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1 About GFI MailArchiver®

1.1 Introduction to GFI MailArchiver

GFI MailArchiver is an email archiving solution which can archive all internal and external email into a
central Archive Store. You can then easily manage the email Archive Stores from the web-based
configuration of GFI MailArchiver. You can also allow users to browse and search old emails via the
web-based browse and search interface. GFI MailArchiver also provides Microsoft Outlook®

integration.

1.2 How Does GFI MailArchiver Work?

GFI MailArchiver operations can be classified in three stages as described below.

Figure 1: Typical GFI MailArchiver installation diagram.

Stage 1: Retrieve emails

GFI MailArchiver retrieves emails depending on the configured Archiving Method as described in the
table below:

ARCHIVING METHOD DESCRIPTION

Auto-Archiving (Jour-
naling)

GFI MailArchiver collects emails from the Microsoft® Exchange Server journaling mailbox.

Manual Archiving GFI MailArchiver, receives manually archived emails from GFI MailArchiver Outlook
Addon.

NOTE
For more information, refer to Configuring Archiving Method (page 93).
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Optionally, emails can also be imported into GFI MailArchiver through the GFI MailArchiver Import
Export Tool. For more information, refer to Import and Export Emails (page 176).

Stage 2: Archive emails

GFI MailArchiver stores collected emails in Archive Stores created automatically based on the
configured New Archive Store Settings. Emails are archived according to their sent date. If an Archive
Store does not exist for the period that matches the date of the email, a new Archive Store is
automatically created. For more information, refer to Configuring Archive Store Settings (page 111).

NOTE

When Rule-based method of archiving is selected, GFI MailArchiver only archives emails
that match criteria specified in the configured Archiving Rules. For more information,
refer to Configuring Archiving Rules (page 99).

Stage 3: Browse archived emails

Users can browse and search archived emails via the GFI MailArchiver web interface or from Microsoft
Outlook® using the GFI MailArchiver Outlook Connector.

1.3 GFI MailArchiver Licensing

For information on GFI MailArchiver licensing, refer to:

http://go.gfi.com/?pageid=MAR_Licensing

1.3.1 Terms and conventions used in this manual

Term Description

Additional information and references essential for the operation of GFI MailArchiver.

Important notifications and cautions regarding potential issues that are commonly encountered.

> Step by step navigational instructions to access a specific function.

Bold text Items to select such as nodes, menu options or command buttons.

Italics text Parameters and values that you must replace with the applicable value, such as custom paths and file
names.

Code Indicates text values to key in, such as commands and addresses.

Table 1: Terms and conventions used in this manual

1.4 Legal Compliance

Ensure that by enabling the Rule-based method of archiving or the Email deletion feature you are not
breaching your company policy or any laws and regulations related to email storage in your
jurisdiction. For more information refer to Configuring Archiving Rules and Email Deletion chapters.

http://go.gfi.com/?pageid=MAR_Licensing
http://go.gfi.com/?pageid=MAR_Licensing
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2 Installing GFI MailArchiver

Installing GFI MailArchiver is a two-step process:

1. Run the GFI MailArchiver installer to install GFI MailArchiver and missing pre-requisites.

2. Follow the GFI MailArchiver post-install wizard to configure GFI MailArchiver and its operating
environment.

In this chapter:

2.1 System Requirements 18

2.1.1 Software Requirements 19
2.1.2 Hardware Requirements 20
2.1.3 Important Settings 21

2.2 Where Should I Install GFI MailArchiver? 23

2.2.1 Preparing the Journal Mailbox 24
2.2.2 Preparing the Journal Mailbox in Microsoft® Exchange Server 2003 24
2.2.3 Preparing the Journal Mailbox in Microsoft® Exchange Server 2007/2010 24

2.3 Choosing and Preparing a Database 25

2.3.1 Choosing Your Database Type 25
2.3.2 Configuring a Firebird Database 26
2.3.3 Using SQL Server® Express 27
2.3.4 Using Microsoft® SQL Server 28

2.4 Before You Install 28

2.5 Installing GFI MailArchiver 29

2.1 System Requirements

This section describes software and hardware requirements and related settings to ensure a
successful deployment of GFI MailArchiver.

Software requirements:

Supported Operating Systems

Supported Mail Servers

Supported Databases

Other Required Components

Hardware requirements:

Processor

Memory

Physical Storage

Important Settings:

Antivirus and Backup Software

Firewall Port Settings
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Database Settings

ASP.NET® Settings

NOTE

The recommended software and hardware specifications depend on the number of
users, settings enabled, email flow and message sizes.

2.1.1 Software Requirements

Supported Operating Systems

GFI MailArchiver can be installed on all the operating systems listed below:

OS VERSION SUPPORTED OPERATING SYSTEM

32 BIT Windows® SBS 2003 & SBS 2011
Windows® 2003 Standard & Enterprise
Windows® 2008 Standard & Enterprise

64 BIT Windows® SBS 2008 Standard & SBS 2011
Windows® 2003 Standard & Enterprise
Windows® 2008 Standard, Enterprise, Datacentre & Hyper-V® Environments
Windows® Server 2008 R2 Enterprise & Hyper-V® Environments

Table 2: Supported operating systems

NOTE

The server on which to install GFI MailArchiver must have access to Active Directory®.

Supported Mail Servers
Microsoft® Exchange Server 2003 or later.

IMAP compatible mail servers

Supported Databases

GFI MailArchiver supports the database back-ends listed below:

SUPPORTED DATABASE DESCRIPTION

Firebird An open source database used for evaluation purposes
bundled with GFI MailArchiver. Recommended for evaluation
purposes only for organizations with less than 50 email users
and with an average mail flow of up to 2500 per day.

SQL Server® 2005 or later
(including SQL Server® Express editions)

Recommended for all organizations. Not included with GFI Mai-
lArchiver installation and is required to be installed as a sep-
arate process.

Table 3: Supported databases

Other Required Components

OTHER COMPONENTS

Microsoft .NET® Framework 4.0

Table 4: Other supported components
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OTHER COMPONENTS

ASP.NET® 4.0

Internet Information Services (IIS®) 6.0 or later - SMTP &World Wide Web services

Internet Explorer® 8 or later, Mozilla Firefox, Google Chrome, Safari®

Microsoft® Data Access Components (MDAC) 2.6 or higher

Microsoft® Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 - Required (unless Outlook® 2003 32-bit or
later is installed or unless GFI MailArchiver is installed with Microsoft® Exchange Server 2003). Download from:
http://www.microsoft.com/download/en/details.aspx?id=6248

NOTE

Minimum supported screen resolution is 1024 x 768

IMPORTANT

After installing Microsoft .NET® Framework 4.0 restart the machine.

2.1.2 Hardware Requirements

Processor

REQUIREMENT DESCRIPTION

Minimum Intel Pentium or compatible - 2GHz 32 bit processor.

Recommended x64 architecture-based server with Intel 64 architecture or AMD64 platform.

Table 5: Minimum and recommended processors

Memory

REQUIREMENT DESCRIPTION

Minimum 1GB RAM (dedicated to GFI MailArchiver)

Recommended 3GB RAM (dedicated to GFI MailArchiver)

Table 6: Memory requirements

Physical Storage

REQUIREMENT DESCRIPTION

Minimum 400MB physical disk space (NTFS) for GFI MailArchiver installation. More space is required for the
database (Firebird or Microsoft® SQL server). Storage space depends on mail volume to archive.

Recommended Server with 4 physical drives, with the ability to increase storage space on demand when required.
Refer to Database Settings section within this chapter for more information on how to configure your
database.

Table 7: Physical Storage requirements

NOTE

It is highly recommended that you store databases and Index files on separate,
appropriately sized hard disks. SAS hard disks are highly recommended.

http://www.microsoft.com/download/en/details.aspx?id=6248
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2.1.3 Important Settings

Antivirus and Backup Software

Anti-virus and backup software may cause GFI MailArchiver to malfunction. This occurs when such
software denies access to certain files required by GFI MailArchiver.

Disable any third party anti-virus and backup software from scanning the following folders and
subfolders:

GFI MailArchiver FOLDERS

<GFI MailArchiver Installation folder> and subfolders.

<..\Program Files\Common Files\GFI>

Table 8: Folders to exclude from Antivirus scanning

Also, exclude the index and the Archive Store locations from backups and anti-virus scans. The default
Index and Archive Store locations are:

GFI MailArchiver DEFAULT INDEX AND ARCHIVE STORE LOCATIONS

<GFI MailArchiver Installation folder>\Indexes\default

<GFI MailArchiver Installation folder>\Databases\default\>

Table 9: Locations to exclude from antivirus scanning

NOTE

You can change the Index and Archive Store locations after installing GFI MailArchiver.
For information, refer to the Configure Archive Stores and Configure search indexes
sections in this manual.

Firewall Port Settings

Configure your firewall to allow connections from the GFI MailArchiver server on the following ports:

PORT DESCRIPTION

Remoting (Ports 8014,
8017, 8018, 8019, 8020,
8022)

Used for communication between GFI MailArchiver components when installed in a role
based setup. Ensure these ports are open only when the server is installed in a distributed
environment.

Table 10: Listening Ports on the GFI MailArchiver Server

Connections Established From the GFI MailArchiver Server

PORT DESCRIPTION PRO-
TOCOL

25 Used by GFI MailArchiver when an email needs to be restored to a user’s mailbox or a notification is
sent to the GFI MailArchiver administrator.

SMTP

80 Used by the GFI MailArchiver user interface and web services. HTTP

135 Enable this port when GFI MailArchiver is installed on the same machine as Microsoft® Exchange
Server and configured to use ExOLEDB to retrieve emails.

MAPI/-
RPC

143 Enable this port to retrieve emails when GFI MailArchiver is not installed on the same server as Micro-
soft® Exchange Server.

IMAP

Table 11: Ports used by GFI MailArchiver
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PORT DESCRIPTION PRO-
TOCOL

1443 Enable this port when GFI MailArchiver is configured to archive emails to a SQL Server® Database. Micro-
soft
SQL
Server
®

3268 Used for connections done from the GFI MailArchiver Server to the Domain Controller which stores
the Microsoft® Global Catalog.

Micro-
soft
Global
Cat-
alog

8096
to
8099

Enable this port when using GFI PST Exporter to communicate with GFI MailArchiver when exporting
data from networked computers.

<Optio-
nal>

44143 Default port assigned to GFI MailArchiver IMAP Service. IMAP Service enables users to access archived
email via IMAP from 3rd party email clients such as Thunderbird, Microsoft Outlook®, Apple Mail,
Android, iOS and others.

IMAP

Database Settings

GFI MailArchiver requires SQL Server® (if used as the archival database) to be installed in case
insensitive mode. This is the default installation setting of SQL Server®. The SQL Server® collation
modes apply to all SQL Server® objects including login names. In such cases if a user changes a
property in the name and does not make EXACT character case matches, GFI MailArchiver will fail
since it would not find the resources required.

Once installed, it is not possible to change the SQL Server® collation mode easily. It requires a rebuild
of the master database using advanced Microsoft® SQL tools or methods. The best solution is to install
another instance of SQL Server® (set to operate in insensitive collation mode).

IMPORTANT

Ensure SQL Server® is installed in case insensitive mode if SQL Server® is used as the
archival database.

ASP.NET® Settings

Register and enable ASP.NET® with IIS® for GFI MailArchiver to work.

Register ASP.NET® With IIS®

If the Microsoft® .NET framework is installed after IIS is installed this is automatically registered. Else,
register ASP.NET® with IIS® by following these steps:

1. From command prompt, navigate to:

<WindowsDirectory>\Microsoft.NET\Framework\<v4.0.xxxxx>\

NOTE

Replace <v4.0.xxxxx> with the folder name of Microsoft® .NET Framework version
number.

For example: C:\Windows\Microsoft.NET\Framework\v2.0.50727\
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Screenshot 1: Registering ASP.NET with IIS

2. Key in aspnet_regiis.exe -i and press Enter.

Enable ASP.NET® From IIS®

NOTE

Ensure that ASP.NET® is allowed by Internet Information Services (IIS®) Manager.

IIS 6

1. Navigate to Control Panel > Administrative Tools > Internet Information Services (IIS) Manager.

2. Expand the local computer node and select Web Service Extensions.

3. In the right pane, right click ASP.NET v4.0.xxxxx and select Allow.

IIS 7

1. Navigate to Control Panel > Administrative Tools > Internet Information Services (IIS) Manager.

2. Select the local computer node and from the Features View pane launch ISAPI and CGI
Restrictions.

3. In the Features View pane, right click ASP.NET v4.0.xxxxx and select Allow.

2.2 Where Should I Install GFI MailArchiver?

Install GFI MailArchiver on any machine that meets the system requirements and is part of an Active
Directory® domain. Before proceeding with the installation, first consider the details listed below:

CONSIDERATION DESCRIPTION

Email volume on
your servers

Installing GFI MailArchiver on a mail server where a high volume of emails received and processed
will invariably put more load on server resources. This can cause these servers to become
unresponsive and not process mail in a timely fashion.

Hardware and
software spec-
ifications of your
servers

The hardware and software specifications listed in the System requirements section above should
be considered to be over and above the requirements of other software installed on the same
server. Servers which are nearing their capacity in terms of resources should not be used to install
GFI MailArchiver.

Need to archive
email from mul-
tiple sources con-
currently

Installing GFI MailArchiver on a server which is not granted access to multiple sources creates a
problem in the centralization efforts of email data archival.

Table 12: Installation considerations

If all of the above details are considered not to be of significant issues then you can consider
installing GFI MailArchiver on the mail server.

For example:
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If you need to archive email from one Microsoft® Exchange Server, and the server is
handling the email flow on your network and still has spare processing capacity, then you
can consider installing GFI MailArchiver directly on the Microsoft® Exchange Server
machine.

If you want to archive email from multiple Microsoft® Exchange Servers using IMAP, it is rec-
ommended that you install GFI MailArchiver on a separate server.

GFI MailArchiver does not require a dedicated machine when it is not installed on the mail server.

2.2.1 Preparing the Journal Mailbox

A Journal mailbox is a mailbox that stores copies of emails sent or received by email users. This
enables the recording of all email in an organization, with minimum performance overheads. GFI
MailArchiver uses Microsoft® Exchange Server journaling to centralize all the emails to archive in a
single mailbox.

IMPORTANT

If journaling is not set up correctly, email archiving will NOT work.

2.2.2 Preparing the Journal Mailbox in Microsoft® Exchange Server 2003

Configuring a Microsoft® Exchange Server journaling mailbox for use within GFI MailArchiver requires
you to create a new journal mailbox and to configure Microsoft Exchange to archive emails to the
journal mailbox. Then you are also to configure whether to journal just the BCC information or all the
header information

For detailed instructions on configuring a journaling mailbox in Microsoft® Exchange Server 2003 for
use with GFI MailArchiver, refer to Create a Journal Mailbox in Microsoft Exchange Server 2000/2003
in Appendix 1 .

2.2.3 Preparing the Journal Mailbox in Microsoft® Exchange Server 2007/2010

Microsoft® Exchange Server 2007 and Microsoft® Exchange Server 2010 support two types of
journaling:

Standard journaling: This feature enables the configuration of a Mailbox store that enables the
recording of email in an organization. GFI MailArchiver can use Microsoft® Exchange Server jour-
naling to centralize all the emails to archive in a single mailbox for archival. This type of jour-
naling is also called per-mailbox database journaling.

Premium journaling: Only available with the Microsoft® Exchange Server Enterprise client access
license. It enables an administrator to setup custom journaling rules such as Archive only incom-
ing emails, Archive only outgoing emails or Archive emails for a particular group. This journaling is
also called per-recipient journaling.

GFI MailArchiver utilizes this type of journaling by detecting and displaying these rules in the Data
Sources Configuration Wizard.

Choosing a Journaling Method
Choose standard journaling to archive all emails (inbound and outbound) for all users in your
organization.

Choose premium journaling of you want more control over the emails to archive (e.g. only for spe-
cific users or for inbound or outbound only).
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NOTE

Premium journaling requires a Microsoft® Exchange Enterprise client access license.

Enabling Journaling for Microsoft® Exchange Server 2007 or Microsoft® Exchange Server
2010

For Microsoft® Exchange Server 2007 pre-service pack 2 installations, journal mailbox creation should
be created using the instructions listed in Creating a Journaling Mailbox in Microsoft Exchange Server
2007 or Create a Journal Mailbox in Microsoft Exchange Server 2010 in this guide. Installations running
Microsoft® Exchange Server 2007 SP2 or Microsoft® Exchange Server 2010 can:

Use the GFI MailArchiver Post-Installation wizard to automatically create the required journal
mailbox, or

Use the instructions listed in Appendix 1 in this guide.

2.3 Choosing and Preparing a Database

As an archiving solution, GFI MailArchiver is highly dependent on your database infrastructure setup
for high performance of data archival and retrieval processes.

The following sections help you to understand the following options:

Firebird Database

Microsoft SQL Server Express

Microsoft SQL Server

2.3.1 Choosing Your Database Type

GFI MailArchiver can be configured to run in various hardware setups and combinations. The table
below shows the typical recommended configurations. These guidelines and configurations may vary
according to user activity and daily email flow.

NUMBER OF MAILBOXES TO ARCHIVE RECOMMENDED DATA-
BASE TYPE

DESCRIPTION WHERE
EACH COMPONENT IS
STORED

50 mailboxes or less
Evaluation ONLY

GFI MailArchiver data-
base

Email headers – Fire-
bird database

Metadata – Firebird
database

Email data – On disk

100 mailboxes or less Average mail flow of up to 6000
emails/day

SQL Server® Express
with File Storage

Email headers – SQL
Server® Express

Metadata – SQL
Server® Express

Email data – On disk

Table 13: Choosing your database type



GFI MailArchiver 2 Installing GFIMailArchiver | 26

NUMBER OF MAILBOXES TO ARCHIVE RECOMMENDED DATA-
BASE TYPE

DESCRIPTION WHERE
EACH COMPONENT IS
STORED

50 mailboxes or more
Average mailflow of more than 8000/day

SQL Server® Email headers – SQL
Server®

Metadata – SQL
Server®

Email data – SQL
Server®

More than 500 mailboxes
Average mailflow of more than 8000/day

SQL Server® with File
Storage

Email headers – SQL
Server®

Metadata – SQL
Server®

Email data – On disk

NOTE

Email metadata is the information about email archived within GFI MailArchiver.

2.3.2 Configuring a Firebird Database

GFI MailArchiver ships with a Firebird database for evaluation purposes.

NOTE

Ensure that the size of each Firebird database never exceeds 2GB.

To minimize any potential performance issues, the following setup is strongly recommended when
using the Firebird database:

Physical HDD 1: Operating system and GFI MailArchiver installation.

Physical HDD 2: Firebird database data store.

Physical HDD 3: Mail database indexes.

The above setup reduces data read/write operations on the same physical hard disk drive to improve
performance.

IMPORTANT

Failing to follow the above recommendations may result in substantial performance
degradation.

NOTE

Archive email auditing feature is only available when emails are archived in SQL
Server®. Microsoft® SQL Server with File Storage option is not supported.



GFI MailArchiver 2 Installing GFIMailArchiver | 27

2.3.3 Using SQL Server® Express

SQL Server® Express is recommended for medium sized organizations (approximately 1-100 email
users) with an average mail flow of up to 6000 emails/day

The recommended setup for GFI MailArchiver using a SQL Server® Express 2000/2005/2008 database
is as follows:

Physical HDD 1: Operating system and GFI MailArchiver installation.

Physical HDD 2: Microsoft® SQL Server data file (.mdf).

Physical HDD 3: Microsoft® SQL Server log file (.ldf)

Physical HDD 4: Mail database indexes.

This configuration ensures that different processes are distributed to distinct physical hard disk
drives. This eliminates performance loss due to excessive data read/write operations on the same
physical hard disk drive.

NOTE

Archive email auditing feature is only available when emails are archived in SQL
Server®. Microsoft® SQL Server with File Storage option is not supported.

There are however a number of SQL Server® Express limitations to consider:

Database size has a limit of 4GB (10GB for SQL Server® Express 2008 R2)

It uses 1 CPU only

It uses a maximum of 1GB RAM.

It is therefore highly recommended that:

OPTION DESCRIPTION

SQL Server Express and file sys-
tem are used as the back-end
database.

This method uses SQL Server® Express as the backend database and a separate
location (not a database) for the binary sources files. This saves up on the SQL
Server® Express space required for archiving.
Refer to the GFI MailArchiver Administration and Configuration manual (installed
with GFI MailArchiver) for detailed information on Archive Stores.

Enable the ‘Use a new Archive
Store when full’ feature within
Archive Store Management.

This instructs GFI MailArchiver to automatically switch to a new database when
the 4GB limit of SQL Server® Express is reached. This feature requires that
Archive Stores are based on SQL and Filesystem.
Refer to the GFI MailArchiver Administration and Configuration manual (installed
with GFI MailArchiver) for detailed information on the Use a new Archive Store
when full feature within Archive Store Management

Table 14: Microsoft SQL Server limitations

NOTE

After the first month of archiving, note the database data file size. With this value,
estimate the archive database size after six months, for example. If you estimate that
your archive database will be larger than 20 GB, you should consider configuring the
Archive Stores management feature of GFI MailArchiver.
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2.3.4 Using Microsoft® SQL Server

Microsoft® SQL Server is recommended for larger organizations (100+ email users) with a substantial
volume of emails to archive (more than 6000 email per day). For organizations with more than 500
email users (or more than 8000 emails per day) to archive emails for, it is highly recommended to use
Microsoft® SQL Server with File Storage option. This substantially increases the archival capacity of
GFI MailArchiver.

NOTE

Archive email auditing feature is only available when emails are archived in Microsoft®

SQL Server. Microsoft® SQL Server with File Storage option is not supported.

The recommended setup for GFI MailArchiver using a Microsoft® SQL Server 2000/2005/2008
database is as follows:

Physical HDD 1: Operating system and GFI MailArchiver installation.

Physical HDD 2: Microsoft® SQL Server data file (.mdf).

Physical HDD 3: Microsoft® SQL Server log file (.ldf)

Physical HDD 4: Mail database indexes.

This configuration ensures that different processes are distributed to distinct physical hard disk
drives. This eliminates performance loss due to excessive data read/write operations on the same
physical hard disk drive.

NOTE

After the first month of archiving, note the database data file size. With this value,
estimate the archive database size after six months, for example. If you estimate that
your archive database will be larger than 20 GB, you should consider configuring the
Archive Stores management feature of GFI MailArchiver.

IMPORTANT

Configure Microsoft® SQL Server to use Mixed Authentication mode for use with GFI
MailArchiver.

To change to Mixed Authentication mode:

1. Right-click on the SQL Server node > Properties from the Enterprise Manager

2. Access Security tab and select SQL Server and Windows under Authentication.

3. Save settings.

2.4 Before You Install

1. Ensure that you are logged on as Administrator or using an account with administrative privileges.

2. Save any pending work and close all open applications on the machine.
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3. Check that the machine on which you are installing GFI MailArchiver meets the system and
hardware requirements specified earlier in this chapter.

4. Check the Microsoft® Exchange Server role:

GFI MailArchiver cannot be installed on the Microsoft® Exchange Server 2007/2010 Edge Role,
since such a server is typically deployed on a DMZ using ADAM (Active Directory® Application
Mode)/AD LDS (Lightweight Directory Services) instead of Active Directory.

Ensure to enable IMAP if installing on the Microsoft® Exchange Server 2007/2010 Client Access
Role.

2.5 Installing GFI MailArchiver

1. Double-click on:

Mailarchiver.exe to install GFI MailArchiver on x86 systems

Mailarchiver_x64.exe to install GFI MailArchiver on x64 systems

2. In the Choose Setup Language dialog, select the language you want to use during installation and
click OK.

3. On the Welcome page, click Next.

Screenshot 2: Check for a newer build

4. If you want GFI MailArchiver to check for a newer build other than the one being installed, select
Check for a newer build of GFI MailArchiver on the GFI web site and click Next. Otherwise, select
Do not check for a new build and click Next.

NOTE

Checking for a newer build requires an active Internet connection.
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5. Read the license agreement and select I accept the terms in the license agreement option. Click
Next to continue.

6. Click Next to continue by installing GFI MailArchiver to the default folder. For an alternative
location, click Change and select a new installation path.

Screenshot 3: Specify the website and virtual directory alias for the web application

7. If you want to change the default values for the Website and Virtual Directory Alias, modify the
values in the Website: and Virtual Directory Alias: fields. These values define which URL you use to
access GFI MailArchiver. Click Next.

8. Click Install to install GFI MailArchiver.
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Screenshot 4: Installation complete

9. On completion, click Finish to close the installation wizard.
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3 GFI MailArchiver Post-install Wizard

After GFI MailArchiver is successfully installed, the Congratulations screen is displayed. Click
Configure to start the post-install wizard that assists in setting up GFI MailArchiver .

Screenshot 5: Post install wizard start screen

The Post Install wizard will help you:

TASK DESCRIPTION

Enter a valid license key - A valid license key is required to use GFI MailArchiver after the product is installed.
Use your purchased license key or enter a User Evaluation Key if you are in the process of evaluating GFI Mai-
lArchiver. A User Evaluation Key can be requested from http://go.gfi.com/?pageid=MAR_Down-
loadRegistrationForm.

Setup Archive Store settings - Configure Archive Store settings that define properties such as name, database
type and index locations. These settings are used as a template by GFI MailArchiver to automatically create
new Archive Stores.

Select an Archiving Method - The archiving method defines how Microsoft® Exchange Server archives emails
within GFI MailArchiver Archive Stores. Choose your preferred archiving method from available options.

Table 15: Post installation tasks

Click Next to set up GFI MailArchiver for first use.

http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm
http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm
http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm
http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm
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In this chapter:
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3.2.2 Configure Archive Store - SQL Server® 37

3.3 Configure Archiving Method 41

3.3.1 Set Up a Journal Mailbox 43

3.4 Finalizing the Post Install Setup 45

3.5 Test Your Setup 46

3.1 License Configuration

In the License Configuration screen, enter the license key obtained when purchasing your GFI
MailArchiver product. Click Verify License Key, then click Next to continue.

NOTE

To evaluate GFI MailArchiver, request an evaluation key by registering on the GFI
Software Ltd http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm.

3.2 Configure Archive Store Settings

Within GFI MailArchiver, Archive Stores can be described as the containers that contain the archived
emails. Archive Stores consist of several components, such as:

A database where email metadata is stored

A database where both email metadata and email data is stored

A disk location used as an email index

A disk location used as storage for email data.

Archive Stores are created based on an Archive Store profile that defines details such as Archive
Store name, database type, database file location, email file location and index locations. Use the
Archive Store Wizard to create your Archive Store settings that will be used as a template to
automatically create future Archive Stores.

To trigger the Archive Store Wizard manually:

1. From Configuration tab, select > Archive Stores.

2.In the Archive Stores window, click New Archive Store Settings.

3.(Optional) To disable browse and search functionality within the archive stores, uncheck Allow
users to browse and search this archive store (enabled by default). Click Next to continue.

http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm
http://go.gfi.com/?pageid=MAR_DownloadRegistrationForm
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Screenshot 6: Post install wizard - select database type.

3. Select where to store your archived emails. Available options are:

DATABASE TYPE DESCRIPTION

Microsoft SQL
Server with File
Storage

Recommended if you have more than 500 mailboxes to archive or an average mail flow of more
than 8000/day.
Select this option to prompt GFI MailArchiver to use a SQL Server® to store the email headers
and metadata, and a disk location you specify to store the email data.

NOTE
Choosing this option requires a SQL Server® installation.

Microsoft SQL
Server

Recommended if you have less than 500 mailboxes to archive, an average mail flow of more than
8000/day or if you need full auditing of both user and database activity.
Select this option to prompt GFI MailArchiver to use a SQL Server® to store both email
headers/metadata as well as email data.

NOTE
Choosing this option requires a SQL Server® installation.

Table 16: Archived emails storage options
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DATABASE TYPE DESCRIPTION

SQL Server Express
with File Storage

Recommended if you have less than 100 mailboxes to archive or an average mail flow up to 6000
emails/day.
Select this option to prompt GFI MailArchiver to use a SQL Server® Express database to store
email headers and metadata and a disk location you specify to store the email data.

NOTE
Choosing this option requires a SQL Server® Express installation. This is freely
downloadable from the Microsoft® website.

GFI MailArchiver
Database

Recommended for evaluation purposes only.
Select this option to store all email header/metadata in a Firebird database and the email data
in a disk location you specify.

NOTE
Choosing this option does NOT require you to install the Firebird database. GFI MailArchiver
will automatically create a database for you.

4. Click Next to continue setup.

In this chapter:

3.2.1 Configure Archive Store - GFI MailArchiver Database 35

3.2.2 Configure Archive Store - SQL Server® 37

3.2.1 Configure Archive Store - GFI MailArchiver Database

If you opted to use a GFI MailArchiver database, you will now be guided to create New Archive Store
Settings that are used as a template by GFI MailArchiver to create new Archive Stores.
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Screenshot 7: Archive Store creation: Select locations

1. Browse and select the Database File, Email File and Search Index locations to use for the GFI
MailArchiver database. Also, provide any required credentials to access the provided locations.

OPTION DESCRIPTION

Database file location Defines the location where the Firebird database file will be
located. Key in or click Browse… to select a location where to store
this file.

NOTE
UNC paths are not allowed.

Email file location Defines the location where the email data files will be located. Key
in or click Browse… to select a location where to store this file.

NOTE
UNC paths are allowed.

Table 17: Archive Store file locations
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OPTION DESCRIPTION

Search Index location Defines the location where the email search index will be located.
Key in or click Browse… to select a location where to store this file.

NOTE
UNC paths are allowed.

Use the following login and password to access
the above UNC path

Enable this option to allow input in the Login: and Password: fields.
The credentials keyed in are used to access the UNC paths
selected.

2. Click Next to continue setup.

3. Click Finish.

3.2.2 Configure Archive Store - SQL Server®

If you have opted to use a Microsoft® SQL Server, Microsoft® SQL Server with File Storage or SQL
Server® Express with File Storage, you will now be guided to set up a new Archive Store settings.

NOTE

Ensure SQL Server® is installed in Mixed Mode authentication and TCP IP is enabled.
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Screenshot 8: Archive Store creation: Select database

1. In the Database Server Details screen, choose an SQL Server® from the list of automatically
discovered servers or manually provide the details.

OPTION DESCRIPTION

Select the database server to
use to store the archived
emails.

Enables you to select a SQL Server® from the list of discovered Microsoft® SQL
Servers. Click Recheck to recheck for any servers that might have come online since
the page loaded.

Manually specify the database
server to use to archive your
emails.

Choose this option to disregard the list of discovered Microsoft® SQL Servers and to
specify the details of the server used for your Archive Store.

Table 18: Database server details

2. Click Next to continue.

3. If, in the previous screen, you chose to manually specify the details used to store your archived
emails, provide the Microsoft® SQL Server database name in the Database Server field. If a database
server was selected, continue with the next step.

4. Select the authentication method used to connect to the selected SQL Server®.
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OPTION DESCRIPTION

Integrated Windows
Authentication

Uses the login credentials of the currently logged on user to access the SQL Server®. Keying
in a username and a password is not required.

Microsoft SQL Server
Authentication

Uses the username and password provided in the Username and Password fields to access
the SQL Server®.

Table 19: Archive Store authentication options

5. Click Next to continue.

Screenshot 9: Archive Store creation: Select data and log file location.

6. Provide the paths for the SQL Server® data (.mdf) and log (.ldf) files. If an existing database was
selected, skip to the next step.

OPTION DESCRIPTION

Use the default path as defined in
the Microsoft SQL Server

Instructs GFI MailArchiver to use the default paths configured within SQL
Server®. Uncheck this option to configure alternate paths.

Data file location Defines the location used by GFI MailArchiver to store data files. Key in or click
Browse… to select the path.

Table 20: Archive Store database file location options
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OPTION DESCRIPTION

Use the same path for both data
file and log file.

Instructs GFI MailArchiver to use the path in the Data & Log File Location text
box as the location for the Log file.
Uncheck this option to key in a custom log file location.

Log File Location Defines the location used by GFI MailArchiver to store the log files. Key in or
click Browse… to select the path.

7. Click Next to continue.

Screenshot 10: Archive Store creation: Select locations

8. Provide the file locations required for the type of selected SQL Server® type.

NOTE

Some options are not selectable depending on the chosen SQL Server® type.

For example, selecting Microsoft SQL Server with File Storage disables Database File Location and
Email File Location options.
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OPTION DESCRIPTION

Email file location Defines the location where the email data will be located. Key in or click
Browse… to select a location where to store this file.

NOTE
UNC paths are allowed.

Search Index location Defines the location where the email search index will be located. Key in or
click Browse… to select a location where to store this file.

NOTE
UNC paths are allowed.

Use the following login and password
to access the above UNC path

Enable this option to allow input in the Login: and Password: fields. The
credentials keyed in will be used to access the UNC paths selected.

Table 21: Database file location options

9. Click Next to continue.

IMPORTANT

For more information, refer to Choosing Your Database Type (page 25).

10. Click Finish.

3.3 Configure Archiving Method

The Archiving Method determines which emails are archived by GFI MailArchiver. For example, you
can select Auto-Archiving (journaling) with Rule-Based Archiving if you want to archive emails based
on configured Archiving Rules.
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Screenshot 11: Post install wizard - choose archiving method

To configure the Archiving Method:

1. From Configuration tab, select Archiving Method.

2. Click Configure Archiving Method.

3. From the Configuration Wizard screen, select one or a combination of the following options:

OPTION DESCRIPTION

Manual Archiving This archiving method enables users to manually archive messages from their Micro-
soft Outlook® client into GFI MailArchiver. Users need to deploy GFI MailArchiver Out-
look Addon to be able to manually archive emails. For more information, refer to
Configuring Manual Archiving (page 159).

Table 22: Configure archiving method
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OPTION DESCRIPTION

Auto-Archiving (Journaling) GFI MailArchiver uses Microsoft® Exchange Server journaling to retrieve emails to
archive in a single mailbox. A Journal mailbox is required to use Auto-Archiving
(Journaling) method. An initial Journal mailbox is configured using the post-install
wizard. This enables you to start archiving emails from a Microsoft® Exchange Server. If
Auto-Archiving (Journaling) method is enabled, select one of the following options:

All Emails - select to archive all emails that pass through your configured mail
servers. For more information, refer to Managing the Mail Servers to Archive
(page 95).

Rule-Based Archiving - archive emails based on criteria specified in the con-
figured Archiving Rules. For more information, refer to Configuring Archiving
Rules (page 99).

4. Click Next to continue setup.

3.3.1 Set Up a Journal Mailbox

Journaling is an email server feature that enables the recording of email in an organization. Through
Microsoft® Exchange Server journaling, you can channel the email data to archive into a single
mailbox. Emails are then retrieved by GFI MailArchiver for archiving.

For Microsoft® Exchange Server 2007 and later, GFI MailArchiver provides the facility to create the
Journal Mailbox on Microsoft® Exchange Server through the post install wizard. Follow the
instructions in this section to set up journaling for Microsoft Exchange Server 2007 or later
installations.

NOTE

For instructions on how to manually set up a journal mailbox for Microsoft® Exchange
Server 2007 or later systems refer to: http://go.gfi.com/?pageid=MAR_
ConfiguringJournaling

For Microsoft® Exchange Server 2003 installations, create a journal mailbox as described in Appendix
1 - Create Journal Mailbox Manually.

IMPORTANT

If journaling is not set up correctly, Auto-archiving (journaling)method of email
archiving will NOT work.

1. In the Configuration Wizard that opens after creating the Archive Store Profile, click Next.

http://go.gfi.com/?pageid=MAR_ConfiguringJournaling
http://go.gfi.com/?pageid=MAR_ConfiguringJournaling
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Screenshot 12: Journal Mailbox wizard

2. Select whether to automatically create a new Journal Mailbox or to manually specify all Journal
Mailbox details. The configuration wizard can also detect any existing journaling mailboxes and gives
you the facility to use them.

OPTION DESCRIPTION

Select a journal mailbox from
the detected journal mailbox
list below.

Displays a list of Journal Mailboxes detected by the Configuration Wizard. Select this
option and a Journal Mailbox from the list displayed to use selected mailbox.

Let the wizard create a new
journal mailbox to use to start
archiving your emails

Provides the facility to automatically create a new Journal Mailbox. Select this
option and a detected Microsoft® Exchange Server to create the new journal
mailbox for.

Manually create a Journal Mail-
box using this wizard

Provides the facility to create a new Journal Mailbox, providing all the details
required to create such mailbox. These may include specifying a Mailbox Store, the
connection method, ports used and credentials.
NOTE
Choose this option to configure a Journal Mailbox in Microsoft® Exchange Server 2003.

Table 23: Journal Mailbox options

3. Click Next to continue setup.
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4. If you have selected Let the wizard create a new journal mailbox to use to start archiving your
emails or Manually create a Journal Mailbox using this wizard option, you will now be prompted to
key in the required details for the Journal Mailbox. If Select a journal mailbox from the detected
journal mailbox list was selected, click Next.

Available options are:

OPTION DESCRIPTION

Mail Server Shows the detected name of the mail server where the Journal Mailbox resides.

Connect using: Defines the connection method used to connect to the Mail Server where the new Journal Mailbox
will be created. Available options are:

ExOLEDB – Available only if GFI MailArchiver is installed on the same machine as Microsoft®

Exchange Server 2003 or 2007.

IMAP - Available only if GFI MailArchiver is not installed on the same machine as Microsoft®

Exchange Server 2003 or 2007.

Exchange Web Services (EWS) - Available only for Microsoft® Exchange Server 2007 SP1 or
2010.

IMAP Port Shown only if IMAP is selected as the connection method. Defines the IMAP port used to connect to
the Mail Server.
Default value: 143

Use SSL Defines whether SSL (Secure Sockets Layer) should be used to secure the connection between GFI
MailArchiver and the Mail Server

Login:/Password: Enables you to provide the login name and password used to connect to the Mail Server.

Mailbox/Folder Defines the default mailbox/folder that is used to journal emails.
Default value: Inbox.

Table 24: New journal mailbox options

5. Click Next to continue setup.

6. Click Finish to finalize Journal Mailbox setup.

3.4 Finalizing the Post Install Setup

On completing the requirements of the Post Install wizard, you can now start using GFI MailArchiver
to archive emails on your Microsoft® Exchange Server.
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Screenshot 13: Post Install Wizard completed successfully

Confirm that the setup for Licensing, the Archive Store Profile and Archiving Method are marked as
completed and click Finish.

3.5 Test Your Setup

Depending on the Archiving Method chosen during the post installation tasks, test your setup to
ensure that emails are archived successfully.

Testing Manual Archiving

1. Open a Microsoft Outlook® installation where GFI MailArchiver Outlook Addon has been deployed.

NOTE

For more information, refer to Configuring Manual Archiving (page 159).

2. Select an email and click the Archive button.

3. In GFI MailArchiver, go to Archive tab.
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4. Ensure the correct Archive Store is selected and verify that the email archived using the GFI
MailArchiver Outlook Addon is displayed in the Conversation pane.

Testing Archiving of Auto-Archiving (Journaling) All Emails

1. Create a new email and send it to an email address that belongs to a mailbox that is being
archived.

2. In GFI MailArchiver, go to Archive tab.

Screenshot 14: Search for email

3. Ensure the correct Archive Store is selected and verify that the archived email is displayed in the
Conversation pane.

Testing Rule-based Archiving

1. Ensure that Archiving rules have been configured. For more information, refer to Configuring
Archiving Rules (page 99).

2. Create a new email based on the criteria configured in the Archiving Rules and send it to a valid
email address.

3. In GFI MailArchiver, go to Archive tab.

4. Ensure the correct Archive Store is selected and verify that the archived email is displayed in the
Conversation pane.
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4 Upgrading From Previous Versions

4.1 Upgrading from versions earlier than GFI MailArchiver 2012

In GFI MailArchiver2012, Archive Store Management is redesigned to automate the Archive Store
creation process. This has an effect on how several features within the product work. There are also
new requirements that must be met for new Archive Store automation to work. The table below lists
the new feature requirements and changes:

FEATURE / REQUIREMENT DESCRIPTION

Database Schema Upgrade Ensure that the Database Schema is upgraded during the installation /
upgrade process, otherwise Archive Store automation is not implemented
and GFI MailArchiver 2012 does not work. The Database Schema can also
be upgraded manually using the Database Schema Upgrader tool. For
more information, refer to Upgrading the database schema (page 124).

Databases cannot be created manually Archive Stores can no longer be created manually. Archive Store man-
agement is an automated process handled by GFI MailArchiver.

Automatic Archive Store Creation To facilitate Archive Store management, GFI MailArchiver creates new
Archive Stores as required. The new Archive Stores are created when
emails are received into GFI MailArchiver from Journaling or from Manual
Archiving, based on the template settings specified in the New Archive
Store Settings.

New Archive Store Settings A template for automatically creating new Archive Stores is created
based on New Archive Store Settings specified during post installation
tasks. This template can be modified later from the GFI MailArchiver UI.
For more information, refer to Configuring Archive Store Settings (page
111).

Scheduling Archive Stores Archive Stores are automatically created periodically on a predefined
schedule. The default and recommended rollover period is Bi-Monthly.
For more information, refer to Scheduling Archive Stores (page 117).

No active / inactive Archive Store Created Archive Stores remain active until the Archive Store is full, or
set as read-only, so emails with dates that span the Archive Store period
are archived within the respective container.

A read-only Archive Store An Archive Store can be set as Read-only. When this happens, a new
Archive Store for the same period is created when an email that falls
within that time bracket needs to be archived. For more information,
refer to Editing Existing Archive Store Details (page 113).

A full Archive Store A new Archive Store for the same period is created if the recommended
size limit for that Archive Store is reached. This feature is only available
for Archive Stores based on SQL Server® Express and Firebird databases.

Single instance storage Using a single-instance storage system, GFI MailArchiver ensures that no
duplicate emails are kept within the same Archive Store.

Importing emails into GFI MailArchiver When using the GFI MailArchiver Import Export Tool to import emails in
GFI MailArchiver, emails are sorted and archived according to their date
without the need of creating a plan. New Archive Stores are created as
required if none exist for a particular period. If an email is imported for 1
user, then all recipients / senders in the email have ownership of that
email, and they can access it. Archive Stores created during import
process can be used for normal GFI MailArchiver operations when emails
are archived from journaling or manual archiving. For more information,
refer to Import and Export Emails (page 176).

Table 25: New feature requirements related to Archive Store automation

4.2 Before You Upgrade

1. Ensure that you are logged on as Administrator or using an account with administrative privileges.

2. Before starting installation, save and close all open applications on the machine.
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3. Check all the System requirements before proceeding with upgrade.

NOTE

For more information on upgrading from versions earlier than GFI MailArchiver 6, refer
to:

http://go.gfi.com/?pageid=MAR_UpgradeDatabase

4.3 Upgrading GFI MailArchiver

1. Double-click on:

Mailarchiver.exe to upgrade GFI MailArchiver on x86 systems

Mailarchiver_x64.exe to upgrade GFI MailArchiver on x64 systems

2. On the Welcome page, click Next.

3. Select whether to check for a newer build of GFI MailArchiver on the GFI Website. Click Next to
continue.

4. Read the license agreement and select I accept the terms in the license agreement option. Click
Next to continue.

5. If you are upgrading from a previous version of GFI MailArchiver, you are asked to key in the
administrator email address and license key. Click Next to continue. Otherwise skip to the next step.

NOTE

To upgrade the license from a previous version or to evaluate GFI MailArchiver, click
Tell me more and apply for a key. For further information refer to:
http://go.gfi.com/?pageid=MAR_UpgradeInformation

http://go.gfi.com/?pageid=MAR_UpgradeDatabase
http://go.gfi.com/?pageid=MAR_UpgradeDatabase
http://go.gfi.com/?pageid=MAR_UpgradeInformation
http://go.gfi.com/?pageid=MAR_UpgradeInformation
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Screenshot 15: Specify the website and virtual directory alias for the web application

6. If you want to change the default values for the Website and Virtual Directory Alias, modify the
values in the Website: and Virtual Directory Alias: fields. These values define which URL you use to
access GFI MailArchiver. Click Next.

7. Click Install to install GFI MailArchiver.

8. Click Upgrade to upgrade your database schema to the new GFI MailArchiver schema and click
Next to continue setup.

IMPORTANT

GFI MailArchiver does not work if the database schema is not upgraded. For more
information, refer to Upgrading the database schema (page 124).

NOTE

To continue setup without updating your database schema, select I do not want to
upgrade the schema now and click Next.

9. Click Finish to close the installation wizard.

4.4 Post Upgrade Actions

4.4.1 Check Licensing

A valid license key enables you to use GFI MailArchiver without any restrictions.

To review the currently installed license key, select Configuration and click Change license key. For
more information, refer to Viewing and Editing License Keys (page 146).
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UPGRADE TYPE DESCRIPTION

From the same version
but an older build

If previous license key was full you will not be asked for a license key during instal-
lation. Once the UI is loaded, you will not be asked to enter the key.

If previous license key is expired you will not be asked for a license key during instal-
lation. You will be asked to enter the key in post installation.

If previous license key was an evaluation key you will not be asked for a License key
during installation.

If evaluation license key is expired, you will be asked to purchase a key in post
installation.

If evaluation license key is not expired, you will not be asked for a key.

NOTE
'Older build' refers to compiled GFI MailArchiver software for the same version.

From a previous version
of GFI MailArchiver

The previous license key is not valid. Enter the new license key during installation
when prompted. Refer to: http://go.gfi.com/?pageid=MAR_UpgradeInformation

Table 26: Licensing options

http://go.gfi.com/?pageid=MAR_UpgradeInformation
http://go.gfi.com/?pageid=MAR_UpgradeInformation
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5 Using GFI MailArchiver

Read this chapter for information related to:

Logging in GFI MailArchiver

Browsing archived emails

Working with emails

Searching for archived emails

Accessing multiple mailboxes

Changing the display language

5.1 Logging In GFI MailArchiver

Navigate to Start > GFI MailArchiver > GFI MailArchiver. GFI MailArchiver will load in your
default Internet browser. Key in your domain credentials (username and password used to
login to Windows®) when prompted.
Alternately, from your Internet browser, key in the following URL:

http://<GFI MailArchiver host name>/<GFI MailArchiver virtual folder name>

For example:
http://mydomain.com/MailArchiver

By default, GFI MailArchiver does not require any login credentials while logging in. It will
instead use the credentials of the currently logged in user. Closing your browser session
logs off the currently logged on user from GFI MailArchiver.

NOTE

To login as a different user, log off your profile and log in using a different Windows®

user.

NOTE

If you are logging in from a computer that is not joined to the domain where GFI
MailArchiver is installed, you will be prompted to key in the credentials used to log in
the domain where GFI MailArchiver is installed.

5.2 Browsing Archived Emails

1. From GFI MailArchiver, select Archive tab.
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Screenshot 16: Browsing Archived Emails

2. In the Archive tab, you can view emails archived for all the mailboxes that you have been granted
access to. You can also perform several actions as described in the table below.

OPTION DESCRIPTION

Enables you to search for emails. Key in the words or phrases to search for
and click . Results are displayed in the emails pane.

Hides the email preview pane.

Shows the email preview pane.

Toggles the email preview pane from displaying emails at the bottom to dis-
playing emails at the side of the email list page.

Displays emails in message view.

Displays emails in mailbox view.

Displays the list of mailboxes the currently logged in user has access to.
From the accounts list, select the Archive Store to view mailboxes for form
the List accounts in archive option. Click Close to exit Account list.

Table 27: Archive Tab options
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OPTION DESCRIPTION

Deletes the selected Emails if Email Deletion has been enabled by your
System Administrator. If Email Deletion is not enabled, this icon will not be
displayed.

NOTE
Emails cannot be deleted from Read-only Archive Stores or when
Legal-hold is enabled.

NOTE

By default, GFI MailArchiver displays 25 emails per page. To change this value, click the
user name displayed on the top right hand corner of your screen and change the value of
the Number of emails to display per page option. Click Save.

5.3 Working With Emails

Within the GFI MailArchiver Archive tab, you can view and take action on archived emails. To view an
email, select the email from the mailbox or message view. This will display the selected email in the
preview pane. Double click an email to view it in the email view window.

Screenshot 17: Working with emails within GFI MailArchiver

In the email view window, email contents are displayed and several actions can be performed. These
actions are listed and described in below.
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OPTION DESCRIPTION

View email headers.
Click to view email Internet headers. These are displayed in a panel. Click this button again or select close
to close panel.

View conversation thread
Click button to view the whole conversation in the mail view window. All emails forming part of the
conversation are listed. Click this button again or select close to close the panel.

Edit email labels (Personal and Global)
Enables you to categorize emails through labeling. This feature is useful during searches for specific mail
types, For example search all emails labeled as “Important”.
To add a label:
1. From ‘Available Labels’, key in a new email label or select an existing one.
2. Click Label Email to label email with the keyed in or selected label.
To remove a previously assigned label:
1. Select a previously assigned label.
2. Click Remove label.
Click this button again or select close to close panel.

NOTE
Labels are displayed in the ‘Labels’ field in black. Labels assigned at an organization level through
categorization policies are in red. You cannot remove categorization policies labels from an email.

Restore email
Restores emails using the OneClick Restore feature that restores an archived email to a specific mailbox or
forwards a copy to an email address.
In the restore email panel, key in the email address where to send a copy of the current email and click
Restore Email.

Save email to disk (EML format)
Downloads the whole email to disk including any attachments, in .eml format. This format is compatible with
a number of email clients such as Microsoft Outlook® Express, Windows® Mail, and Mozilla Thunderbird. In
the File download dialog box, select Save, and select the location where to save the file.

Save email to disk (MSG format)
Downloads the whole email to disk including any attachments, in .msg format, which is compatible with
Microsoft Outlook®. In the File download dialog box, select Save, and select the location where to save the
file.

Print email
Displays email in a printer friendly format in a new browser window. Use the print function of your browser
to print the email.

Show images in email
Use this button to display embedded images within the email.

Mark as not SPAM
Use this button to mark as not SPAM an email that was previously identified as SPAM by an anti-spam
solution. Requires a SPAM retention policy to be set up

Delete Email
Deletes the current email if Email Deletion has been enabled by your System Administrator. If Email
Deletion is not enabled, this icon will not be displayed.

NOTE
Emails cannot be deleted from Read-only Archive Stores or when Legal-hold is enabled.

Table 28: Email View options

5.4 Searching Archived Emails

Within GFI MailArchiver, you can search for emails using the Search Archived Emails text box. When
searching for emails, GFI MailArchiver will query the email index retrieve any matching email and its
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respective attachment.

Apart from the Search Archived Emails text box, GFI MailArchiver also provides you with an
Advanced Search feature that provides an extensive range of search options.

NOTE

For more information, refer to Advanced Search (page 56).

In the Search Archived Emails text box, you can also use wildcards as described in the table below.

WILDCARD DESCRIPTION

? Matches any single character.

* Matches any string of characters.

Table 29: Wildcard description

For example:

To search for emails containing the word ‘Swiss’, key in ‘sw??s’ or ‘sw*s’ in the Archived Emails text
box.

Emails matching the search query are displayed in the emails pane. GFI MailArchiver displays up to 25
emails per page. If more than 25 emails are matched for each search query, GFI MailArchiver will
spread the emails out on separate pages. Use the slider at the bottom of the email pane to change
from one page to the next.

5.5 Advanced Search

The Advanced Search is an extension of the Search feature that enables you to use a wide range of
search criteria when searching for emails.

1. From the Archive tab, select .

Screenshot 18: Advanced Search Options

2. In the Advanced Search Options area, use the features described in the table below to perform an
advanced search.

OPTION DESCRIPTION

Archive Store Defines the Archive Store where the search will be performed. Select one or more Archive Stores
from the available list of Archive Stores.

Sent date Defines the date when the email to search for was sent.

Table 30: Advanced Search options
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OPTION DESCRIPTION

Includes all/any Defines whether to display emails that match all conditions or emails that match any of the
conditions. From the drop-down list select:

All – Displays emails that match at least one of the conditions specified.

Any – Displays emails that meet all the conditions specified.

Click this button to add conditions. Available conditions are:
Subject – Search for emails having a specific subject.

Sender - Specify the email address or Active Directory® display name of the email sender for
which to search emails.

Recipient - Specify the email address or Active Directory® display name of the email recip-
ient for which to search emails.

Sent Date - Search for emails sent before, after or exactly on a specific date. Key in or
select a date, and select Is before, Is after or Is exactly.

Received Date - Search for emails received before, after or exactly on a specific date. Key
in or select a date, and select Is before, Is after or Is exactly.

Size (KB) - Search for emails that are bigger, smaller or equal to a particular size. Key in a
size and select Is greater than, Is smaller than and Is exactly.

Message ID - Search using the ‘Message ID’ field contained in the email header. Key in or
paste the message ID of the email to find.

Whole Email - Search for emails that have some specific content anywhere in the email
(including the body, headers and attachments).

Body - Search for emails that have some specific content in the body.

Attachment - Search for emails that have some specific content anywhere in the attach-
ment.

Folder - Search for emails contained in a specific mailbox folder.

Folder/Subfolders - Search for emails contained in a specific subfolder within a mailbox
folder.

Label - Search for emails labeled with a specific label.

NOTE

Click displayed next to a search condition to remove it.

Exclude emails
with the following
conditions

Defines a list of conditions that the email will NOT have to meet to be returned as a search

result. Click and select the conditions to apply. The conditions that can be selected are similar
to the ones described above.

NOTE

Click displayed next to a search criteria to remove it from search.

Search Starts the search for the archived emails. Results are returned as per the conditions selected.

Reset Resets the search conditions and enables you to start all over again.

Save Saves the search conditions as a saved search query that can be triggered at any time.

5.6 Email Search Using Smart Phones

Within GFI MailArchiver, you can search for emails using a smart phone.
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NOTE

This feature is supported by the following mobile Operating Systems:

Android 2.1+

Apple iPhone iOS 4

Blackberry OS5+

To perform a simple search:

1. Launch the Internet browser on your smart phone and key in the URL where GFI MailArchiver is
located in the following format:

http://<GFI MailArchiver host name>/<GFI MailArchiver virtual folder name>

For example:

http://mydomain.com/MailArchiver

Screenshot 19: Smart Phone Login Screen

2. Sign in using your credentials.
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Screenshot 20: GFI MailArchiver Home Page for Smart Phones

NOTE

The Mobile User Interface uses the same language settings as those configured by the
user in GFI MailArchiver. For more information, refer to Changing User Preferences
(page 85).

3. Key in the text to search for and click Search.
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Screenshot 21: Search Result by Smart Phone

4. Browse through the displayed results using the controls provided. Results are sorted by date in
descending order.

NOTE

The mobile search feature returns 10 emails per page. You can browse additional pages
using the controls provided. The maximum number of results is 5000.
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Screenshot 22: Conversation View Smart Phone

5. Click the Email subject to display the email or click View Conversation to display related emails.

NOTE

The mobile user interface is focused on searching email archives. For advanced search
and browsing features, access GFI MailArchiver from your computer.

NOTE

The mobile user interface enables users to access ONLY their mailbox.

5.7 Accessing Multiple Mailboxes

From within the Archive tab, you can also browse other users’ archived emails. The users for which
you can access emails depend on the access granted from the GFI MailArchiver Access Control
feature.

NOTE

Search user to add feature is disabled if currently logged on user does not have access
to other user’s mailboxes, or if there are no emails to view.
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Screenshot 23: Accessing multiple mailboxes

To view archived emails for a different mailbox:

1. Key in the name of the mailbox for which to view emails in the Search users to add search box . A
list of names matching the one keyed and for which you have access to will be displayed.

2. Select the user and click next to the search field.

3. Select the newly added user from the Browse conversations for: field.

4. Browse or search the displayed emails using the controls provided.

5.8 GFI MailInsights

GFI MailInsights is a reporting facility within GFI MailArchiver that uses archived emails to deliver
information related to email usage and trends. Use this feature to generate management and HR
reports that provide insight on email and resource use or misuse.

NOTE

GFI MailInsights is only enabled for users with full access rights. For more information,
refer to Adding Groups to the Full Access Group (page 126).

The available reports are:
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Communication Flow – Monitor user/group communication patterns inside and outside the organ-
ization.

WebMail Use - Identify top users exchanging email with webmail services. Identifies potential data
leakages and inappropriate email use.

Email Responsiveness - Gain insight into the average time it takes users to reply to internal and
external email.

Storage Use - Understand the impact of attachments on email storage costs. Use this report to
create appropriate retention policies to control email-related storage space.

Inactive Accounts - Returns a list of user accounts that received email but have not replied within
the specified time.

Inappropriate Words - Track inappropriate language in email that violates company policy.

Internal Spammers - Find out which internal users tend to include too many recipients in the
To/CC/BCC fields. Use this report to know about and minimize such behavior.

Outside Office Hours - Returns a list of internal mail accounts with sending activity outside office
hours. Use this report to spot behavior which may need more investigation

Data Leakage Detection - Identify emails with major credit card numbers and US Social Security
numbers, or other confidential documents and information.

Job Search - Identify sent or received emails that contain resumes, or are addressed to job search
sites.

5.8.1 GFI MailInsights Requirements

GFI MailInsights requires the following configurations:

A preconfigured SMTP server. For more information, refer to General Settings (page 147).

Email indexing. For more information, refer to Indexing (page 114).

Data within Archive Stores for reports to generate successfully.

5.8.2 Generating Reports

Generated reports are sent by email either to the logged in user or to a user specified in the Send To
field. Reports are sent as an attachment in PDF format.

To generate a report:

1. Select MailInsights tab and choose desired report.

2. Use available filters by selecting a value to filter by.

3. (Optional) In the Forward to field, enter the recipient email address.

NOTE

When using the email forwarding option, the report is received by the user generating
the report and by any users specified in the Forward to field.

NOTE

You can insert multiple email addresses separated by ';'
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4. Click Send Report, located at the bottom of each report page.

5.8.3 Scheduling Reports

Every MailInsights report can be scheduled to run automatically.

To schedule a report:

1. Select MailInsights tab and choose desired report.

2. Use available filters by selecting a value to filter by.

3. Click Schedule.

Screenshot 24: MailInsights report scheduling

4. In the Report Name field, enter a meaningful name for your report.

5. (Optional) In the Forward to field, enter the recipient (or recipients) email address.

6. From the Schedule Report drop down list, select the report run frequency. Available options
are: Daily,Weekly or Monthly.

7. In the At field, specify the time.

8. Click Save & Schedule Report.

5.8.4 Communication Flow

The Communication Flow graph provides an overview of emails exchanged between selected
users/groups and their contacts.



GFI MailArchiver 5 UsingGFIMailArchiver | 65

Screenshot 25: MailInsights Communication Flow

Filter the report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting. You can only select dates in the last 6 months.

Report for Select Active Directory® user or group.

Recipients Select Internal, External or All.

Include Specify number of results up to a maximum of 1000 recipients. Default value is Top 20.

Table 31: Communication Flow Report criteria
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Screenshot 26: MailInsights Communication Flow Report

Senders can be a user or group displayed as a single entity in the middle of the report. Contacts are
segregated by domains. Each domain cluster is shown in different color. Edge width between the
nodes shows the strength of the email relation between different entities.

The table below the graph shows the following information:
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OPTION DESCRIPTION

Contact Email Contact email address

Sent Emails Total number of sent emails

Received Emails Total number of received emails

Total Emails Total number of sent and received emails

Last Communication Date and time of last sent/received email.

Table 32: Communication Flow Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.8.5 WebMail Use

The WebMail Use area enables you to generate a report that shows interaction of internal users with
web email accounts.

Screenshot 27: MailInsights WebMail Use

The report can be filtered using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting. You can only select dates in the last 6 months.

Report for Select Active Directory® user or group.

Include Specify number of results up to a maximum of 1000 recipients, default value is Top 20.

Table 33: WebMail Use Report criteria
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Screenshot 28: MailInsights WebMail Communicators Report

The graph represents total emails sent and received in specified period. A Summary area at the top of
the report shows the top WebMail providers, with a summary of sent and received emails per
provider.

The table below the graph contains the following information:

OPTION DESCRIPTION

User User email address.

Total Emails Total number of internal contacts.

Sent Emails Total number of sent emails.

Received Emails Total number of received emails.

Average/Day Average emails sent and received per day.

Total Percentage Percentage of total web emails.

Table 34: WebMail Use Report criteria
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NOTE

WebMail Use report covers the following WebMail providers: Hotmail; Gmail; Yahoo!;
Live; AOL; Facebook; Yandex.ru; Seznam.cz; Gawab.com; Gmx.com; Mail.ru;
Hushmail.com; Rediff.com

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.8.6 Email Responsiveness

The Email Responsiveness report shows how long it takes employees to reply to emails.

Screenshot 29: MailInsights Email Responsiveness

Filter the report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (Last 7 days). You can only select dates in the last 6 months.

Report for Select Active Directory® user or group.

Include Specify number of results up to a maximum of 1000 recipients, default value is All.

Sort By Specify sorting method. Options are:
By name (default)

By responsiveness

Table 35: Email Responsiveness Report criteria
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Screenshot 30: MailInsights Email Responsiveness Report

The bar chart represents users on the y-axis and responsiveness in hours on the x-axis. Data is sorted
according to defined criteria.

Additional data is displayed in a table below the chart with the following information:

OPTION DESCRIPTION

User Name or email address of user

Average responsiveness All Email (Hours)

Average Internal responsiveness Internal Email (Hours)

Average external responsiveness External Email (Hours)

Table 36: Email Responsiveness Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports
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5.8.7 Storage Use

The Storage Use report shows how much space is used by different attachment categories.

Screenshot 31: MailInsights Storage Use

Filter report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (This Month). You can only select dates in the last 6 months.

Report for Select Everyone (default), Active Directory® user or group

Table 37: Email Storage Report criteria
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Screenshot 32: MailInsights Storage Use Report

The graph consists of stacks representing different attachment categories. The graph’s x-axis shows
the different size brackets and the y-axis shows the attachment size.

NOTE

Attachment categories for Storage Use report are: Images, Documents, Music, Videos
and Others

The table below the graph contains the following additional information:

OPTION DESCRIPTION

Date Date email was received.

Total Size (KB) Total size of attachment.

Images (KB) Total size of attachment for category Images.

Table 38: Storage Use Report criteria
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OPTION DESCRIPTION

Documents (KB) Total size of attachment for category Documents.

Music (KB) Total size of attachment for category Music.

Videos (KB) Total size of attachment for category Videos.

Other (KB) Total size of attachment for category Other.

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.8.8 Inactive Accounts

The Inactive Accounts area enables you to generate a report that shows internal accounts that are no
longer active.

Screenshot 33: MailInsights Inactive Accounts

Filter report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (Last 30 days). You can only select dates in the last 6 months.

Table 39: Inactive Accounts Report criteria
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Screenshot 34: Inactive Accounts Report

NOTE

An inactive account is an account that has received emails but has not sent any emails
in the date range covered.

The report returns a list of inactive accounts.

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.8.9 Inappropriate Words

The Inappropriate Words area enables you to generate a report that identifies any inappropriate
language used in emails. Inappropriate words can include words considered sexist, racist or swear
words.
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Screenshot 35: MailInsights Inappropriate Words

Filter the report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (Today). You can only select dates in the last 6 months.

Recipients Select All, Internal Only, External Only

Table 40: Inappropriate Words Report criteria
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Screenshot 36: MailInsights Inappropriate Words Report

NOTE

When the Inappropriate Words report exceeds 1,500 rows, the report will be generated
in .xls format.

Report data is displayed in a table listing the following:

OPTION DESCRIPTION

Date/Time Email date and time

Sender Sender email address

Subject Email subject

Table 41: Inappropriate Words Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.8.10 Internal Spammers

The Internal Spammers report enables you to generate a list that identifies internal email accounts
of users who include a large number of recipients in their emails. This reports takes into
consideration recipients in the To, CC or BCC fields.
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Screenshot 37: MailInsights Internal Spammers

Filter the report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (Last 30 days). You can only select dates in the last 6 months.

Include Specify the amount of email accounts to include up to a maximum of 1000 users.

Table 42: Internal Spammers Report criteria
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Screenshot 38: MailInsights Internal Spammers Report

Report data is displayed in a table listing the following:

OPTION DESCRIPTION

Username Sender username or email address.

Average Number of Recip-
ients

Average number of recipients who received email from the sender during the specified
time period.

Table 43: Internal Spammers Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports
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5.8.11 Outside Office Hours

Use this report to identify internal users who send emails outside of office hours.

Screenshot 39: MailInsights Outside Office Hours

Filter the report using the following criteria:

OPTION DESCRIPTION

Report
for

Enables you to choose for whom this report applies. Run report on all employees (default) or on an Active
Directory® group.

Include Specify number of results to display, up to a maximum of 1000. Default = 50.

Scope Specify date range or use default setting (This Month). You can only select dates in the last 6 months.

Table 44: Outside Office Hours Report criteria
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OPTION DESCRIPTION

Office
Hours

Enter a time range according to your organization's normal working hours.

Working
Week

Select the days of work of your organization. Checked days are considered as part of normal office hours.

Non-
Working
Days

Use the calendar to define non-working days for past and future dates. Selected dates are listed in the
provided window. Non-working days can include public holidays and company shutdown.

IMPORTANT
The settings will only be saved upon successful generation of the report. If you navigate away from the
page before generating the report, all settings will be lost.

NOTE
When using the Clear All Dates button, configured dates will be cleared for all years.

The following examples describe how the report will work when configured in typical scenarios:

Scenario 1: An organization working from Monday to Friday, with start time and end time within the
same day, example from 9.00 am to 6.00 pm.

The report will cover emails sent between 6.00 pm and 9.00 am from Monday to Friday, and all day
during Saturday and Sunday.

Scenario 2: An organization working from Monday to Friday. Start time and end time span across
midnight, example from 8.00 pm to 5.00 am.

In this case the report will cover emails sent between 5.00 am and 8.00 pm from Monday to Friday
and those sent on Saturday and Sunday. Emails sent on Saturdays between midnight and 5.00 am will
not be taken into account, since they are considered within normal working hours.

Scenario 3: An organization working from Monday to Friday. Start time and end time span across
midnight, Wednesday is a public holiday.

The report will cover emails sent between 5.00 am and 8.00 pm from Monday to Friday, emails sent
on Saturday and Sunday, and all emails sent on Wednesday from midnight to midnight.
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Screenshot 40: MailInsights Outside Office Hours Report

The results of the generated report are displayed in a horizontal bar chart. A report summary above
the chart displays the top 3 users who sent emails outside office hours.

Additional data is displayed in a table below the chart with the following information:

OPTION DESCRIPTION

Email Email address of user

Number of Emails Sent Number of emails sent outside office hours

Table 45: Outside Office Hours Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports
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5.8.12 Data Leakage Detection

Use this report to detect emails that potentially contain sensitive data. The report will detect sent or
received emails containing:

Major credit card numbers (VISA, Mastercard, American Express, Diner’s Club, Discover)

USA Social Security numbers

Confidential documents and information

NOTE

The report analyzes both sent and received email for a selected user.

Screenshot 41: MailInsights Data Leakage Detection report

Filter the report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (Last 3 Months). You can only select dates in the last 6 months.

Report for Enables you to choose for whom this report applies. Run report on all employees (default) or on an Active
Directory® user or group.

Recipients Internal recipients, external recipients or both. Default is both.

Table 46: Data Leakage Detection Report criteria
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Screenshot 42: MailInsights Data Leakage Detection Report

The results of the generated report are listed in a table sorted by date in ascending order. A report
summary above the table displays the top 3 senders.

The table contains the following information:

OPTION DESCRIPTION

Date Displays the date and time of the email.

Sender Sender email address.

Subject Email subject.

NOTE
Entries in the subject column contain a link to display the detected email.

Leakage Type Leakage type can be: Credit card, Social Security Number, confidential data, medical,

NOTE
If more than one type of leak is detected, only the first one is displayed.

Table 47: Data Leakage Detection Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.8.13 Job Search

Use this report to identify internal users who exchange emails with job search sites. The report
detects sent or received emails containing resumes.

NOTE

The report is able to identify both sent and received email for a selected user.



GFI MailArchiver 5 UsingGFIMailArchiver | 84

Screenshot 43: MailInsights Job Search report

Filter the report using the following criteria:

OPTION DESCRIPTION

Scope Specify date range or use default setting (This Month). You can only select dates in the last 6 months.

Report
for

Enables you to choose for whom this report applies. Run report on all employees (default) or on an Active
Directory® user or group.

Domains The list of domains listed in this area will be added to the search criteria of the report. Add domains by

typing the URL in the available field and clicking . To remove a domain, click . Clear all removes all the
listed URLs.
The default list of job search sites includes: Monster.com; Jobster.com; jobcentral.com; hotjobs.yahoo.com;
careerbuilder.com; indeed.com; simplyhired.com; jobing.com; reed.co.uk; jobsearch.co.uk; monster.co.uk;
totaljobs.com; fish4.co.uk; cityjobs.com.

Table 48: Job Search Report criteria
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Screenshot 44: MailInsights Job Search Report

The results of the generated report are listed in a table sorted by date in ascending order. A report
summary above the table displays the top 3 users who exchanged emails with job search domains.

The table contains the following information:

OPTION DESCRIPTION

Date Displays the date and time of the email.

Sender Sender email address.

Subject Email subject.

NOTE
Entries in the subject column contain a link to display the detected email.

Table 49: Job Search Report criteria

For further information, refer to:

Generating MailInsights reports

Scheduling MailInsights reports

5.9 Changing User Preferences

1. Click the user name displayed on the upper right hand corner of the screen.
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Screenshot 45: User profile preferences

2. From the Language options drop down box, select the language to display.

3. From the Maximum page size area, configure the number of emails to display per page.

4. From the Audit Reports Date/Time Format area (available only if logged in as an administrator),
change the date/time format to display on audit reports.

5. Click Save.
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6 Monitoring GFI MailArchiver operations

6.1 Introduction

Through the GFI MailArchiver Home tab, you can easily monitor your GFI MailArchiver installation.
The graphical and statistical information provides a real-time overview of the general operational
parameters of GFI MailArchiver. It also helps to identify any issues before these have serious
repercussions on your system.

6.2 Using the Home Tab

Screenshot 46: The GFI MailArchiver dashboard

From the GFI MailArchiver interface, select the Home tab. The information is displayed in various
screen elements that are grouped by type. The sections below describe each section and how to
interpret the data presented:

About GFI MailArchiver

Heartbeat

Servers

Archive Stores

Email Flow

Event Viewer
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6.2.1 About GFI MailArchiver

Screenshot 47: About GFI MailArchiver area

The ‘About GFI MailArchiver’ area provides you with important licensing information required for
correct operation of GFI MailArchiver. The information displayed includes:

Version and build number – Shows the version and build of the current GFI MailArchiver instal-
lation

License validity – Shows whether license key is valid and whether the installation is in evaluation
or fully licensed mode.

Number of licenses used – Shows how many licenses are still free for use within GFI MailArchiver.

Legal Hold – Shows whether Legal Hold is enabled or not.

6.2.2 Heartbeat

Screenshot 48: GFI MailArchiver Heartbeat

The ‘Heartbeat’ area shows the time since last successful connection to Mail Servers, Archive Stores
and Notification Servers. This enables you to quickly identify any unresponsive servers and investigate
any interruptions in service.
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6.2.3 Servers

Screenshot 49: Servers area

The ‘Servers’ area provides you with information on how much disk space you have free on the Server
where GFI MailArchiver is installed. This enables you to easily keep track of any servers that are
running out of disk space and to take remedial action before you run out of disk space.

6.2.4 Archive Stores

Screenshot 50: Archive Stores area

The ‘Archive Stores’ area provides information about the total number of emails stored in Archive
Stores and the number of Archive Stores used.. This information enables you to identify whether the
Archive Stores previously configured are archiving emails as per schedule and whether you should
start considering moving to an alternate Archive Store.
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6.2.5 Email Flow

Screenshot 51: GFI MailArchiver Email flow area

The ‘Email Flow’ graph provides a graphical overview of the quantity of emails that GFI MailArchiver
is archiving. Spikes or dips that fall outside of the normal email flow should be investigated since this
can indicate that email journaling is not functioning correctly.

The ‘Email Flow’ graph is customizable to enable to view the flow for all journal mailboxes, a single
mailbox or a specific period. To customize the view:

1. Click Change Filter.

Screenshot 52: Email flow area configuration

2. Change any of the values listed and click Done. Available options are:

OPTION DESCRIPTION

Source Defines what the email flow area will show in terms of either the whole queue or a single
journal mailbox. Select Queue to view the entire queue or a mailbox name to view a single
journal mailbox.

Period Defines the period of time that will be shown in the email flow area.

Table 50: Email flow area options



GFI MailArchiver 6Monitoring GFIMailArchiver operations | 91

OPTION DESCRIPTION

Start Data and Time:
Defines the start date that will be shown in the email flow area. Click to set the date

and to set the time.

End Date and Time:
Defines the end date that will be shown in the email flow area. Click to set the date

and to set the time.

6.2.6 Event Viewer

Screenshot 53: Event Viewer tab

The ‘GFI MailArchiver Event Viewer’ provides information about GFI MailArchiver events. The
messages that are provided here enable you to gain information about system processes that are
typically hidden from the system administrator’s view but which can lead to you to discover that
some system functions require your attention.
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7 Configuring GFI MailArchiver

7.1 Settings Overview

GFI MailArchiver enables you to gain a comprehensive overview of the settings currently in force
within GFI MailArchiver.

NOTE

Use the buttons located in the top right hand corner of the Configuration page to
switch between Tile and List View.

Screenshot 54: GFI MailArchiver Settings Page

Click Configuration tab to load the Overview of current settings page.

The table below describes the information available.

OPTION DESCRIPTION

Archiving Method Shows the Archiving Method currently enabled. An Archiving Method needs to be specified for GFI
MailArchiver to start archiving emails.

Mail Servers to
Archive

Shows the number of Journal mailboxes configured for use with this installation of GFI
MailArchiver.

Archiving Rules If Rule-based Archiving is enabled, the number of configured rules is displayed.

Table 51: Overview of current settings
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OPTION DESCRIPTION

Mailboxes to
Archive

Shows whether User Mailbox Archive Restrictions are in force or not. User Mailbox Archive
Restrictions define which mailboxes to archive.

Archiving Scope Shows whether Email Archive Restrictions are in force or not. These define whether incoming, out-
going, or internal emails (or a combination) are archived.

Mailbox Folder
Structure Retrieval

Shows whether Folder Structure Retrieval is enabled or not. Folder Structure Retrieval enables
the replication of the folder structure of the mailboxes within Microsoft® Exchange Server with
GFI MailArchiver.

Archive Stores Shows the number of Archive Stores configured with this installation of GFI MailArchiver.

Access Control Archive Mailbox Access defines who has access to which mailboxes.

Import old emails Provides information on how to import emails to this installation of GFI MailArchiver.

IMAP Server Shows whether IMAP Server is enabled or not. When enabled, users can retrieve archived emails
using supported IMAP email clients.

Retention and
Spam policies

Retention and Spam policies define the lifetime of an archive email within GFI MailArchiver.
Emails matching specific criteria can be deleted immediately or after a specific period of time.

Classification Rules Email Classifications automate the labeling of emails through policies. Emails matching specific
criteria can be automatically classified.

Auditing Shows and defines whether GFI MailArchiver Auditing is switched on or not.

Email Deletion Shows whether Email Deletion is enabled or not. When enabled, users can permanently delete
archived emails from mailboxes they have access to.

Change license key Displays license key information associated with your GFI MailArchiver installation

General Settings Displays the version and build number of the current GFI MailArchiver installation

7.2 Configuring Archiving Method

The Archiving Method enables you to define how GFI MailArchiver stores emails in the archive stores.

IMPORTANT

Without an Archiving Method GFI MailArchiver will not archive any emails.

To configure Archiving Method:

1. Select Configuration tab and from Mail Servers to Archive, click Archiving Method.
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Screenshot 55: Configuring Archiving Method

2. Click Configure Archiving Method.

3. From the Archiving Method Wizard page, select from the following options:

OPTION DESCRIPTION

Manual Archiving Enables users to manually select which emails to archive from their Microsoft Outlook®

applications using GFI MailArchiver Outlook Addon. Users are also able to define a folder
structure when manually archiving their emails to facilitate searches.

Auto-Archiving (Jour-
naling)

When selected, GFI MailArchiver will automatically move emails from Microsoft® Exchange
Server to an Archive Store.

All Emails Select this option to archive all incoming emails.

Rule-Based Archiving Archive specific emails from journaling that match configured rules and specify how these
emails are archived in particular folders. For more information, refer to Configuring
Archiving Rules (page 99).

IMPORTANT
Emails are not archived if Archiving Rules are not configured.

Table 52: Archiving Method Wizard options
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NOTE

More than one method of archiving can be selected. For example, you can enable
Manual Archiving and Auto-Archiving (Journaling) of All Emails at the same time.

4. Click Save.

7.3 Managing the Mail Servers to Archive

Within GFI MailArchiver, the mail servers to archive are defined by the configured journal mailboxes.

A Journal mailbox is a type of mailbox within Microsoft® Exchange Server that enables the recording
of emails in an organization. The difference between journaling and archiving is that, by definition,
journaling is the ability to record emails while archival reduces the strain of storing data through
backups, removal, and storage. GFI MailArchiver uses Microsoft Exchange journaling to centralize all
the emails to archive in a single mailbox. An initial Journal mailbox is configured using the GFI
MailArchiver post-install wizard. This enables you to start archiving emails from a Microsoft®

Exchange Server.

This section provides information on how to:

View configured mail servers

Create Journal Mailboxes in Microsoft® Exchange Server and use them with GFI MailArchiver

Editing existing Journal Mailbox details

Removing existing Journal Mailbox details

IMPORTANT

For journaled emails to be archived within GFI MailArchiver, the archiving method Auto-
Archiving (Journaling)must be enabled. For more information, refer to Configuring
Archiving Method (page 93).

NOTE

GFI MailArchiver will create the Journal Mailbox for you within Microsoft® Exchange
Server using the GFI MailArchiver post install wizard. For more information, refer to
Appendix 1 - Journal Mailbox Manual Operations (page 230).

In this chapter:

7.3.1 Viewing Configured Mail Servers 96

7.3.2 Adding a New Journal Mailbox 96

7.3.3 Editing an Existing Journal Mailbox 98

7.3.4 Deactivating and Activating an Existing Journal Mailbox 99

7.3.5 Removing an Existing Journal Mailbox 99
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7.3.1 Viewing Configured Mail Servers

To view configured mail servers from where GFI MailArchiver archives emails, select the
Configuration tab and from Overview of current settings, click Mail Servers to Archive.

Screenshot 56: Manage Journaling Mailboxes screen

The table below provides a list of available information and options:

OPTION DESCRIPTION

Journal Mailbox Defines the name of the Journal mailbox set up within Microsoft® Exchange Server and con-
figured for use within GFI MailArchiver.

Active Denotes whether the Journal Mailbox is active or not.

Mailbox Server The machine name of the server on which the Journal Mailbox is configured.

Mailbox Store Defines the name of the Mailbox Store to which the configured Journal Mailbox belongs.

Connection Type Defines the type of connection that GFI MailArchiver will use to retrieve emails from the
mail servers to archive emails from.

Table 53: Mail Server options

7.3.2 Adding a New Journal Mailbox

1. Select Configuration tab and click Mail Servers to Archive.

Screenshot 57: Add Journaling Mailbox

2. Click .
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Screenshot 58: Choose how you want the wizard to setup GFI MailArchiver to use a journal mailbox.

3. From the Journal Mailbox Wizard page, select whether to automatically create a new Journal
Mailbox or whether to manually specify all the Journal Mailbox details. GFI MailArchiver Journal
Mailbox Wizard can also detect any existing journaling mailboxes and gives you the facility to use
them.

OPTION DESCRIPTION

Select a journal mailbox from
the detected journal mailbox
list below.

Displays a list of Journal Mailboxes that were detected by the GFI MailArchiver
Journal Mailbox Wizard. Select this option and a Journal Mailbox from the list
displayed to use the selected mailbox.

Let the wizard create a new
journal mailbox to use to start
archiving your emails

Provides the facility to automatically create a new Journal Mailbox. Select this
option and a detected Microsoft® Exchange Server to create the new journal mailbox
for.

NOTE
This feature works only with Microsoft® Exchange Server 2007 Service Pack 2
onwards.

Manually create a journal mail-
box using this wizard.

Provides the facility to create a new Journal Mailbox while providing all the details
required to create such mailbox. These may include specifying a Mailbox Store, the
connection method, ports used and credentials.

Table 54: Journal Mailbox wizard options

Click Next to continue setup.
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4. If you have selected Let the wizard create a new journal mailbox to use to start archiving your
emails or Manually create a journal mailbox using this wizard option in the Journal Mailbox Wizard
screen, you will now be prompted to key in the required details for the Journal Mailbox. If Select a
journal mailbox from the detected list to use to archive your emails was selected, click Next.

Available options are:

OPTION DESCRIPTION

Mail Server Shows the detected name of the mail server of where the Journal Mailbox resides.

Connect using: Defines the connection method used to connect to the Mail Server where the new Journal Mailbox
will be created. Available options are:

ExOLEDB – Available only if GFI MailArchiver is installed on the same machine as Microsoft®

Exchange Server 2003 or 2007.

IMAP - Available only if GFI MailArchiver is not installed on the same machine as Microsoft®

Exchange Server 2003 or 2007.

Exchange Web Services (EWS) - Available only for Microsoft® Exchange Server 2007 SP1 or
2010.

Login:/Password: Enables you to key in a login name and a password used to connect to the selected mail server.

Folder Defines the default folder that is used to journal emails.
Default value: Inbox.

Table 55: Existing Journal Mailbox options

5. Click Next to continue setup.

Screenshot 59: Existing mailbox added successfully

6. Click Finish to finalize Journal Mailbox setup.

7.3.3 Editing an Existing Journal Mailbox

1. Select Configuration tab and from Overview of current settings, click Mail Servers to Archive.
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2. Select a Journal Mailbox to edit and click .

3. From the Journal Mailbox Wizard page, adjust the settings as per the instructions in the Adding a
New Journal Mailbox section within this chapter in this manual.

7.3.4 Deactivating and Activating an Existing Journal Mailbox

1. Select Configuration tab and from Overview of current settings, click Mail Servers to Archive.

2. Select a Journal Mailbox to edit and click to deactivate an existing Journaling mailbox

or to activate a previously deactivated journal mailbox.

7.3.5 Removing an Existing Journal Mailbox

1. Select Configuration tab and from Overview of current settings, click Mail Servers to Archive.

2. Select the Journal Mailboxes to delete and click .

IMPORTANT

Deleting a Journal Mailbox is an irreversible procedure. Journal mailbox emails cannot
be retrieved if deleted.

IMPORTANT

Removing a Journal Mailbox from GFI MailArchiver does not delete or make inoperative
any existing Journal Mailboxes in Microsoft® Exchange Server.

For more information on how to remove Journaling Mailboxes from Microsoft® Exchange Server, refer
to Disabling Journaling section within Appendix 1 - Journal Mailbox Manual Operations in this manual.

7.4 Configuring Archiving Rules

IMPORTANT

This feature is disabled if Rule-based Archiving is not enabled in the Archiving Method
wizard. For more information, refer to Configuring Archiving Method (page 93).

A number of Archiving Rules can be set up to determine what emails are archived. Rules are created
based on different criteria, and GFI MailArchiver applies each rule against incoming and outgoing
emails that match configured rules. If a rule is matched, the email is archived and moved to the
configured folder.

IMPORTANT

Enabling this feature may breach company policy or legal compliance related to email
retention.
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Screenshot 60: Configuring Archiving Rules

NOTE

GFI MailArchiver applies rules from top to bottom of the list. Rules can be moved up or
down the list using the provided arrows.

IMPORTANT

Emails archived through the GFI MailArchiver Outlook Addon get archived irrespective of
any rules set in Rules-based Archiving.

In this chapter:

7.4.1 Adding Archiving Rules 100

7.4.2 Editing Archiving Rules 102

7.4.3 Removing Archiving Rules 102

7.4.1 Adding Archiving Rules

To add an Archiving Rule:

1. From Configuration tab, click Archiving Rules.

2. Click Add.
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3. In the Rule Name field, specify a meaningful name for the archiving rule.

4. In the Email Criteria section, specify rule conditions from the available options described in the

table below. Click to add more conditions.

CONDITION DESCRIPTION

Subject Emails that match the specified subject are archived.

Body Emails that are an exact match to the a word or a sentence specified in this criteria are archived.

Sender Select Email and type the email address or select User and type the name of the user.

NOTE
A list of AD users will be displayed when you start typing the first letters of an email address or a
user name.

Recipient Select Email and type the email address or select User and type the name of the user.

NOTE
A list of AD users will be displayed when you start typing the first letters of an email address or a
user name.

Full email
size

Select a filter from the available options (Equals, Greater Than, Greater or Equal Than, Smaller Than,
Smaller or Equal Than) and specify an email size in MB.

Attachment
Size

Select a filter from the available options (Equals, Greater Than, Greater or Equal Than, Smaller Than,
Smaller or Equal Than) and specify an attachment size in MB.

Table 56: Archiving Rule conditions
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CONDITION DESCRIPTION

Attachment
Type

Select a filter from the available options: Images, Documents, Music, Videos, Custom.

5. In the Place matching email in folder field, specify to which folder the email is archived.

NOTE

Using special characters in folder names

By default, Inbox\ is displayed in the Place matching email in folder field. This path
can be overwritten with the desired folder path using the following conventions:

\ (back slash) is represented by /\

/ (forward slash) is represented by //

For example:

To input a folder path for the following folder structure:

Input the following path in the Place matching email in folder field:
Inbox\Managerial//CEO\Requests/\Queries

NOTE

If the folder specified by the user does not exist, it is created automatically.

6. Click Next.

7. Click Finish.

7.4.2 Editing Archiving Rules

To edit an Archiving Rule:

1. From Configuration tab, click Archiving Rules.

2. Click Edit.

3. Use the Archiving Rule Wizard to modify the required fields.

4. Click Finish.

7.4.3 Removing Archiving Rules

1. Select Configuration tab and click Archiving Rules.

2. Select the rule or rules to delete and click .

7.5 Mailbox Archive Restrictions

Mailbox archive restrictions enable you to define specific mailboxes to exclude from archiving. This
feature can also be used to exclude all mailboxes from archival while including only specific ones.
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7.5.1 Enabling Mailbox Archive Restrictions

1. Select Configuration tab and from Overview of current settings, click Mailboxes to Archive label.

2. Click Change Settings.

Screenshot 61: Select Enable Archiving Restrictions

3. Select Enable Archiving Restrictions and choose one of the following options:

EXCLUSION / INCLUSION OPTION

Using an exclusion list DO NOT archive email at all if ANY of the recipients or senders are in the
restriction list

Always archive email but users in the restriction list will not be able to view
it

NOTE
When Manual Archiving is configured, users in an exclusion list cannot
manually archive emails using GFI MailArchiver Outlook Addon if any of these
options is enabled.

Table 57: Archiving restriction options
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EXCLUSION / INCLUSION OPTION

Using an inclusion list Always archive email if ANY of the recipients or senders are in the restric-
tion list

Only archive email if all recipients and senders are in the restriction list

NOTE
When Manual Archiving is configured, all users in an inclusion list are able to
manually archive emails using GFI MailArchiver Outlook Addon if any of these
options is enabled.

NOTE

Emails archived manually using the GFI MailArchiver Outlook Addon are always archived,
even when an exclusion list is configured.

4. Click Save.

Screenshot 62: Add emails, groups or users
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5. Click and select an option between email, group or users and key in the email,
group name or user name of the user to restrict.

6. Click Save.

7.5.2 Disabling Mailbox Archive Restrictions

To disable mailbox archive restrictions, select Configuration tab and from Overview of current
settings, click Mailboxes to Archive label. Click Change Settings, unselect Enable Archiving
Restrictions and click Save.

7.6 Managing the Archiving Scope

The Archiving Scope enables you to define which types of emails to archive. Using this feature you
can, for example, instruct GFI MailArchiver to exclude internal emails from being archived or to
include all inbound and internal emails while excluding all outbound emails.

1. Select Configuration tab and from Overview of current settings, click Archiving Scope.

Screenshot 63: Configuring email archive restrictions.

2. Select Configure Archiving Scope and from the list displayed unselect the emails to exclude from
archiving as shown in the table below :

OPTION DESCRIPTION

Inbound
emails

Defines whether GFI MailArchiver will archive emails originating from outside the organizations’ domain.
Uncheck this option to not archive this type of emails.

Outbound
emails

Defines whether GFI MailArchiver will archive emails destined to recipients not within the organizations’
domain. Uncheck this option to not archive this type of emails.

Internal
emails

Defines whether GFI MailArchiver will archive emails originating from and destined to the organizations’
domain. Uncheck this option to not archive this type of emails.

Table 58: Email archive restrictions options

3. Click Save to save configuration.

7.7 Configuring Mailbox Folder Structure Retrieval

By default, GFI MailArchiver does not automatically archive emails according to the folder structure in
which they were originally contained within the source mailbox. To replicate the folder structure of
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the original mailboxes, enable the GFI MailArchiver Folder Structure Retrieval feature.

IMPORTANT

The GFI MailArchiver Folder Structure Retrieval feature adds a computational and
network access overhead to the archival process and may slow down your system.

This feature requires a user account with access to all mailboxes to which to retrieve the folder
structure. GFI MailArchiver can automatically create this account.

7.7.1 Enabling Mailbox Folder Structure Retrieval

1. Select Configuration tab and from Overview of current settings, click Folder Structure Retrieval
label.

2. Select Change Settings.

Screenshot 64: Enable folder structure retrieval

3. Select Enable Folder Structure Retrieval.

4. Select whether to automatically create a new user account or whether to use an existing user
account. This user account will be used to access the mailboxes for which to replicate the folder
structure.

The table below shows a list of available options.
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OPTION DESCRIPTION

Create a new user
account

Instructs GFI MailArchiver to create a new user account using the provided details in the Connect
using, Login, and Password fields.

Use an existing
user account

Instructs GFI MailArchiver to use an existing user account that was previously created.

Connect using Defines the connection method used to connect to the Microsoft® Exchange Server to access the
mailbox structure to retrieve.
Available options:

Exchange Web Services (EWS) - Recommended for Microsoft® Exchange Server 2007 SP1 or
2010 mail servers.

Traditional Message Application Programming Interface (MAPI) - Recommended for NON
Microsoft® Exchange Server 2007 SP1 or 2010 mail servers.

Login Enter the Login name that will be used for the new account to create or for the previously created
account.

Password Defines the Password used for the new account or for the previously created account.

Table 59: Folder Structure Retrieval Options

Click Next to continue setup. If in the previous screen you have selected Create a new user account,
you will be asked to provide the user credentials of the domain administrator account with the rights
to create the account.

5. Click Finish to finalize setup.

6. Click Save to save Folder Structure Retrieval settings.

7.7.2 Disabling Mailbox Folder Structure Retrieval

1. Select Configuration tab and from Overview of current settings, click Folder Structure Retrieval
label.

2. Click Disable Folder Structure Retrieval.

IMPORTANT

Disabling Folder Structure Retrieval does not delete or disable the user account
previously created for this feature.

7.7.3 Excluding Folders From Folder Structure Retrieval

If there are any folders that you wish to exclude from being retrieved, configure an Excluded Folders
policy.

1. Select Configuration tab and from Overview of current settings, click Folder Structure Retrieval.

2. Click .
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Screenshot 65: Add exclude policy

3. Key in a policy name for the Exclude Folders Policy and select the Enable excluded folder policy
checkbox to apply the policy immediately. Click Next to continue.

4. Key in the name of the folder to exclude and click Add. Click Next to continue.

NOTE

To exclude users from Folder Structure Retrieval, specify * as the folder name. The * is
a special keyword that represents all folders. For more information refer to SkyNet
article at the following link: http://go.gfi.com/?pageid=MAR_ExcludeFolders.

http://go.gfi.com/?pageid=MAR_ExcludeFolders
http://go.gfi.com/?pageid=MAR_ExcludeFolders
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Screenshot 66: Select users to exclude

5. To exclude the folders specified in the previous screen for specific users, select Selected users
only:.

6. From the drop down list, select User or Email and key in the relative email address or user name.
Click Add and repeat to add other users.

NOTE

If Selected users only: is not enabled, the folders specified in the previous screen are
excluded for all users.

7. Click Finish to finalize setup.

7.7.4 Removing Excluded Folders Policies

1. Select Configuration tab and from Overview of current settings, click Folder Structure Retrieval
label.

2. Select the Excluded Folder policy to remove and click .
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7.8 Managing Archive Stores

Within GFI MailArchiver, Archive Stores are the containers that contain the archived emails. Archive
Stores include several components, such as:

A database where email metadata is stored

A database where both email metadata and email data is stored

A disk location used as an email index

A disk location used as storage for email data.

Archive Stores are created automatically by GFI MailArchiver, based on an Archive Store Profile that
defines their name, database type and file locations.

IMPORTANT

If New Archive Store Settings are not configured, emails are not archived. For more
information, refer to Configuring Archive Store Settings (page 111).

In this chapter:

7.8.1 Viewing Configured Archive Stores 110

7.8.2 Configuring Archive Store Settings 111

7.8.3 Choosing and Preparing a Database for Use With GFI MailArchiver 112

7.8.4 Attaching an Archive Store 112

7.8.5 Editing Existing Archive Store Details 113

7.8.6 Detaching an Existing Archive Store 114

7.8.7 Indexing 114

7.8.8 Scheduling Archive Stores 117

7.8.9 Backup Archive Stores 118

7.8.10 Online Backup 118

7.8.11 Offline Backup 118

7.8.12 Moving Emails From One Database to Another 123

7.8.13 Upgrading the database schema 124

7.8.14 Attaching a GFI MailArchiver 3 Database 125

7.8.1 Viewing Configured Archive Stores

To view configured Archive Stores, select Configuration tab and from Archive area, click Archive
Stores.
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Screenshot 67: Viewing Archive Stores

Configured Archive Stores are grouped by year and listed in tables with the most recent on top.

The table below shows the available Archive Store fields:

OPTION DESCRIPTION

Archive Store Defines the name given to the Archive Store previously configured.

Start Date The start date indicates the first day of the period for emails contained within the archive store.
Emails that fall outside this range are archived in another Archive Store.

End Date The end date is the last day of the period for emails contained within the archive store. Emails
that fall outside this range are archived in another Archive Store.

Status Defines the status of the Archive Store in question. Available statuses include:
Empty: Denotes that the Archive Store is not yet in use.

Active: Denotes that the Archive Store is currently in use.

Inactive: Denotes that the Archive Store was used in the past but is no longer used.

Read-only: A Read-only Archive Store can be accessed and is available for search but new
emails cannot be archived within it.

Table 60: Archive Store table

Select an Archive Store from any Archive Stores list and click to view more information
about that Archive Store’s settings and statistics.

7.8.2 Configuring Archive Store Settings

The New Archive Store Settings enable GFI MailArchiver to use a set of previously keyed in settings to
create new archive stores automatically. To view a summary of the current Archive Store settings:

1. Select Configuration tab.

2. From Overview of current settings, click Archive Stores.

3. Click next to Summary of Archive Store Settings.
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NOTE

After installing GFI MailArchiver, you will be prompted by the post installation wizard to
configure an Archive Store Profile.

To edit Archive Store Settings:

1. Select Configuration tab and from Overview of current settings, click Archive Stores.

2. Click .

3. Follow the on-screen instructions to edit the existing Archive Store Settings.

7.8.3 Choosing and Preparing a Database for Use With GFI MailArchiver

As an archiving solution, GFI MailArchiver is highly dependent on your database infrastructure setup
for high performance in terms of data archival and retrieval.

GFI MailArchiver can be configured to run in various hardware setups and combinations. The table
below shows the typical recommended configurations. These guidelines and configurations may vary
according to user activity, daily email flow and the software configurations (such as Folder Structure
Retrieval).

MAILBOXES/VOLUME RECOMMENDED
DATABASE TYPE

DESCRIPTION

50 mailboxes or less Evaluation
ONLY

GFI MailArchiver
database

Uses a Firebird-based database to archive all email data.

100 mailboxes or less Average
mail flow of up to 6000
emails/day

SQL Server®

Express with File
Storage

Uses a SQL Server® Express database to store email headers
and metadata and a disk location you specify to store email
data.

50 mailboxes or more Average
mail flow of more than 8000/day

Microsoft® SQL
Server

Uses a SQL Server® database to store both email
headers/metadata as well as email data.

More than 500 mailboxes
Average mail flow of more than
8000/day

Microsoft® SQL
Server with File
Storage

Uses a SQL Server® database to store email headers and
metadata and a disk location you specify for the email data.

Table 61: Database type recommendations

7.8.4 Attaching an Archive Store

GFI MailArchiver Archive Stores can be detached and attached again, for example when moving GFI
MailArchiver to a new server. For information on how to detach an Archive Store, refer to Detaching
an Existing Archive Store in this chapter.

1. From Configuration tab, click Archive Stores.

2. Click Attach Archive.



GFI MailArchiver 7 Configuring GFIMailArchiver | 113

Screenshot 68: Attaching an Archive Store

3. In the Archive Store Name field, type the name of the archive to attach.

4. (Optional) Unselect Allow users to browse and search this archive store if you want to disable
search for this particular Archive Store.

5. (Optional) Select Read-only access if you want to stop emails from being archived in this Archive
Store. Emails can be viewed but cannot be deleted if this option is selected.

6. Click Next.

7. Select the database type where you want to store archived emails and click Next.

8. Specify the Database File Location, Email File Location and Search Index Location and click
Next.

9. Review the Archive Store Summary and click Next.

10. Click Finish.

7.8.5 Editing Existing Archive Store Details

1. Select Configuration tab and from Overview of current settings, click Archive Stores.

2. Select an existing Archive Store and click .

3. Follow the on-screen instructions to edit the existing Archive Store.
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7.8.6 Detaching an Existing Archive Store

1. Select Configuration tab and from Overview of current settings, click the number of active
configured Archive Stores.

2. Select an existing Archive Store and click .

IMPORTANT

Detaching an Archive Store does not delete any Archived Email data.

7.8.7 Indexing

The Search Index feature within GFI MailArchiver automatically indexes new email content archived
in the corresponding archive store. This constantly updated search enables users to perform precise
and fast searches.

This section will show you how to configure the frequency with which GFI MailArchiver shall index new
archived emails into the search indexes. You will also learn how to force a full search index rebuild, in
cases where you might suspect that the search index is no longer valid.

Important Notes

1. Search indexes must always reside on a local hard drive. Indexing will not be available if the index
path is specified via a UNC path.

2. For best performance, locate the search index on a separate physical drive than where:

Microsoft® Exchange Server is installed

GFI MailArchiver is installed

SQL Server®/Firebird database is located.

3. Indexes are used only for searches. Users are always able to view the new archived emails through
the browse feature notwithstanding the fact whether emails are indexed or not.

Configuring Indexing Frequency

1. Select Configuration tab and from Overview of current settings, click Archive Stores.

2. Select Index Management.
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Screenshot 69: Search Index Management

3. From Indexing Schedule select any of the following options:

OPTION DESCRIPTION

Index new
archived emails
every

Search index are updated with the latest archived emails at a fixed interval, For example every half
an hour, every hour, every two hours.
This index schedule is recommended since it strikes the right balance between update frequency
and performance hit.

NOTE
Choosing Immediately causes new email content to be indexed as soon as it is stored in an
archive store. This guarantees the most up-to-date search index; users will be able to search
for and find the latest archived emails.

NOTE
Choosing this option can degrade performance due to the updating frequency - depending on
the amount of emails archived.

Index new
archived emails
every day at

Email content is updated on a daily basis at a preset time.
This option enables you to schedule indexing during off peak hours. Search for emails that archived
during the last 24 hours will not be possible due to emails that are not yet indexed.

Table 62: Indexing Schedule options

4. Click Save.
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Rebuilding a Search Index

Rebuilding a search index enables you to rebuild indexes that you think are no longer returning the
correct search results or became somehow corrupted.

Important Notes

Rebuilding a search index might take several hours, depending on the amount of emails stored in
the respective archive store.

During an index rebuild, users will not be able to find emails in that archive store through the
search feature.

Rebuilding a search index impacts performance on the server, since this is a processor and hard
disk intensive operation. It is recommended that this procedure is undertaken during off peak
hours, for example after office hours.

Always rebuild one index at a time for the reasons listed above.

Rebuilding a Search Index

1. Select Configuration tab and from Overview of current settings, click Archive Stores.

2. Select the Archive Store for which to rebuild the index and click Rebuild Index.

Pausing and Resuming Indexing

Indexing can be paused and restarted through the and . This
enables you to pause lengthy indexing operations during peak hours and continue at a time of low
activity, for example, after office hours.

NOTE

Pausing an index during a merge stops users from finding emails in that archive store
through the search feature. Pausing a rebuild does enable users to use the archive
store.

Search Index States

The different states of a GFI MailArchiver search indexes:

STATE DESCRIPTION

Initializing - this is the status when the search index is being created. An index is not expected to stay in this
state for more than 10 minutes.

Invalid - this indicates that the search index is most likely to be corrupt.

Merging - GFI MailArchiver maintains sub-indexes which are smaller versions of the main index. These are
used to increase the performance of the search index. Sub-indexes for an archive store are merged to the
main search index when a number of sub-indexes are created or automatically at 2:00am.

Paused - the process is manually paused from the GFI MailArchiver Configuration. The index will remain in
this state until the Resume Index button is clicked.

Online - the search index is online.

Pending - this state shows that the search index will start rebuilding shortly.

Table 63: Search index states
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STATE DESCRIPTION

Rebuilding - this indicates that the indexer is indexing a database. The duration of rebuilding an index
depends on the size of the database being indexed.

Configuring the Language Analyzer

Word Breaking is the breaking down of text into individual text tokens or words. Many languages,
especially those with Roman alphabets, have an array of word separators (such as white space) and
punctuation used to distinguish words, phrases, and sentences. Word breakers must rely on accurate
language heuristics to provide reliable and accurate results.

Word breaking is more complex for character-based systems of writing or script-based alphabets,
where the meaning of individual characters is determined from context.

A "Word Breaker" is vital for the proper indexing of the most of the Asian languages (For example
Japanese, Chinese, and Arabic) and other languages

The GFI MailArchiver language analyzer is enabled by default. It is highly recommended that for
optimal indexing performance this is not disabled.

Setting Up the Language Analyzer

1. Select Configuration tab and from Overview of current settings, click Archive Stores.

2. Select Index Management.

3. Select/Unselect Enable Auto Language Analyzer to enable/disable Language Analyzer.

4. Select a default language from the Default Language drop down list.

NOTE

If the required language is not listed in the Default Language drop down list, add the
required language from the Regional settings option within the Windows® control panel.

7.8.8 Scheduling Archive Stores

The Archive Store Schedule enables you to set the frequency with which GFI MailArchiver
automatically starts archiving emails to a new Archive Store.

IMPORTANT

Changing these settings can affect performance. We recommend configuring your
Archive Stores to roll-over on a Bi-Monthly schedule. This way, databases should stay at
a more manageable size, which is beneficial if there is a need to move the database or
rebuilding its search index. A Bi-Monthly archive store should also have some
performance gains when searching. For example, to search for an email dated February
2012, GFI MailArchiver searches a small Bi-Monthly database instead of a large yearly
database, hence providing faster retrieval.

GFI MailArchiver changes the Archive Store based on a specifically configured time schedule. This
feature is available for all types of databases used with Archive Stores. The available options are:

Monthly

Bi-Monthly (default)
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Quarterly

Half yearly

Yearly

NOTE

If an Archive Store exceeds the maximum database size, GFI MailArchiver automatically
creates a new Archive Store based on the configured New Archive Store Settings. This
feature is only available for Archive Stores based on SQL Server® Express databases.

To change the Archive Store Schedule:

1. From Configuration tab, click Archive Stores.

2. Select Schedule Archive.

3. Select one of the available options and click Save.

7.8.9 Backup Archive Stores

It is highly recommended to include the GFI MailArchiver Archive Stores in routine server backup
procedures.

7.8.10 Online Backup

Online backup is done using a backup application which backups Archive Stores without the need to
stop the GFI MailArchiver services. For more information refer to

http://go.gfi.com/?pageid=MAR_BackupArchiveStores.

7.8.11 Offline Backup

Offline backup can be done in environments where online backup is not possible. The GFI MailArchiver
services must be temporarily stopped while backing up Archive Stores.

The following is a list of offline backups:

Backup an Archive Store Based on Microsoft SQL Server

Backup an Archive Store Based on Microsoft SQL Server and File System

Backup an Archive Store Based on GFI MailArchiver (Firebird) Database and File System

Backup an Archive Store Based on SQL Server®

In this type of Archive Store, the following information is stored:

Archived email metadata - Stored in the SQL Server® database.

Compressed email binary source - Stored in the SQL Server® database.

Search index entries - Stored on disk.

To backup an Archive Store:

1. From GFI MailArchiver, go to Configuration > Archive Stores and click

2. Take note of the following information for quick reference:

Server

Database

http://go.gfi.com/?pageid=MAR_BackupArchiveStores
http://go.gfi.com/?pageid=MAR_BackupArchiveStores
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Path to search index

3. Launch the Services management console from Start > Run and type ‘services.msc’.

4. Stop all GFI MailArchiver services.

5. Using the search index path determined in step 2, backup the Archive Stores’ search indexes,
either by manually copying and pasting the search index folder or using a backup utility.

Screenshot 70: Backup an SQL database

6. From the SQL Server®, launch the Microsoft® SQL Server Manager and backup the archive database
noted in step 2. To backup a database, right-click on the database and select Tasks > Back up….

NOTE

A maintenance plan can be created in SQL Server® to schedule periodic backups of the
archive database.

7. Return to the GFI MailArchiver server and from the Services management console, restart all GFI
MailArchiver services.
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Backup Archive Store Based on Microsoft® SQL Server and File System

In this type of Archive Store, the following information is stored:

Archived email metadata - Stored on the Microsoft® SQL Server database.

Compressed email binary source - Stored on disk.

Search index entries - Stored on disk.

To backup an Archive Store:

1. From GFI MailArchiver, go to Configuration > Archive Stores and click

2. Take note of the following information for quick reference:

Server

Database

Path to email binary source

Path to search index

NOTE

Move pointer over the path to view the full path.

3. Launch the Services management console from Start > Run and type ‘services.msc’.

4. Stop all GFI MailArchiver services.

5. Using the paths determined in step 2, backup the Archive Stores’ email binary source and search
index, either by manually copying and pasting the folders or using a backup utility.
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Screenshot 71: Backup an SQL database

6. From the Microsoft® SQL Server, launch the Microsoft® SQL Server Manager and backup the archive
database noted in step 2. To backup a database, right-click on the database and select Tasks > Back
up….

NOTE

A maintenance plan can be created in Microsoft® SQL Server to schedule periodic
backups of the archive database.

7. Return to the GFI MailArchiver server and from the Services management console, restart all GFI
MailArchiver services.

Backup Archive Store Based GFI MailArchiver (Firebird) Database And File System

In this type of Archive Store, the following information is stored:

Archived email metadata - Stored on disk.

Compressed email binary source - Stored on disk.
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Search index entries - Stored on disk.

To backup an Archive Store:

1. From GFI MailArchiver, navigate to Configuration > Archive Stores and click .

2. Store the following paths for quick reference:

Path to Firebird database

Path to email binary source

Path to search index

NOTE

Move pointer over the path to view the full path.

3. Launch the Services management console from Start > Run and type ‘services.msc’.

4. Stop all GFI MailArchiver services.

5. Using the paths determined in step 2, backup the Archive Stores’ database file, binary files and
search indexes, either by manually copying and pasting the files in a backup location or using a backup
utility.

6. From the Services management console, restart all GFI MailArchiver services.

Restoring an Archive Store Which is Added in GFI MailArchiver

1. From GFI MailArchiver, navigate to Configuration > Archive Stores and click

2. From the Archive Store Statistics dialog, note the following properties for quick reference:

TYPE OF ARCHIVE
STORE

ARCHIVE STORE PROPERTIES

Microsoft® SQL Server Server

Database

Path to search index

Microsoft® SQL Server
and file system

Server

Database

Path to email binary source

Path to search index

Firebird Database Path to Firebird database

Path to email binary source

Path to search index

Table 64: Archive Store properties

3. Launch the Services management console from Start > Run and type ‘services.msc’.

4. Stop all GFI MailArchiver services.

5. Refer to the location of files noted in step 2 to override the Archive Store files with the restored
backup files as follows:
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Firebird database - replace the Firebird database on disk with the backed up Firebird database

SQL database - from the Microsoft® SQL Manager right-click the backed up database and select
Tasks > Restore.

Email binary source - replace the binary folder on disk with the backed up binary folder

Search index folder - replace the Search index folder on disk with the backed up Search index
folder.

6. From the Services management console, restart all GFI MailArchiver services.

Restoring an Archive Store Which is not Added in GFI MailArchiver

1. Depending on the type of Archive Store to restore, restore the applicable backed up data as
follows:

Firebird database - restore the Firebird database on disk

SQL database - from the Microsoft SQL Manager right-click the backed up database and select
Tasks > Restore.

Email binary source - restore the binary folder on disk

Search index folder - restore the search index folder on disk

Take note of the paths where all data has been restored.

2. Add the restored Archive Store in GFI MailArchiver ensuring that all paths configured during the
wizard, for example search index path or SQL database, are the paths of the restored data.

7.8.12 Moving Emails From One Database to Another

GFI MailArchiver supports various types of Archive Stores. The software enables you to move emails
from one database to another or to many other databases.

NOTE

This feature is only applicable when moving the original emails source stored on disk of
a Firebird database or SQL Server® file system. Emails cannot be moved from a SQL
Server® database when the source is stored on the SQL Server® database.

Examples:

A Firebird database becomes very large in size and hence slow to load data, so the administrator
decides to switch to a SQL Server® database.

An SQL file system stored on disc, stores emails of one whole year. It is recommended to separate
the emails to multiple databases, for example one database for each month.

Important Notes

1. It is highly recommended to backup the archive stores before moving emails. This process is
described in the Backup Archive Stores chapter of this manual.

2. Moving emails between archive stores requires a high amount of computer processing resources
and can reduce the performance of the GFI MailArchiver server substantially.



GFI MailArchiver 7 Configuring GFIMailArchiver | 124

3. The folder structure of emails is lost when moving emails, however the emails can be
resynchronized to retrieve the folder structure. The folder structure of emails deleted from the
mailbox is permanently lost.

4. Ensure that the new database where emails are going to be moved to, is added in the GFI
MailArchiver Archive Stores. This process is described in the Managing Archive Stores chapter of this
manual.

5. Multiple databases can be created to cover different emails date ranges.

7.8.13 Upgrading the database schema

All the schema of GFI MailArchiver databases can be upgraded to the latest schema using the Bulk
Schema Upgrader.

To upgrade the GFI MailArchiver databases schema or verify that you are using the latest database
schema:

1. From the GFI MailArchiver machine, navigate to <GFI MailArchiver installation
path>\BulkSchemaUpgrader and launch BulkSchemaUpgrader.exe.

Screenshot 72: The Bulk Schema Upgrader

2. Select the databases to upgrade and click Upgrade.

IMPORTANT

GFI MailArchiver does not work if the database schema is not upgraded. For more
information, refer to Upgrading the database schema (page 124).

NOTE

When upgrading the database schema of an SQL database, when prompted enter the
credentials of the System Administrator, SA user, or the database owner, ‘dbo role’.
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7.8.14 Attaching a GFI MailArchiver 3 Database

IMPORTANT

You can only attach GFI MailArchiver 3 databases based on SQL Server®. Microsoft®

Access Databases are not supported.

IMPORTANT

Attached GFI MailArchiver 3 databases are read-only and can only be used for browsing
and searching.

1. Select Configuration tab and from Overview of current settings, click Archive Stores option. Click

.

2. Key in an Archive Store name, select whether to allow users to use the new Archive Store and the
method used to create it. Select Wizard option and click Next.

3. Select Microsoft SQL Server option and click Next.

Screenshot 73: Attach a GFI MailArchiver 3 database
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4. Select Attach a GFI MailArchiver version 3 database and select the database to attach.

5. Click Next to continue.

7.9 Email Access Control

By default, Active Directory® Users can browse and search only through their emails. Email Access
Control enables you to configure users to belong in a group with access to other users’ emails. The
pre-configured groups are listed in the table below.

OPTION DESCRIPTION

Full
access
group

Enables users in Active Directory® groups to browse and search through all the emails stored in all the
archive stores.

NOTE
Since emails may contain confidential information it is highly recommended to select members of this
groups with extreme care.

Group
managers

Enables users that have a management or supervisory role in your organization to browse and search
through the emails of all the users forming part of that Active Directory® group.

User
access
control

Enables specific users to browse and search the emails of other users.
This feature enables, for example, to grant a user access to emails of another user which no longer forms
part of your company, and which Active Directory® account was deleted.

Shared
mailboxes

Enables a group to access archived emails in a specific mailbox. For example, enable all sales persons to
have access to sales@mycompany.com.

Table 65: Email Access Control groups

7.9.1 Adding Groups to the Full Access Group

Adding a group of users to the Full Access Group grants the users within that group access to all
emails archived within GFI MailArchiver.

1. Select Configuration tab and from Overview of current settings, click Access Control label.

2. Click Configure Full Access Group.

3. Select the group to set as the Full Access group and click Save.

7.9.2 Adding Users to the Group Managers Group

Adding a user to the Group Managers Group grants users access to all emails archived within GFI
MailArchiver for a particular group of Active Directory® user.

1. Select Configuration tab and from Overview of current settings, click Access Control label.

2. Click Configure Group Managers.

3. Select the user to add as a manager from the Manager field and the group to which full access will
be granted and click Add. Repeat to add other users to other groups.

NOTE

A user can be added to multiple groups by selecting the same user and a different group.

4. Click Save to finalize settings.

7.9.3 Define User Access Control

User Access Control enables you to grant specific users access to email archived for other users.

1. Select Configuration tab and from Overview of current settings, click Access Control label.
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Screenshot 74: Configuring access control

2. Click Configure User Access Control.

3. Select the user to grant access to in the User field and the user to which mailbox access will be
granted from the Has access to User field. Click Add and repeat to add other users to other groups.

NOTE

A user can be added to users by selecting the same user and a different user to grant
access to archived emails.

4. Click Save to finalize settings.

7.9.4 Configuring Shared Mailboxes

Shared mailboxes are mailboxes that can be accessed by a whole set of users in a group.

1. Select Configuration tab and from Overview of current settings, click Access Control label.

2. Click Configure Shared Mailboxes.

3. Select the group to grant access to from the Group field and the mailbox to which access will be
granted from the Mailbox Account field. Click Add and repeat to add other groups to different
mailboxes.
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NOTE

The same group can be added to different mailboxes by selecting the same user and a
different mailbox to grant access to archived emails.

4. Click Save to finalize settings.

7.10 Configuring IMAP Server

Internet Message Access Protocol (IMAP) is an Internet protocol for e-mail retrieval. A number of e-
mail clients and mail servers use IMAP to transfer e-mail messages from a server to a client.

The IMAP service is used to retrieve email identifiers and users' email folder structures from GFI
MailArchiver Archive Stores. This data is stored within a Firebird database on the IMAP Server
machine.

NOTE

The IMAP Server back-end Firebird database is stored in Data\IMAPDB.FDB and
contains the folder structure of each user's mailbox. This database does NOT contain
any message data (subject, headers, body content etc). Such information is retrieved
directly from the GFI MailArchiver Store service when requested. This database is
created by the IMAP service on startup (if not found) and the synchronization will start
as soon as items are available from the archive stores. IMAP server will not return any
items for the users until the data is synchronized.

When a client makes a request, the IMAP Server looks in the local database for the email identifiers
and performs the following actions:

Folder names - sends the data directly

Message details - contacts the store service before returning the data.

Clients connect to the IMAP service using valid authentication.

NOTE

When GFI MailArchiver is installed (not upgraded) and IMAP is enabled for the first time,
it takes a long time for IMAP server to sync up with the store. The synchronization is a
background process transparent to the user.

To configure the IMAP Server:

1. From the Configuration page, select IMAP Server.

2. Click Configure IMAP Server.
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Screenshot 75: IMAP Server configuration

3. Select Enable IMAP Server checkbox.

IMPORTANT

The IMAP service is started automatically when the Enable IMAP server checkbox is
selected. If IMAP is disabled, service does not automatically start on startup.

4. (Optional) In the Port Number field, enter a value and click Check Availability.

NOTE

The default port number is 44143. Changing the port number effects clients that have
been configured to use this port.

5. In the Network Interface field, select the listening network card from the available options. GFI
MailArchiver scans your system and lists discovered network interface cards as possible options. It is
however recommended to retain default setting (All Network Interfaces).

6. In the Server URL field, key in the address of the IMAP server to be used by mail clients.
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NOTE

The IMAP Service is restarted whenever there are changes in IMAP server configuration
related to network card interface or listening port number. All clients are disconnected
when the IMAP service is restarted.

7. Use the Maximum months to show in mail clients field to set the period of time (in months) GFI
MailArchiver goes back and retrieve emails (default set to 24 months).

8. (Optional) Select Enable SSL Security checkbox to enable secure transmission of information. For
more information, refer to Working With Certificates (page 130).

NOTE

If Force SSL certificate is selected, email clients will authenticate using a valid
certificate. Authentication is refused if the client tries to connect unencrypted.

9. Click Save to finish the configuration.

7.10.1 Working With Certificates

Secure Sockets Layer (SSL) is a protocol designed to enable applications to transmit information back
and forth securely. Applications that use SSL, exchange encryption keys with other applications, and
are designed to encrypt and decrypt data sent between the two.

Applications that are configured to run SSL (for example, web browsers like Microsoft® Internet
Explorer and Firefox and email programs like Microsoft Outlook®, Mozilla Thunderbird and Apple Mail)
are automatically able to receive SSL connections. To establish a secure SSL connection, the
application must first have an encryption key assigned to it by a Certification Authority in the form of
a Certificate.

IMAP supports encryption via certificates. Certificates can be:

Purchased from an online vendor such as Verisign

Generated from IIS® (refer to KB article http://support.microsoft.com/kb/299875#appliesto)

To enable SSL and configure a security certificate:

1. In the IMAP Server configuration wizard, select Enable SSL checkbox.

2. In the SSL Certificate field, select the certificate to upload.

3. In the SSL Certificate Password field, type the certificate password. This will be validated when
you click save.

4. (Optional) Select Force SSL certificate checkbox to force encryption of transmitted data.

IMPORTANT

When Force SSL certificate is enabled, encryption is ‘forced’, meaning that clients using
the IMAP service will not be able to connect unless they configure encryption from their
side. If Force SSL certificate is not enabled, the clients can connect to the IMAP server
both in encrypted and unencrypted mode.

http://support.microsoft.com/kb/299875#appliesto
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5. Click Save.

7.11 Retention Policies

Retention Policies define the length of time that an archived email is retained in the Archive Store
before it is deleted. For example, you can configure GFI MailArchiver to retain emails marked ‘Sales’
for two years while keeping emails marked as ‘Legal’ indefinitely.

GFI MailArchiver also provides you with the facility to temporarily suspend (hold) retention policies so
that no email is deleted. For example, you can hold retention policies until a court case is resolved. In
this case, emails are marked for deletion and deleted once the hold is switched off.

7.11.1 How Are Retention Policies Applied?

GFI MailArchiver checks email content against any retention policies configured at the time of
archiving.

GFI MailArchiver first checks email against the highest priority retention policy. If the email matches
the configured conditions, retention policy is associated with the email. If the email does not match
the highest priority retention policy, GFI MailArchiver will check against the next retention policy
configured, according to priority.

This process is repeated until email either matches a configured retention policy or there are no
more retention policies. When an email does not match any retention policy, GFI MailArchiver stores
the email in archive store indefinitely.

Important Notes

1. Retention policies created or modified after GFI MailArchiver has already stored an email in an
archive store will not affect that email. This is because GFI MailArchiver checks emails against
retention policies only at the time of archiving.

2. An email can match only one retention policy. Thus, the priorities you assign to the retention
policies are very important.

3. Any email that matches a retention policy where the configured action is ‘delete email
immediately’ is discarded immediately without ever being stored in an archive store.

4. Any email that matches a retention policy where the configured action is set to delete after a
number of days, is stored in an archive store. On the pre-configured time elapsing, GFI MailArchiver
purges the email from the archive store.

5. By default no retention policies exist within GFI MailArchiver upon installation
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7.11.2 Viewing Retention Policies

Screenshot 76: Viewing retention and spam policies

To view retention policies, select Configuration tab and from Overview of current settings, click
Retention and Spam Policies label. The retention policies are displayed in retention policy table,
sorted by the order in which these will be executed. Available fields are listed in the table below.

OPTION DESCRIPTION

Policy name Displays the name of the retention policy.

Active Displays whether retention policy is active, inactive or disabled due to legal hold.

Action Displays the action configured for this retention policy. For example: Retain emails for 2 years.

Table 66: Retention policy table fields

7.11.3 Adding a New Retention Policy

1. Select Configuration tab and from Overview of current settings, click Retention and Spam
Policies label.

2. Click .
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Screenshot 77: Select SPAM or email retention policy

3. From the Retention Policy wizard, select Email Retention Policy and click Next.
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Screenshot 78: Retention Policy details

4. In the Retention Policy Details screen, key in the details for the new retention policy and click
Next. Available options are:

OPTION DESCRIPTION

Policy name Defines the name for the new policy to be created.

Table 67: New retention policy options
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OPTION DESCRIPTION

Email Criteria Defines the conditions that will identify an email as being part of this retention policy. From the
drop down list select one of the following options and provide the values that an email must

match to fall under this retention policy. Click to add more conditions or to delete a keyed in
condition. Select:

Subject – define an email subject

Body – define key words that can be found in the body of emails

Sender – define the sender’s email address or specify the User name in the format
domain\username

Recipient – key in the recipient’s email address or specify the User name in the format
domain\username

Email size – select a parameter and provide the email size in MB. Available parameters are:

Equals to

Greater Than

Greater Or Equal Than

Smaller Than or

Smaller Or Equal Than

Attachment size - select a parameter and provide the email size in MB. Available param-
eters are:

Equals to

Greater Than

Greater Or Equal Than

Smaller Than or

Smaller Or Equal Than

Attachment Type - define the file type condition by selecting a category from the drop
down list of predefined values. For more information on File Types refer to Retention File
Types in this section.

Enable Policy Defines whether a policy is in effect or not and if emails are to be deleted immediately or
retained for a specific amount of time. Select Enable Policy and select an option between:

Do NOT retain emails matching above conditions, delete immediately.

Do NOT retain emails matching the above conditions, delete after x days

NOTE
To configure a number of years, specify the number of days. For example: To retain emails for
2 years, key in 730 days and to retain emails for 5 years, key in 1825 days.

5. Click Finish.

Retention File Types

The following table lists the file types associated with each Attachment Type category available when
filtering a Retention Policy by attachment type:

CATEGORY FILE TYPE

Images *.jpg,*.jpeg, *.exif, *.tiff, *.raw, *.png, *.gif, *.bmp, *.ppm, *.pgm, *.pbm, *.pnm, *.webp, *.tga, *.pcx,
*.img, *.psd, *.psp, *.cgm, *.svg, *.ai, *.cdr, *.eps, *.hvif, *.odg, *.pict, *.pgml, *.swf, *.vml, *.wmf, *.emf,
*.xps, *.pns, *.jps

Table 68: Pre-defined retention file types
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CATEGORY FILE TYPE

Documents *.acl, *.csv, *.cwk, *.doc*, *.dot*, *.htm*, *.hwp*, *.lwp, *.mcw, *.odm, *.odt, *.ott, *.pages, *.pdax, *.pdf,
*.rtf, *.rpt, *.stw, *.sxw, *.tex, *.txt, *.wpd, *.wps, *.wpt, *.wrd, *.wri, *.xhtml, *.xml, *.xps, *.xls, *.xlsx,
*.ppt, *.pptx, *.mdb, *.accdb, *.accde

Music *.aiff, *.au, *.cdda, *.raw, *.wav, *.flac, *.la, *.m4a, *.ape, *.wma, *.mp2, *.mp3, *.ogg, *.ra, *.rm, *.ots,
*.swa, *.vox, *.voc, *.mid, *.psf, *.mod, *.asf, *.asx, *.m3u, *.ram, *.xspf, *.omf, *.cel

Video *.aaf, *.3gp, *.gif, *.asf, *.avchd, *.avi, *.dat, *.flv, *.mpeg, *.mpg, *.fla, *.flr, *.sol, *.m4v, *.mkv, *.mov,
*.mpe, *.mxf, *.ogg, *.rm, *.swf, *.wmv

7.11.4 Changing the Order of Retention Policies

The order in which retention policies are applied is very important within GFI MailArchiver. GFI
MailArchiver first checks email against the highest priority retention policy. If the email matches the
configured conditions, retention policy is associated with the email. If the email does not match the
highest priority retention policy, GFI MailArchiver checks against the next retention policy configured,
according to priority.

To change the order of the retention policies:

1. Select Configuration tab and from Overview of current settings, click Retention and Spam
Policies label.

2. Select the retention policy to change the order for and click or to move up
or down respectively.

7.11.5 Adding a SPAM Retention Policy

By default, emails marked as spam are archived with all other emails and GFI MailArchiver does not
discriminate between valid emails and emails marked as SPAM by anti-spam solutions such as GFI
MailEssentials. Within GFI MailArchiver, you can set up a SPAM Retention Policy that enables you to
delete spam immediately on archival or after a specific number of days.

Creating a SPAM Retention Policy also enables users to browse emails marked as spam and if these
are not actually spam, mark them as not spam. This causes the SPAM Retention Policy not to delete
such emails.

1. Select Configuration tab and from Overview of current settings, click Retention Policies label.

2. Click .

3. From the Retention Policy wizard, select Specify a SPAM policy and click Next.
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Screenshot 79: SPAM Retention Policy dialog

4. Fill in a name for the SPAM Retention Policy, configure whether the policy is active or not, and
select the retention period. The table below shows a list of available options.

OPTION DESCRIPTION

Policy Name Defines the name for the policy being created/edited. Key in or edit the
name in this text box.

Enable policy Defines whether the policy being created/edited is active or disabled.
Check or uncheck the checkbox to enable or disable the policy.

Do NOT retain emails marked as SPAM,
delete immediately

Instructs GFI MailArchiver to immediately delete all emails marked as
SPAM.

Do NOT retain emails matching the
above conditions, delete after x days

Instructs GFI MailArchiver to retain all emails marked as SPAM and delete
them only after the configured time elapses.

Table 69: SPAM Retention Policy options

5. Click Next and Finish to complete retention policy configuration.

7.11.6 Configuring Legal Hold

Legal Hold instructs GFI MailArchiver to pause deleting archived emails and to retain them until
further notice. Enable this feature to temporarily halt archived email deletion until, for example, a
court case is resolved.
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Enabling this feature still causes GFI MailArchiver to mark the archived emails for deletion. Delete
instruction will be executed only once the legal hold is removed.

To enable Legal Hold:

1. Select Configuration tab and from Overview of current settings, click Retention and SPAM
Policies label.

2. Select .

To disable Legal Hold:

1. Select Configuration tab and from Overview of current settings, click Retention and SPAM
Policies label.

2. Select .

IMPORTANT

Use this feature with caution, since emails are immediately deleted on disabling Legal
Hold.

7.12 Classification Rules

Classification Rules enable you to automatically classify emails according to the content. Archived
emails are automatically reviewed according to the classification rules set up and marked according
to which rule is met.

This section will help you:

Add a New Classification Rule

Edit a Classification Rule

Remove a Classification Rule

7.12.1 Adding a New Classification Rule

1. Select Configuration tab and from Overview of current settings, click Classification Rules label.

2. Click .
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Screenshot 80: Categorization rule details

3. Key in a rule name in the Policy Name field and configure the criteria that emails have to fulfill to
fall under this classification rule. Available options are:

OPTION DESCRIPTION

Subject Key in the subject text that the email must match to fall under this categorization rule.

Body Key in the body text that the email must match to fall under this categorization rule.

Sender Select whether to classify by email address or user name. Provide the email address or select a
user name that the email must match to fall under this categorization rule.

NOTE
‘@’ sign must always be present in sender email address specified. Wildcard characters are
also supported as follows:

? - matches any letters

For example: ???n@?aster-domain.com will match both john@master-domain.com and
joan@faster-domain.com.

- matches complete words

For example: *@master-domain.com matches all email addresses with the domain part
master-domain.com

Recipient Key in the recipient email address that the email must match to fall under this categorization
rule.

Table 70: Classification Policy options
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4. Click to add further classification criteria or to delete previously keyed in criteria.

5. Select Enable policy and key in the label with which emails should be labeled in the Emails that
match this categorization policy should be labeled field. Click Next to continue.

6. In the Summary page review the categorization rule details and click Finish.

7.12.2 Editing a Classification Rule

1. Select the classification rule to edit and click Edit.

2. Follow the instructions listed in the Adding a New Classification section for information on how to
edit a classification rule.

7.12.3 Removing a Classification Rule

Select the classification rule to remove and click . Classification rule will automatically be
removed.

7.13 Auditing

GFI MailArchiver database activity auditing uses the tracing capabilities of SQL Server® to record all
activity affecting the archive databases.

Trace data is stored in a text file in a user specified location on the SQL Server® machine. There is
one trace file per server, containing trace data from all archive stores hosted on the server. The SQL
Server® service holds an exclusive lock on the trace file, ensuring the file is not tampered with. From
GFI MailArchiver, you can then trigger the process to upload trace files into the auditing database.
Following the upload, you can view auditing reports through the Auditing Reports page in the
console.

IMPORTANT

GFI MailArchiver only audits archive stores based on SQL Server®.

Auditing is not performed on Archive Stores based on:

SQL Server® database and file system

GFI MailArchiver (Firebird) database and file system.

In this chapter:

7.13.1 Configuring Database Activity Auditing 140

7.13.2 Editing Database Activity Auditing 142

7.13.3 Audit Reports 143

7.13.1 Configuring Database Activity Auditing

1. Select Configuration tab and from Overview of current settings, click Auditing label.

2. Click Configure.



GFI MailArchiver 7 Configuring GFIMailArchiver | 141

Screenshot 81: Select authentication method

3. Select the SQL Server® to use from the Microsoft SQL Server drop-down box and choose the
Authentication method to use to connect to the selected SQL Server®.

OPTION DESCRIPTION

Windows Authen-
tication

Uses the currently logged on user to connect to SQL Server®.

Microsoft SQL
Server Authen-
tication

Uses the credentials you key in the Login Name and Password: fields to connect to SQL Server®.
These will be used by GFI MailArchiver to read/write from the auditing database.

Table 71: SQL Server® Authentication methods

Click Next to continue setup.

IMPORTANT

The account specified must have sysadmin or database owner privileges.

4. To create a new database within the previously selected SQL Server®, select New Auditing
Database and provide a name in the text box. To use an existing database, choose Select an Existing:
auditing database from the displayed list of databases. Click Next to continue.

Click Next to continue setup.
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5. Specify whether to enable tracing on GFI MailArchiver archive stores. Select Enable trace on
Archive Stores to log database activity data and specify the path on the SQL Server® machine where
the trace files will be stored. Click Next to continue.

NOTE

Ensure that the location specified is accessible using the user account under which the
SQL Server® service is running

NOTE

Lock down the location where you store the SQL Server® trace files through NTFS
permissions, so that only the SQL Server® Service can access the location. This, together
with the exclusive lock held by the SQL Server® service, ensures that the data in the
trace files cannot be tampered with.

Screenshot 82: Enable user interaction auditing

6. Specify whether to enable user interaction auditing. This will record all the activity of the GFI
MailArchiver user interface by users. To enable, select Enable user interaction auditing. Click Next
to continue.

7. Review the Auditing Database setup summary and click Finish to finalize setup.

7.13.2 Editing Database Activity Auditing

To edit an existing database activity auditing setup, select the previously configured settings and click
Configure. Follow the instructions listed in the Configuring Database Activity Auditing section to edit
an existing database activity auditing setup.
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7.13.3 Audit Reports

Auditing reports are based on data generated by database activity auditing and user interaction
auditing. You can view the auditing reports from GFI MailArchiver.

Database activity auditing reports:

Configuration Management

Access Control

Data Handling

Archived Emails

Bulk Import

Retention Policy

Data Leakage Prevention

User Audit Trail

User interaction auditing report:

Data Integrity

Accessing Reports

1. Select Auditing tab and select the desired report.

2. Perform the following actions:

Filter reports: Use the Filter by: area by selecting a value to filter by and providing the details
that a record has to match to be displayed on screen. The Filter by: area is located at the top of
each report page.

Print reports: click on the print report button , located at the top of each report page.

Configuration Management Auditing Report

Use this report to list all the configuration changes made in GFI MailArchiver. Information displayed
includes:

User who made the changes

Changes effected

NOTE

Clicking on any configuration change in the list will bring up a window with further
detailed information.

Access Control Auditing Report

Use this report to list all the changes made to the access control configuration of GFI MailArchiver.
Information displayed includes:

User who made the changes

The user affected by the change
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What permissions were changed

Archived Emails Auditing Report

Use this report to list the number of emails archived in GFI MailArchiver Archive Stores per day.
Information displayed includes:

Date

Name of archive store

Number of archived emails

Bulk Import Auditing Report

Use this report to list the amount of emails imported into the archive stores through the bulk import
service, for each import. Information displayed includes:

Date of import

Name of archive store

Number of emails imported

Retention Policy Auditing Report

Use this report to list the retention policies executed and the amount of emails deleted. Information
displayed includes:

Date on which the policy was executed

Name of archive store

Name of retention policy

Number of emails deleted

Clicking on any executed retention policy in the list will bring up a window with detailed information
on the policy executed.

Data Leakage Prevention Auditing Report

Use this report to list which users performed actions that could lead to data leakage, such as
forwarding of emails from the archive stores. Information displayed includes:

User that performed the action

Action performed

Number of emails affected.

User Audit Trail Auditing Report

Use this report to list the actions taken by users whilst using the GFI MailArchiver web interface.
Information displayed includes:

User name

Action taken

Date/time action was taken

The following report options are available:
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To group the list by user, click on the Group by user button, located at the top of the report
page.

To group the list by date, click on the Group by date button, located at the top of the report
page.

Clicking on any user action in the list will bring up a window with detailed information on the
action taken.

Data Integrity Auditing Report

Use this report to list all the changes made to the GFI MailArchiver archive stores and auditing
databases, which were not carried out through the GFI MailArchiver services. Information displayed
includes:

Event type

Microsoft® SQL server and database affected

Database user affected

Action taken

Machine from which action originated.

The following report options are available:

To group the list by event type, click on the Group by event type button, located at the top of the
report page.

To group the list by date, click on the Group by date button, located at the top of the report
page.

Clicking on any database change in the list will bring up a window with detailed information on
that change.

7.14 Configuring Email Deletion

The Email Deletion feature enables users to permanently delete emails from the GFI MailArchiver Mail
View. If enabled, an additional delete button is displayed in the Archive tab toolbar and in the Mail
View toolbar.

IMPORTANT

Enabling this feature may breach company policy or legal compliance related to email
retention.

IMPORTANT

Enabling this feature allows all GFI MailArchiver users to permanently delete archived
emails from mailboxes they have access to.

1. From Configuration tab, select Email Deletion.
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Screenshot 83: Configuring Email deletion

2. Click Enable Email Deletion.

3. Check the I agree checkbox.

4. Click OK.

NOTE

User cannot delete emails from a read-only Archive Store. Users are notified if delete
fails.

IMPORTANT

If Legal Hold is enabled, Email Deletion is disabled until Legal Hold is removed. For
more information, refer to Configuring Legal Hold (page 137).

7.15 Viewing and Editing License Keys

A fully licensed version of GFI MailArchiver requires a license key. For information on GFI MailArchiver
licensing, refer to:

http://go.gfi.com/?pageid=MAR_Licensing

To review the license key that is currently used within GFI MailArchiver select Configuration tab and
click Change license key label.

To change your current license key:

1. Click Edit Licensing Key.

2. Key in or paste the new license key in the License Key text box. Click Verify License Key to verify
that the new license key is correct.

3. Click Save to finalize settings.

http://go.gfi.com/?pageid=MAR_Licensing
http://go.gfi.com/?pageid=MAR_Licensing


GFI MailArchiver 7 Configuring GFIMailArchiver | 147

NOTE

After installing GFI MailArchiver, the Post-installation Wizard redirects you
automatically to this page.

7.16 General Settings

The General Settings option enables you to define your administrator email address and the email
server details for notifications. It also enables you to enable, disable and configure the GFI
MailArchiver version checks. This enables GFI MailArchiver to check for and advise you of any new
versions of GFI MailArchiver.

In this chapter:

7.16.1 Changing General Settings 147

7.16.2 Changing Version Check Settings 148

7.16.1 Changing General Settings

1. Select Configuration tab and click General Settings.

2. Click Change Settings.
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Screenshot 84: General Settings

3. Perform all the required modifications from the list of available options.

OPTION DESCRIPTION

Administrator email
address

Defines the administrator email address where important notifications are sent.

SMTP Server Defines the SMTP server used by GFI MailArchiver to send notifications and to restore emails
from Archive Store.

Port Number Defines the port number over which GFI MailArchiver will communicate to the SMTP server.
Default value: 25

Use SSL Instructs GFI MailArchiver to connect and communicate with the SMTP Server using SSL.

The SMTP requires
authentication

Instructs GFI MailArchiver to connect to the SMTP server using a username and a password.
The username and password fields are automatically displayed if this option is chosen.

Table 72: General Settings Options

4. Click Save to save new setup.

5. Click Send a test email to confirm that details are correct.

7.16.2 Changing Version Check Settings

1. Select Configuration tab and click General Settings.

2. Click Change Check Version Settings.
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Screenshot 85: Version check configuration

3. Perform all the required modifications from the list of available options.

OPTION DESCRIPTION

Enable Version
Check

Enables/Disables the GFI MailArchiver Version Check. Uncheck option to disable GFI
MailArchiver automated checks for newer versions.

Enable Proxy server Instructs GFI MailArchiver to use a proxy server to connect to the GFI servers and check for
updated versions.

Proxy server/Port Defines the Proxy server and the port that GFI MailArchiver uses to connect to the GFI servers
for version check purposes.

Proxy requires
authentication

Enable option if the Proxy server specified in the Proxy server and Port fields requires
authentication.

Username/Password Defines the username and password that GFI MailArchiver uses if the proxy server uses
authentication.

Table 73: Version Check settings

4. Click Save to save new setup.
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8 Configuring Email Client Access

GFI MailArchiver provides integration with various email clients and technologies so that users can
access their archived emails from remote locations, while in the office or on the move. Use the Email
Client Access page to:

Download GFI MailArchiver Outlook Connector, a Microsoft Outlook® plugin that enables users to
view archived emails from their Microsoft Outlook client.

Download GFI MailArchiver Outlook Addon, a tool that enables users to manually archive emails
contained in their Microsoft Outlook® installation.

Configure an IMAP account on your email client of choice to view archived emails in mailboxes you
have access to.

In this chapter:

8.1 Installing GFI MailArchiver Outlook Connector 151

8.2 How Does the GFI MailArchiver Outlook® Connector Work 151

8.3 Downloading GFI MailArchiver Outlook Connector 152

8.3.1 Changing the Outlook® Connector Tab Availability 152

8.4 Outlook® Connector System Requirements 152

8.4.1 Software 152
8.4.2 Hardware 153
8.4.3 Installing GFI MailArchiver Outlook Connector Without GPO - Manual Install 153

8.5 Installing GFI MailArchiver Outlook Connector via GPO 154

8.5.1 Installing Outlook® Connector via GPO in Windows® Server 2003 155
8.5.2 Installing Outlook® Connector via GPO in Windows Server 2008 157

8.6 Configuring Manual Archiving 159

8.6.1 How Does Manual Archiving Work? 160
8.6.2 GFI MailArchiver Outlook Addon System Requirements 160
8.6.3 Software 160
8.6.4 Hardware 161

8.7 Enabling and Disabling GFI MailArchiver Outlook® Addon 161

8.8 Downloading and Installing GFI MailArchiver Outlook Addon 162

8.8.1 Changing the Outlook® Addon Tab Availability 163
8.8.2 Installing GFI MailArchiver Outlook Addon Manually 163
8.8.3 Installing Manual Archiving Plugin Through GPO 163
8.8.4 Installing GFI MailArchiver Outlook Addon Through GPO WinSvr2003 163
8.8.5 Installing Manual Archiving Through GPO Windows® Server 2008 165

8.9 Configuring GFI MailArchiver IMAP Client Access 167

8.9.1 Configuring IMAP in Apple Mail 3.0 168
8.9.2 Configuring IMAP in iOS5 169
8.9.3 Configuring IMAP in Microsoft Outlook® 2003 170
8.9.4 Configuring IMAP in Microsoft Outlook® 2007 171
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8.9.5 Configuring IMAP in Microsoft Outlook® 2010 172
8.9.6 Configuring IMAP in Outlook® 2011 for Mac 173
8.9.7 Configuring IMAP in Windows® Live Mail 174
8.9.8 Configuring IMAP on Android 174
8.9.9 Configuring IMAP in Mozilla Thunderbird 10 175

8.1 Installing GFI MailArchiver Outlook Connector

The GFI MailArchiver Outlook Connector enables users to synchronize their Microsoft Outlook® folders
with the data archived by GFI MailArchiver. This connector can be installed via Active Directory®

Group Policy Objects (GPO) or via manual install.

In this chapter:

8.2 How Does the GFI MailArchiver Outlook® Connector Work

Figure 2: How does GFI MailArchiver Outlook® connector work?

1. GFI MailArchiver Outlook Connector (installed on client machine) initiates a request to
synchronize Microsoft Outlook® folders with GFI MailArchiver.

2. GFI MailArchiver retrieves the required email and folder data from the GFI MailArchiver archive

store .

3. GFI MailArchiver sends the email data to the Microsoft Outlook® client machines.
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8.3 Downloading GFI MailArchiver Outlook Connector

The GFI MailArchiver Outlook Connector can be downloaded from the GFI MailArchiver web interface.

1. Open GFI MailArchiver.

2. Select Email Client Access tab.

3. Click Outlook Connector tab.

4. Select one of the available download options link to download GFI MailArchiver Outlook Connector.
Available options are:

OPTION DESCRIPTION

Outlook Connector (32-bit Out-
look)

Download the GFI MailArchiver Outlook Connector for Microsoft Outlook 32-bit ver-
sion.

Outlook Connector (64-bit Out-
look)

Download the GFI MailArchiver Outlook Connector for Microsoft Outlook 64-bit
version.

Table 74: GFI MailArchiver Outlook Connector versions

8.3.1 Changing the Outlook® Connector Tab Availability

By default, the Outlook® Connector tab is visible and available to all users when they log in GFI
MailArchiver. To disable users from seeing it:

1. In the Email Client Access page, click on the GFI MailArchiver Outlook Connector tab.

2. Select an option and click Save. Available options are:

OPTION DESCRIPTION

Administrators only Makes the Outlook® Connector tab available only to users that log on using domain
administrator privileges.

All users and Admin-
istrators

Makes the Outlook® Connector tab available to all users, regardless of their logon privileges.

Table 75: Outlook® Connector Tab Availability options

8.4 Outlook® Connector System Requirements

8.4.1 Software

NOTE

The machines where GFI MailArchiver Outlook Connector is deployed must be able to
connect to the GFI MailArchiver server.

COMPONENT DESCRIPTION

Supported Microsoft
Outlook Versions

Microsoft Outlook® 2003 (including Service Packs 1, 2, 3 or 4)

Microsoft Outlook® 2007 (including Service Packs 1 or 2)

Microsoft Outlook® 2010 (x86 and x64 versions)

Table 76: GFI MailArchiver Outlook Connector software requirements



GFI MailArchiver 8 Configuring EmailClient Access | 153

COMPONENT DESCRIPTION

Supported Operating
Systems

Windows® 7

Windows® Vista

Windows® XP

Windows® Server 2008

Windows® Server 2003

Windows® Server 2000

Other Required
Components

Internet Explorer® 7 or later (Internet Explorer® 9 Compatibility Mode only)/Mozilla
Firefox/Google Chrome/Safari®

HTTP port 80 (or HTTPS default port 443 for secure connections) - used by GFI
MailArchiver Outlook Connector to connect with GFI MailArchiver.

NOTE

GFI MailArchiver Outlook Connector cannot be installed on the Microsoft® Exchange
Server.

NOTE

When using a web-filtering tool, this must be configured to allow all HTTP requests
between GFI MailArchiver server and GFI MailArchiver Outlook Connector. Ensure that
the GFI MailArchiver server’s IP address, NETBIOS name and DNS name are not blocked
by the web filter. For more information, refer to:

http://go.gfi.com/?pageid=MAR_WebFiltering

8.4.2 Hardware

COMPONENT REQUIREMENTS

Processor 1GHz processor or more.

Memory Minimum: 512MB RAM
Recommended: 2GB RAM

Physical Storage 20MB physical disk space required for GFI MailArchiver Outlook Connector installation. More
space is required to store email headers and emails for offline access.

Table 77: GFI MailArchiver Outlook Connector hardware requirements

8.4.3 Installing GFI MailArchiver Outlook Connector Without GPO - Manual Install

1. Open GFI MailArchiver.

2. Select Email Client Access tab.

3. Select Outlook Connector tab and download the following to a share accessible by all domains:

MAROC_32bitOutlook.msi (Installer for Microsoft Outlook 2010 32-bit computers only)

MAROC_64bitOutlook.msi (Installer for Microsoft Outlook 2010 64-bit computers only)

http://go.gfi.com/?pageid=MAR_WebFiltering
http://go.gfi.com/?pageid=MAR_WebFiltering
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NOTE

Make sure that when deploying the 32-bit version of the GFI MailArchiver Outlook
Connector, the domain policy used contains only computers with Microsoft Outlook®

2010 32-bit version installed.

Also, ensure to use a domain policy that applies only to computers where Microsoft
Outlook® 2010 64-bit version is installed when deploying GFI MailArchiver 2010 64-bit
edition.

2. Double click on the file and follow the wizard to install

NOTE

To check installation, from Microsoft Outlook®, check that a new folder called GFI
MailArchiver Mailbox is created.

3. <Optional>: Add the Outlook® connector administrator template that will set up Outlook
connector.

a. From command prompt, key in: mmc.exe

b. Click Enter to launch the Microsoft Management Console.

c. Click File > Add/Remove Snap-in… and click Add...

d. Select Group Policy Object Editor snap-in and click Add.

e. Click Browse… and select the domain policy to edit.

f. Select the domain policy and click OK.

g. Click Finish to close ‘Select Group Policy Object’ dialog. Click Close to close ‘Add standalone Snap-
in’ dialog and click OK to close ‘Add/Remove Snap-in’ dialog; to return to the Microsoft Management
Console.

h. Navigate to Console Root > <domain policy> > User Configuration, right-click Administrative
Templates, and select Add/Remove Templates….

i. Click Add…, browse for the file gfiapps.adm located in: <Program
Files\GFI\MailArchiver\Outlook> and click Open.

j. Click Close to return to the Microsoft Management Console.

For information on how to use the GFI MailArchiver Outlook Connector, refer to the GFI MailArchiver
Outlook Connector manual available from:

http://go.gfi.com/?pageid=MAR_DownloadDocumentation

8.5 Installing GFI MailArchiver Outlook Connector via GPO

This section will help you install GFI MailArchiver Outlook Connector via GPO in the following
environments:

Windows® Server 2003

Windows® Server 2008

Manual Installation (Without GPO)

http://go.gfi.com/?pageid=MAR_DownloadDocumentation
http://go.gfi.com/?pageid=MAR_DownloadDocumentation
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8.5.1 Installing Outlook® Connector via GPO in Windows® Server 2003

1. Open GFI MailArchiver.

2. Select Email Client Access tab.

3. Select Outlook Connector tab and download the following to a share accessible by all domains:

MAROC_32bitOutlook.msi (Installer for Microsoft Outlook 2010 32-bit computers only)

MAROC_64bitOutlook.msi (Installer for Microsoft Outlook 2010 64-bit computers only)

NOTE

Make sure that when deploying the 32-bit version of the GFI MailArchiver Outlook
Connector, the domain policy used contains only computers with Microsoft Outlook®

2010 32-bit version installed.

Also, ensure to use a domain policy that applies only to computers where Microsoft
Outlook® 2010 64-bit version is installed when deploying GFI MailArchiver 2010 64-bit
edition.

2. From command prompt, key in:

mmc.exe

and click Enter to launch the Microsoft Management Console.

3. Click File > Add/Remove Snap-in… and click Add...

4. Select Group Policy Object Editor snap-in and click Add.

5. Click Browse… and select the domain policy to edit.

6. Select the domain policy and click OK.

7. Click Finish to close ‘Select Group Policy Object’ dialog. Click Close to close ‘Add standalone Snap-
in’ dialog and click OK to close ‘Add/Remove Snap-in’ dialog; to return to the Microsoft Management
Console.

8. Navigate to Console Root > <domain policy> > User Configuration, right-click Administrative
Templates, and select Add/Remove Templates….

9. Click Add…, browse for the file gfiapps.adm located in: <Program Files\GFI\MailArchiver\Outlook>
and click Open.

10. Click Close to return to the Microsoft Management Console.

11. Expand Console Root > <domain policy> > User Configuration > Administrative Templates > GFI
Applications.
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Screenshot 86: Setting GFI MailArchiver server URL in Windows® Server 2003 GPO

12. From the right pane, double click GFI MailArchiver Server Location policy and select Enabled. In
the Server URL text box enter the URL where user machines can access GFI MailArchiver in the form
http://<hostname>/<GFI MailArchiver virtual folder name>

For example:

http://win2k3entsvr.master-domain.com/MailArchiver

13. <Optional> Click Next Setting and configure the following settings. For each option select Not
Configured to use the default value or click Enable to specify a custom value.

GFI MailArchiver Outlook® Connector Data Path Root - specify a different root location where
store configurations and local emails are stored on client machines. For example, type ‘%MyDo-
cuments%’ to store in the My Documents folder of the logged on user.

GFI MailArchiver Outlook® Connector days span - specify the number of days for which emails
are synchronized. Only emails received within this time span are accessible through GFI Mai-
lArchiver Outlook® Connector.

GFI MailArchiver Outlook® Connector download batch size - Specify how many emails can be
downloaded during one synchronization session.

GFI MailArchiver Outlook® Connector connection timeout - Specify the timeout period in mil-
liseconds for accessing data from the GFI MailArchiver server.

GFI MailArchiver Outlook® Connector maximum offline days - Specify the maximum number of
days which a user can set for emails offline access.
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GFI MailArchiver Outlook® Connector offline support - Enable or disable offline support. If off-
line support is enabled, specify the number of days to support offline access. If this setting is ena-
bled:

Users are not allowed to modify offline access

GFI MailArchiver Outlook® Connector maximum offline days setting is ignored.

14. Click OK when all settings are configured.

15. Select Console Root > <domain policy> > Computer Configuration > Software Settings.

16. Right click Software installation and select New > Package…

17. In the Open dialog, locate the share where msi file is saved.

NOTE

When selecting the location of the msi file ensure that this is done through ‘My network
locations’ so that the share name in GFI MailArchiver includes the full network share
location rather than the local path.

18. Choose the deployment option - select Assigned and OK.

19. GFI MailArchiver Outlook Connector will be installed the Next time each client machine is started.

To check installation, from Microsoft Outlook®, check that a new folder called GFI MailArchiver
Mailbox is created.

For information on how to use the GFI MailArchiver Outlook Connector, refer to the Outlook
Connector Manual available from:

http://go.gfi.com/?pageid=MAR_DownloadDocumentation

8.5.2 Installing Outlook® Connector via GPO in Windows Server 2008

1. Open GFI MailArchiver.

2. Select Email Client Access tab.

3. Select Outlook Connector tab and download the following to a share accessible by all domains:

MAROC_32bitOutlook.msi (Installer for Microsoft Outlook 2010 32-bit computers only)

MAROC_64bitOutlook.msi (Installer for Microsoft Outlook 2010 64-bit computers only)

NOTE

Make sure that when deploying the 32-bit version of the GFI MailArchiver Outlook
Connector, the domain policy used contains only computers with Microsoft Outlook®

2010 32-bit version installed.

Also, ensure to use a domain policy that applies only to computers where Microsoft
Outlook® 2010 64-bit version is installed when deploying GFI MailArchiver 2010 64-bit
edition.

2. From command prompt, key in:

mmc.exe

and click Enter to launch the Microsoft Management Console.

http://go.gfi.com/?pageid=MAR_DownloadDocumentation
http://go.gfi.com/?pageid=MAR_DownloadDocumentation
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3. Click File > Add/Remove Snap-in… and click Add...

4. Select Group Policy Management Editor snap-in and click Add.

5. Click Browse… and select the domain policy to edit.

6. Select the domain policy and click OK.

7. Click Finish to close ‘Select Group Policy Object’ dialog. Click Close to close ‘Add standalone Snap-
in’ dialog and click OK to close ‘Add/Remove Snap-in’ dialog; to return to the Microsoft Management
Console.

8. Navigate to Console Root > <domain policy> > User Configuration > Policies, right-click
Administrative Templates, and select Add/Remove Templates….

9. Click Add…, browse for the file gfiapps.adm located in: <Program
Files\GFI\MailArchiver\Outlook> and click Open.

10. Click Close to return to the Microsoft Management Console.

11. Expand Console Root > <domain policy> > User Configuration > Policies > Administrative
Templates > Classic Administrative Templates (ADM) > GFI Applications.

Screenshot 87: Setting GFI MailArchiver server URL in Windows® Server 2003 GPO

12. From the right pane, double click GFI MailArchiver Server Location policy and select Enabled. In
the Server URL text box enter the URL where user machines can access GFI MailArchiver in the form
http://<hostname>/<GFI MailArchiver virtual folder name>

For example:

http://win2k3entsvr.master-domain.com/MailArchiver
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13. <Optional> Click Next Setting and configure the following settings. For each option select Not
Configured to use the default value or click Enable to specify a custom value.

GFI MailArchiver Outlook® Connector Data Path Root - specify a different root location where
store configurations and local emails are stored on client machines. For example, type ‘%MyDo-
cuments%’ to store in the My Documents folder of the logged on user.

GFI MailArchiver Outlook® Connector days span - specify the number of days for which emails
are synchronized. Only emails received within this time span are accessible through GFI Mai-
lArchiver Outlook® Connector.

GFI MailArchiver Outlook® Connector download batch size - Specify how many emails can be
downloaded during one synchronization session.

GFI MailArchiver Outlook® Connector connection timeout - Specify the timeout period in mil-
liseconds for accessing data from the GFI MailArchiver server.

GFI MailArchiver Outlook® Connector maximum offline days - Specify the maximum number of
days which a user can set for emails offline access.

GFI MailArchiver Outlook® Connector offline support - Enable or disable offline support. If off-
line support is enabled, specify the number of days to support offline access. If this setting is ena-
bled:

Users are not allowed to modify offline access

GFI MailArchiver Outlook® Connector maximum offline days setting is ignored.

14. Click OK when all settings are configured.

15. Select Console Root > <domain policy> > Computer Configuration > Policies > Software
Settings.

16. Right click Software installation and select New > Package…

17. In the Open dialog, locate the share where msi file is saved.

NOTE

When selecting the location of the msi file ensure that this is done through ‘My network
locations’ so that the share name in GFI MailArchiver includes the full network share
location rather than the local path.

18. Choose the deployment option - select Assigned and OK.

19. GFI MailArchiver Outlook Connector will be installed the Next time each client machine is started.

To check installation, from Microsoft Outlook®, check that a new folder called GFI MailArchiver
Mailbox is created.

For information on how to use the GFI MailArchiver Outlook Connector, refer to the Outlook
Connector Manual available from:

http://go.gfi.com/?pageid=MAR_DownloadDocumentation

8.6 Configuring Manual Archiving

The GFI MailArchiver Outlook Addon enables users to manually archive emails and files (such as
documents or images) from Microsoft Outlook®. This connector can be installed via Active Directory®

http://go.gfi.com/?pageid=MAR_DownloadDocumentation
http://go.gfi.com/?pageid=MAR_DownloadDocumentation
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Group Policy Objects (GPO) or via manual install.

IMPORTANT

Emails archived through the GFI MailArchiver Outlook Addon get archived irrespective of
any rules set in Rules-based Archiving.

8.6.1 How Does Manual Archiving Work? 160

8.6.2 GFI MailArchiver Outlook Addon System Requirements 160

8.6.3 Software 160

8.6.4 Hardware 161

8.6.1 How Does Manual Archiving Work?

1. Within Microsoft Outlook®, user selects an email, a group of emails, a file or a number of files, or a
folder and uses the archive commands in the additional toolbar that is installed when GFI
MailArchiver Outlook Addon is deployed.

NOTE

Microsoft Outlook® 2007 and 2010 enable users to store files (documents, images, pdf's
etc) under a folder in the user mailbox. To store a file, create a folder under Inbox, and
drag the file into this folder. You cannot store a file within Inbox.

2. GFI MailArchiver Outlook Addon (installed on client machine) initiates a request to synchronize the
selected emails with GFI MailArchiver.

8.6.2 GFI MailArchiver Outlook Addon System Requirements

8.6.3 Software

NOTE

The machines where GFI MailArchiver Outlook Addon is deployed must be able to
connect to the GFI MailArchiver server.

SOFTWARE DESCRIPTION

Supported Microsoft
Outlook® Versions

Microsoft Outlook® 2003 (including Service Packs 1, 2, 3 or 4)

Microsoft Outlook® 2007 (including Service Packs 1 or 2)

Microsoft Outlook® 2010 (x86 and x64 versions)

Table 78: GFI MailArchiver Outlook Addon software requirements
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SOFTWARE DESCRIPTION

Supported Operating
Systems

Windows® 7

Windows® Vista

Windows® XP

Windows® Server 2008

Windows® Server 2003

Other Required
Components

HTTP port 80 (or HTTPS default port 443 for secure connections) - used by GFI
MailArchiver Outlook Addon to connect with GFI MailArchiver.

Microsoft .NET® Framework 4 Client Profile

NOTE

GFI MailArchiver Outlook Addon cannot be installed on the Microsoft® Exchange Server.

NOTE

When using a web-filtering tool, this must be configured to allow all HTTP requests
between GFI MailArchiver server and GFI MailArchiver Outlook Addon. Ensure that the
GFI MailArchiver server’s IP address, NETBIOS name and DNS name are not blocked by
the web filter. For more information, refer to:

http://go.gfi.com/?pageid=MAR_WebFiltering

8.6.4 Hardware

COMPONENT REQUIREMENTS

Processor 1GHz processor or more.

Memory Minimum: 512MB RAM
Recommended: 2GB RAM

Physical Storage 20MB physical disk space required for GFI MailArchiver Outlook Addon installation. More
space is required to store email headers and emails for offline access.

Table 79: GFI MailArchiver Outlook Addon hardware requirements

8.7 Enabling and Disabling GFI MailArchiver Outlook® Addon

To disable or enable GFI MailArchiver Outlook Addon:

1. Log on to GFI MailArchiver with a user that has administrative privileges.

2. From the Configuration page, select Archiving Method.

3. Click Configure Archiving Method.

http://go.gfi.com/?pageid=MAR_WebFiltering
http://go.gfi.com/?pageid=MAR_WebFiltering
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Screenshot 88: Enable or disable Manual Archiving

4. Perform one of the following actions:

Select Manual Archiving to enable GFI MailArchiver Outlook Addon.

Unselect Manual Archiving to disable GFI MailArchiver Outlook Addon.

5. Click Save to complete the configuration.

8.8 Downloading and Installing GFI MailArchiver Outlook Addon

The GFI MailArchiver Outlook Addon can be downloaded from the GFI MailArchiver web interface.

IMPORTANT

GFI MailArchiver Outlook Addon is not available for download if Manual Archiving is not
enabled. For more information, refer to Configuring Archiving Method (page 93).

1. Open GFI MailArchiver.

2. Click Email Client Access tab.

3. From Manual Archiving area, click Download Outlook Addon.

4. Double click the downloaded file and follow the wizard to install.



GFI MailArchiver 8 Configuring EmailClient Access | 163

NOTE

To verify successful installation, check that GFI MailArchiver Outlook Addon toolbar is
visible within Microsoft Outlook®.

8.8.1 Changing the Outlook® Addon Tab Availability

By default, the GFI MailArchiver Outlook Addon tab is visible and available to all users when they log
in GFI MailArchiver. To disable users from seeing it:

1. In the Email Client Access page, click on the GFI MailArchiver Outlook Addon tab.

2. Select an option and click Save. Available options are:

OPTION DESCRIPTION

Administrators only Makes the GFI MailArchiver Outlook Addon tab available only to users that log on using domain
administrator privileges.

All users and Admin-
istrators

Makes the GFI MailArchiver Outlook Addon tab available to all users, regardless of their logon
privileges.

Table 80: Outlook® Connector Tab Availability options

8.8.2 Installing GFI MailArchiver Outlook Addon Manually

1. Open GFI MailArchiver.

2. Click Email Client Access tab.

3. From Manual Archiving area, click Download Outlook Addon.

4. Double click the downloaded file and follow the wizard to install.

NOTE

To verify successful installation, check that Archive buttons are now visible within
Microsoft Outlook®.

8.8.3 Installing Manual Archiving Plugin Through GPO

This section will help you install GFI MailArchiver Outlook Addon via GPO in the following
environments:

Windows® Server 2003

Windows® Server 2008

8.8.4 Installing GFI MailArchiver Outlook Addon Through GPO WinSvr2003

1. Open GFI MailArchiver.

2. Click Email Client Access tab.

3. From Manual Archiving area, click Download Outlook Addon.

4. Save the downloaded file in a shared location accessible by all domains.
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5. From command prompt, key in mmc.exe and click Enter to launch the Microsoft Management
Console.

6. Click File > Add/Remove Snap-in….

7. Select Group Policy Object Editor snap-in and click Add.

8. Click Browse… and select the domain policy to edit.

9. Select the domain policy and click OK.

10. Click Finish to close ‘Select Group Policy Object’ dialog. Click Close to close ‘Add standalone
Snap-in’ dialog and click OK to close ‘Add/Remove Snap-in’ dialog; to return to the Microsoft
Management Console.

11. Navigate to Console Root > <domain policy> > User Configuration, right-click Administrative
Templates, and select Add/Remove Templates….

12. Click Add…, browse for the file gfiapps.adm located in: <Program
Files\GFI\MailArchiver\Outlook> and click Open.

13. Click Close to return to the Microsoft Management Console.

14. Expand Console Root > <domain policy> > User Configuration > Administrative Templates >
Classic Administrative Templates (ADM) > GFI Applications.

15. From the right pane, double click GFI MailArchiver Server Location policy and select Enabled. In
the Server URL text box enter the URL where user machines can access GFI MailArchiver in the form
http://<hostname>/<GFI MailArchiver virtual folder name>

For example:

http://win2k3entsvr.master-domain.com/MailArchiver

16. Click OK when all settings are configured.

17. Select Console Root > <domain policy> > Computer Configuration > Software Settings.

18. Right click Software installation and select New > Package…

19. In the Open dialog, locate the share where msi file is saved.

NOTE

When selecting the location of the msi file ensure that this is done through ‘My network
locations’ so that the share name in GFI MailArchiver includes the full network share
location rather than the local path.

20. Choose the deployment option - select Assigned and OK.

21. GFI MailArchiver Outlook Addon will be installed the Next time each client machine is started.

To check installation, verify that the GFI MailArchiver Outlook Addon toolbar is visible in Microsoft
Outlook®.
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NOTE

For information on how to use the GFI MailArchiver Outlook Addon, refer to the GFI
MailArchiver Outlook Addon manual available from:

http://www.gfi.com/mar/manual/

8.8.5 Installing Manual Archiving Through GPO Windows® Server 2008

1. Open GFI MailArchiver.

2. Click Email Client Access tab.

3. From Manual Archiving area, click Download Outlook Addon.

4. From command prompt, key in mmc.exe and click Enter to launch the Microsoft Management
Console.

5. Click File > Add/Remove Snap-in… and click Add...

6. Select Group Policy Management Editor snap-in and click Add.

7. Click Browse… and select the domain policy to edit.

8. Select the domain policy and click OK.

9. Click Finish to close ‘Select Group Policy Object’ dialog. Click Close to close ‘Add standalone Snap-
in’ dialog and click OK to close ‘Add/Remove Snap-in’ dialog; to return to the Microsoft Management
Console.

10. Navigate to Console Root > <domain policy> > User Configuration > Policies, right-click
Administrative Templates, and select Add/Remove Templates….

11. Click Add…, browse for the file gfiapps.adm located in: <Program Files\GFI\MailArchiver\Outlook>
and click Open.

12. Click Close to return to the Microsoft Management Console.

13. Expand Console Root > <domain policy> > User Configuration > Policies > Administrative
Templates > Classic Administrative Templates > GFI Applications.

http://www.gfi.com/mar/manual/
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Screenshot 89: Setting GFI MailArchiver server URL in Windows® Server 2008 GPO

14. From the right pane, double click GFI MailArchiver Server Location policy and select Enabled. In
the Server URL text box enter the URL where user machines can access GFI MailArchiver in the form
http://<hostname>/<GFI MailArchiver virtual folder name>

For example:

http://win2k3entsvr.master-domain.com/MailArchiver

15. <Optional> Click Next Setting and configure the following settings. For each option select Not
Configured to use the default value or click Enable to specify a custom value.

Data Path Root - specify a different root location where store configurations and local emails are
stored on client machines. For example, type ‘%MyDocuments%’ to store in the My Documents
folder of the logged on user.

Days span - specify the number of days for which emails are synchronized. Only emails received
within this time span are accessible through GFI MailArchiver Outlook Addon.

Download batch size - Specify how many emails can be downloaded during one synchronization
session.

Connection timeout - Specify the timeout period in milliseconds for accessing data from the GFI
MailArchiver server.

Maximum offline days - Specify the maximum number of days which a user can set for emails off-
line access.

Offline support - Enable or disable offline support. If offline support is enabled, specify the
number of days to support offline access. If this setting is enabled:
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Users are not allowed to modify offline access

GFI MailArchiver Outlook Addon maximum offline days setting is ignored.

16. Click OK when all settings are configured.

17. Select Console Root > <domain policy> > Computer Configuration > Software Settings.

18. Right click Software installation and select New > Package…

19. In the Open dialog, locate the share where msi file is saved.

NOTE

When selecting the location of the msi file ensure that this is done through ‘My network
locations’ so that the share name in GFI MailArchiver includes the full network share
location rather than the local path.

20. Choose the deployment option - select Assigned and OK.

21. GFI MailArchiver Outlook Addon will be installed the Next time each client machine is started.

To check installation, verify that the GFI MailArchiver Outlook Addon toolbar is visible in Microsoft
Outlook®.

NOTE

For information on how to use the GFI MailArchiver Outlook Addon, refer to the GFI
MailArchiver Outlook Addon manual available from:

http://www.gfi.com/mar/manual/

8.9 Configuring GFI MailArchiver IMAP Client Access

GFI MailArchiver supports a number of e-mail clients that use IMAP to transfer archived e-mail
messages from the Archive Stores to the email client. Users are able to access a read-only view of
their archived emails using one of the following supported email clients:

Android email application

Apple Mail

iOS5 email application

Microsoft Outlook® 2003

Microsoft Outlook® 2007

Microsoft Outlook® 2010

Microsoft Outlook® 2011 for Mac

Mozilla Thunderbird

Windows® Live Mail

http://www.gfi.com/mar/manual/
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NOTE

Internet Message Access Protocol (IMAP) is an Internet protocol for e-mail retrieval.

Viewing Shared Mailboxes

As a user with access to other users' mailboxes, you can use your IMAP account to view the shared
mailboxes you have access to. To do this, you need to configure a new account for each shared
mailbox. Follow the instructions on how to create a new IMAP client account in the email client of
your choice, however, as a username, type your username in the following format: <your email
address> ¦ <user email address> using your own password.

IMPORTANT

To configure email clients to use IMAP, you must first configure the IMAP Server. For
more information, refer to Configuring IMAP Server (page 128).

In this chapter:

8.9.1 Configuring IMAP in Apple Mail 3.0 168

8.9.2 Configuring IMAP in iOS5 169

8.9.3 Configuring IMAP in Microsoft Outlook® 2003 170

8.9.4 Configuring IMAP in Microsoft Outlook® 2007 171

8.9.5 Configuring IMAP in Microsoft Outlook® 2010 172

8.9.6 Configuring IMAP in Outlook® 2011 for Mac 173

8.9.7 Configuring IMAP in Windows® Live Mail 174

8.9.8 Configuring IMAP on Android 174

8.9.9 Configuring IMAP in Mozilla Thunderbird 10 175

8.9.1 Configuring IMAP in Apple Mail 3.0

Follow these instructions to configure IMAP in Apple Mail 3.0:

NOTE

The following configuration requires an Internet connection.

1. Click Mail > Preferences....

2. On the Accounts tab, click the + button to add a new account.

3. Enter the following information:
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OPTION VALUE

Full Name: [your name]

Email Address: [full email address]

Password: [your password]

4. Click Continue.

5. Enter the following Incoming Mail Server information:

OPTION VALUE

Account Type: Select IMAP

Description Enter account description

Incoming Mail Server: imap.gfi.com

User Name: [full email address]

Password: [your password]

6. Click Continue to view the Incoming Mail Security screen.

7. Select Use Secure Sockets Layer (SSL) to connect to GFI MailArchiver using an encrypted
connection.

NOTE

If SSL is not enabled, the connection will be unencrypted.

8. Enter the following Outgoing Mail Server information:

OPTION VALUE

Outgoing Mail Server: smtp.gfi.com

Use Authentication: selected

User Name: [User name]

Password: [your password]

9. Click Continue.

10. Review your Account Summary, and click Create.

11. Select the account you just created.

12. In the Advanced tab, enter the following information:

OPTION VALUE

Port Use the default port number 44143 or the port number specified by your Systems Administrator.

Use SSL Select to connect to GFI MailArchiver using an encrypted connection.

8.9.2 Configuring IMAP in iOS5

Follow these instructions to configure IMAP in iOS5:

NOTE

The following configuration requires an Internet connection.

1. Tap Settings and select Mail, Contacts, Calendars.

2. In the Accounts section, tap Add Account.



GFI MailArchiver 8 Configuring EmailClient Access | 170

3. From the list, select Other.

4. Select Add Mail Account and enter the following information:

OPTION VALUE

Name: [your name]

Address: [full email address]

Password: [your password]

Description: [meaningful description]

5. Tap Next. The device will connect to the Internet and check your account.

6. Select IMAP and enter the following information:

INCOMING MAIL SERVER DETAILS: VALUE

Host Name: [IMAP server name]

User Name: [full email address]

Password: [your password]

OUTGOING MAIL SERVER DETAILS: VALUE

Host Name: [SMTP server name]

User Name: [User name]

Password: [your password]

NOTE

Outgoing Mail Server details must be provided by your Systems Administrator.

7. Tap Next. If you receive an error indicating that you Cannot Connect Using SSL, tap Yes to
continue without SSL, then tap Save.

NOTE

SSL can be configured after you save the new email account. If SSL is not enabled, the
connection will be unencrypted.

8. From Mail, Contacts, Calendars, locate the account you created under the Accounts section.

9. Tap the account name, scroll to Advanced.

10. Under Incoming Settings, change Server Port number to the default port number 44143 or the
port number specified by your Systems Administrator.

11. Tap Use SSL to turn it on.

12. Tap Next. The device will verify the information you entered.

8.9.3 Configuring IMAP in Microsoft Outlook® 2003

1. Start Outlook®.

2. On the Tools menu, click E-mail Accounts.

3. Under E-mail Accounts, click Add a new e-mail account, and then click Next.

4. Click IMAP as the type of account that you are creating, and then click Next.

5. In the User Information section enter the following information:
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OPTION VALUE

Your Name: [your name]

E-mail Address: [full e-mail address]

6. In the Server Information section enter the following information:

OPTION VALUE

Incoming mail server (IMAP): [IMAP Server name]

Outgoing mail server (SMTP): [SMTP server name provided by your Systems Administrator]

7. In the Logon Information section enter the following information:

OPTION VALUE

User Name: [full e-mail address]

Password: [your password]

8. Click More Settings > Advanced enter the following information:

OPTION VALUE

Incoming server (IMAP): Use the default port number 44143 or the port number specified by your
Systems Administrator.

This server requires an encrypted
connection

Select this option to connect using an encrypted connection.

NOTE

If SSL is not enabled, the connection will be unencrypted.

9. Click Next after you have completed entering this configuration information, and then click Finish.

8.9.4 Configuring IMAP in Microsoft Outlook® 2007

1. Start Outlook®.

2. On the Tools menu, click Options.

3. On the Mail Setup tab, click Email Accounts.

4. Click New.

5. In the Auto Account Setup dialog box, select Manually configure server settings or additional
server types, then click Next.

6. Click Internet E-Mail, and then click Next.

7. In the User Information section enter the following information:

OPTION VALUE

Your Name: [your name]

E-mail Address: [full e-mail address]

8. In the Server Information section enter the following information:

OPTION VALUE

Account Type: IMAP

Incoming mail server: [IMAP server name]

Outgoing mail server (SMTP): [SMTP server name provided by your Systems Administrator]

9. In the Logon Information section enter the following information:
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OPTION VALUE

User Name: [full e-mail address]

Password: [your password]

10. Click More Settings > Advanced enter the following information:

OPTION VALUE

Incoming server (IMAP): Use the default port number 44143 or the port number specified by your
Systems Administrator.

Use the following type of encrypted
connection:

Select the encryption method provided by your Systems Administrator.

NOTE
If prompted, accept the Security Certificate.

NOTE

If ‘NONE’ is selected as the type of encryption, the connection will be unencrypted.

11. Click Next after you have completed entering this configuration information, and then click
Finish.

8.9.5 Configuring IMAP in Microsoft Outlook® 2010

1. Start Outlook®.

2. On the Filemenu, click Info, then click Account Settings.

3. Select Account Settings from the list.

4. On the E-mail tab, click New.

5. Select the Manually configure server settings or additional server types check box, and then click
Next.

6. Click Internet E-Mail, and then click Next.

7. In the User Information section enter the following information:

OPTION VALUE

Your Name: [your name]

E-mail Address: [full e-mail address]

8. In the Server Information section enter the following information:

OPTION VALUE

Account Type: IMAP

Incoming mail server: [IMAP server name]

Outgoing mail server (SMTP): [SMTP server name provided by your Systems Administrator]

9. In the Logon Information section enter the following information:

OPTION VALUE

User Name: [full e-mail address]

Password: [your password]

10. Click More Settings > Advanced enter the following information:
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OPTION VALUE

Incoming server (IMAP): Use the default port number 44143 or the port number specified by your
Systems Administrator.

Use the following type of encrypted
connection:

Select the encryption method provided by your Systems Administrator.

NOTE
If prompted, accept the Security Certificate.

NOTE

If ‘NONE’ is selected as the type of encryption, the connection will be unencrypted.

11. Click Next after you have completed entering this configuration information, and then click
Finish.

8.9.6 Configuring IMAP in Outlook® 2011 for Mac

Follow these instructions to configure IMAP Outlook® 2011 for Mac:

1. Open Outlook® 2011.

2. If you see a Welcome to Outlook® screen, click Add Account. Otherwise click Tools > Accounts and
click + in the menu bar.

3. Click E-mail Account.

4. Enter the following information:

OPTION VALUE

Email Address: [full email address]

Password: [your password]

User Name: [full email address]

Type: Select IMAP

Incoming Server: [IMAP server name]

Select Override default port and enter
port number:

Use the default port number 44143 or the port number specified by your
Systems Administrator.

Use SSL to connect (recommended) Select to connect to GFI MailArchiver using an encrypted connection.

NOTE
If SSL is not enabled, the connection will be unencrypted.

Outgoing Server: [SMTP server name provided by your Systems Administrator]

NOTE

Un-select Configure Automatically.

5. Click Add Account.

6. In the Accounts window, click on More Options and set Authentication to Use Incoming Server
Info.

7. Click Advanced and select Use IMAP IDLE (If the server supports it) to be notified when there are
new messages.

8. Click OK.
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8.9.7 Configuring IMAP in Windows® Live Mail

1. Open Windows® Live Mail and from the Accounts tab, click Email.

2. In the Add your email accounts window enter the following information:

OPTION VALUE

Email Address: [full email address]

Password: [your password]

Manually configure server settings: [Selected]

3. Click Next.

4. In the Configure server settings window enter the following information:

OPTION VALUE

Incoming server information:

Server type: [port number]

Server address: [IMAP server name]

Port: Use the default port number 44143 or the port number specified by your Systems
Administrator.

Requires a secure connection
(SSL):

Select to connect to GFI MailArchiver using an encrypted connection.

NOTE
If SSL is not enabled, the connection will be unencrypted.

Authenticate using: [Clear text]

Outgoing server information: [Use details provided by your Systems Administrator]

5. Click Next, then click Finish.

8.9.8 Configuring IMAP on Android

Follow these instructions to configure IMAP on Android devices:

NOTE

The following configuration requires an Internet connection.

1. Launch Email client and select option to create a new IMAP email account.

2. Configure the following Incoming Mail Server settings:

OPTION VALUE

Email Address: [full email address]

Password: [your password]

3. In Manual setup mode, enter the following information:

OPTION VALUE

Username: [full email address]

Password: [your password]

IMAP server: [IMAP server name]

Port: Use the default port number 44143 or the port number specified by your Systems Administrator.

Security type: Select the Security type provided by your Systems Administrator.

NOTE
If Security Type is set to None, your connection to the IMAP server will be unencrypted.
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4. After entering your IMAP configuration parameters, the device checks your incoming settings.

5. When prompted, enter Outgoing server settings supplied by your System Administrator. The device
checks your outgoing settings.

NOTE

Configuration instructions depend on your Android OS version. Consult your device
documentation for more information on how to set up a new IMAP account.

8.9.9 Configuring IMAP in Mozilla Thunderbird 10

Follow these instructions to configure IMAP in Mozilla Thunderbird 10:

1. In Thunderbird, select File > New > Mail Account.

2. In the Mail Account Setup screen enter the following information:

OPTION VALUE

Your name: [first and last name]

Email address: [full email address]

Password: [your password]

3. Click Continue.

NOTE

Click Stop to prevent Thunderbird from automatically detecting account settings, then
click Manual config.

4. In Mail Account Setup, enter the following information:

OPTION VALUE

Incoming: From the drop down menu, select IMAP.

Server hostname: [IMAP server name]

Port: [use default]

SSL: Select the encryption type provided by your Systems Administrator.

NOTE
If SSL is not enabled, the connection will be unencrypted.

Authentication: [Normal password]

Outgoing: [Use settings provided by your Systems Administrator]

5. Click Advanced Config and under the account name locate Server Settings. Enter the following
information:

OPTION VALUE

Port: Use the default port number 44143 or the port number specified by your Systems Administrator.

Username: [full email address]

6. After Thunderbird verifies the account information, click Create Account.

7. Click Get Mail to download emails.
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9 Import and Export Emails

GFI MailArchiver enables you to extract emails from various email databases and to import them into
the Archive Stores.

IMPORTANT

If Microsoft Outlook® is not detected on the machine where the tool is running, the
following import options are disabled:

Import from .pst files

Download to PST option when selecting Export data from GFI MailArchiver.

GFI MailArchiver supports only Microsoft Outlook® 2003/2007/2010 32bit.

Through GFI MailArchiver, you can also export emails from the Archive Stores, for example, to restore
deleted emails. GFI MailArchiver Import Export Tool can export emails to a:

specific email address

folder on disk in .eml or .msg format

PST file.

For more information, refer to Export emails from GFI MailArchiver Archive Stores (page 206).
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9.1 Import Emails From Microsoft® Exchange Mailboxes

The GFI MailArchiver Import Export Tool enables you to extract emails from Microsoft® Exchange
mailboxes and import them to the GFI MailArchiver Archive Stores.

The process of adding email from Microsoft® Exchange Mailboxes to
GFI MailArchiver involves the following procedure:

1. The GFI MailArchiver Import Export Tool extracts emails from
Microsoft® Exchange mailboxes.

2. The GFI MailArchiver Import Export Tool converts the emails to
MIME format.

3. The Import Service processes the extracted emails based on the
date of each email.

4. GFI MailArchiver stores emails in the appropriate archive store.
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9.1.1 Step 1: Importing emails from a remote computer

IMPORTANT

This section only applies when extracting emails from a remote machine. If importing
emails from the same machine where GFI MailArchiver is installed, skip to Run the GFI
MailArchiver Import Export Tool in this manual.

GFI MailArchiver lets you extract email mailboxes located on remote machines. To do this:

1. From the GFI MailArchiver machine, navigate to <GFI MailArchiver installation path>\MAIS\

2. Share Pickup folder to give full read and write permissions to the remote machine from where the
GFI MailArchiver Import Export Tool is to run. To share a folder:

In Windows® Server 2003:

a. Right-click the Pickup folder and select Sharing and Security…

b. Select Share this folder and click Permissions button to enter the Permissions dialog.

c. Click Add.

d. Enter the username of the user where the tool is going to be run and click Check Names to confirm
the user.

e. Click OK to add the user in the Permissions dialog.

f. In the Permissions dialog select the username added and select the Allow checkbox for Full Control.

g. Click OK to save and exit the Permissions dialog.

h. Click OK to save and exit the folder properties sharing dialog.

In Windows® Server 2008:

a. Right-click Pickup folder and select Share…

b. Specify the credentials under which the GFI MailArchiver Import Export Tool will run and click Add.

c. From the Permission Level drop-down list next to the added user, select Co-owner.

d. Select Share and click Done.

3. Return to where GFI MailArchiver is installed and copy the MarcImportExport folder.

4. Paste the folder on remote machine.

5. Open an instance of CMD

6. Browse to the MarcImportExport Folder on the local machine

7. Run MArcImportExport.exe.

9.1.2 Microsoft® Exchange mailbox access permissions – Grant Permissions

The Import from Microsoft Exchange Mailbox Wizard within GFI MailArchiver Import Export Tool
uses the credentials of the logged-on user when run on the Microsoft® Exchange Server machine
directly. To run the wizard on a server that is not the Microsoft® Exchange Server 2003/2007/2010
machine, specify a user name and a password. This account needs to be granted full mailbox access
(‘SendAs’ and ‘ReceiveAs’ permissions) on the mailboxes from which emails are to be extracted.
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NOTE

It is recommended to remove these permissions after extracting the mailboxes.

See Also:

Importing mailboxes remotely from Microsoft Exchange 2003 server

Importing mailboxes remotely from Microsoft Exchange 2007

Importing mailboxes remotely from Microsoft Exchange 2007 SP1 / SP2 / SP3

Importing mailboxes remotely from Microsoft Exchange 2010

Importing mailboxes remotely from Microsoft® Exchange Server 2003 server

1. Open Microsoft® Exchange System Manager.

2. Navigate to Servers > [Server Name] > [Storage Group], right click on the Mailbox Store and
select Properties.

3. Select Security tab.

4. Click Advanced button and uncheck Allow inheritable permissions… checkbox.

5. In the Security dialog box, select Copy.

6. Click OK to apply changes and return to the Mailbox Store Security properties.

7. In the Security tab, select Administrator from the Group or user names.

8. From the Permissions list, check Allow check boxes for Receive As and Send As.

9. Repeat steps 7 and 8 to allow Receive As and Send As permissions for:

Domain Admins

Enterprise Admins

Microsoft® Exchange Domain Servers.

10. Click OK to save settings.

11. Restart the Information Store:

a. Navigate to Start > Run, type services.msc, and click OK.

b. In the Results pane, right-click Microsoft Exchange Information Store service and
click Restart.

Importing mailboxes remotely from Microsoft® Exchange Server 2007

1. Open the Microsoft Exchange Management Shell.

2. Run the following PowerShell commandlet:

Add-ADPermission -identity "Mailbox Store" -User "Trusted User" -
AccessRights GenericAll
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NOTE

Replace Mailbox Store with the name of the mailbox store that contains the
mailboxes to import and ‘Trusted User’ with the user that will be granted full mailbox
access.

Example:

Add-ADPermission –Identity "Mailbox Database" -User "master-
domain\JohnSmith" –AccessRights GenericAll

Importing mailboxes remotely from Microsoft® Exchange Server 2007 SP1 SP2 SP3

1. Open the ‘Exchange Management Shell’ on the Microsoft® Exchange Server 2007.

2. Run the following Windows® PowerShell commandlet:

foreach ($exchangeServer in Get-ExchangeServer)

{

if ($exchangeServer.ServerRole -match 'ClientAccess')

{

Add-ADPermission -Identity $exchangeServer.DistinguishedName -User
'domain\user' -ExtendedRights ms-Exch-EPI-Impersonation

}

}

Example:

foreach ($exchangeServer in Get-ExchangeServer)

{

if ($exchangeServer.ServerRole -match 'ClientAccess')

{

Add-ADPermission -Identity $exchangeServer.DistinguishedName -User
'master-domain\administrator -ExtendedRights ms-Exch-EPI-Impersonation

}

}

Importing mailboxes remotely from Microsoft® Exchange Server 2010

1. Open the ‘Exchange Management Shell’ on the Microsoft® Exchange Server.

2. Run the following PowerShell commandlet:

New-ManagementScope -name "MAUMPolling" -recipientrestrictionfilter
{recipienttype -eq "UserMailbox"}

3. On completion, run the following PowerShell commandlet:

New-ManagementRoleAssignment -name "MAExportEmails" -
role:applicationimpersonation -user "administrator@domain.com" -
customrecipientwritescope "MAUMpolling"
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Example:

New-ManagementRoleAssignment -name " MAExportEmails " -
role:applicationimpersonation -user "administrator@mydomain.com"
-customrecipientwritescope "MAUMpolling"

9.1.3 Step 2: Run the GFI MailArchiver Import Export Tool

To export emails from Microsoft® Exchange mailboxes:

1. Launch the GFI MailArchiver Import Export Tool by navigating to Start > Programs > GFI
MailArchiver > GFI MailArchiver Import Export Tool.

2. Click Import from Microsoft Exchange mailbox.

Screenshot 90: Importing from a Microsoft Exchange mailbox

3. From the Microsoft Exchange Version area, select the applicable Microsoft® Exchange Server
option:

Microsoft® Exchange Server 2003 or 2007

Microsoft® Exchange Server 2007 SP1 or 2010
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4. From the Login Credentials area, configure a user with permissions to access the Microsoft®

Exchange mailboxes to import. Configure:

Login as current user – Login to Microsoft® Exchange Server using the credentials of the logged on
user.

Use other credentials – Specify the username (domain\username) and password of a user with full
mailbox access permissions.

Exchange Server – Specify the Microsoft® Exchange Server name or IP address.

Use SSL – Check this option if the Microsoft® Exchange Server requires SSL connection.

Extract emails from Public Folders – Check this option to extract emails from public folders.

Verify Credentials – Click this button to confirm access and authentication with Microsoft®

Exchange Server.

5. Click Next to continue.

Screenshot 91: Import from Microsoft Exchange: Mailbox and folder selection

6. Select the mailboxes and folders to import:

All mailboxes and folders – import all the emails in mailboxes that the configured user has access
to.
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Select the mailboxes and folders from where to extract emails – select this option to import the
emails of a particular mailbox. Specify the Mailbox name or click … button to select a mailbox to
import. To import emails from a particular folder only, check Import emails from the following
folder only and key in the folder’s name.

Export from all Folders - Check this option to extract emails from public folders.

7. Click Next to continue.

Screenshot 92: Import from Microsoft Exchange: Configure import options

8. From Import destination area, select one of the following options:

Import to GFI MailArchiver – import emails to GFI MailArchiver Archive Stores.

Extract emails to given path – extract emails to a location on disk in .txt format

9. In the Cut-off time area, specify a date range. Emails sent between the specified dates are
extracted, while other emails are ignored.

10. In the Owner area, enable Select the owner of the emails to extract and specify the user in the
Owner text box.

Example: If user@testdomain.com is specified in the Owner field, imported emails are displayed
under user@testdomain.com.

11. Click Next to start the export process.
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12. When the process completes, click Finish.

NOTE

The duration of the process depends on the amount of emails to extract.

9.1.4 Microsoft® Exchange mailbox access permissions – Revoke Permissions

Importing mailboxes on the Microsoft® Exchange Server

There are no permissions to be revoked when running the GFI MailArchiver Import Export Tool
directly on the Microsoft® Exchange Server machine.

If the Import from Microsoft® Exchange Mailbox Wizard was run on a machine that is not the
Microsoft® Exchange Server 2003/2007/2010 server, ‘Send As’ and ‘Receive As’ permissions are
granted automatically to user credentials . It is recommended to revoke these permissions after
running the GFI MailArchiver Import Export Tool.

Importing mailboxes remotely from Microsoft Exchange 2003 server:

a. Open Exchange System Manager.

b. Navigate to Servers > <Server Name> > <Storage Group>, right click Mailbox Store and select
Properties.

c. Select Security tab.

d. From Group or user names box, select Administrator.

e. From the Permissions list, select Deny for Receive As and Send As.

f. Repeat steps 4 and 5 to deny Receive As and Send As permissions for:

Domain Admins

Enterprise Admins

Exchange Domain Servers.

g. Click Advanced button, select Allow inheritable permissions… option, and click OK.

h. Click OK to exit the Mailbox Store Properties dialog.

i. Restart the Information Store:

a. Navigate to Start > Run, type services.msc, and click OK.

b. In the Results pane, right-click Microsoft Exchange Information Store service and
click Restart.

Importing mailboxes remotely from Microsoft® Exchange Server 2007/2010 server:

1. Open the Microsoft Exchange Management Shell.

2. Run the following Windows® PowerShell commandlet:

Remove-ADPermission -identity "Mailbox Store" -User "Trusted User" -
AccessRights GenericAll
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NOTE

Replace ‘Mailbox Store’ with the name of the mailbox store that contains the mailboxes
of the users and ‘Trusted User’ with the user that was previously granted full mailbox
access.

Example:

Remove-ADPermission -identity "Mailbox Database" -User "master-
domain/JohnSmith" -AccessRights GenericAll

9.2 Import emails from PST files locally

The GFI MailArchiver Import Export Tool enables you to extract emails from PST files. Emails can then
be imported into the GFI MailArchiver archive stores.

IMPORTANT

If Microsoft Outlook® is not detected on the machine where the tool is running, the
following import options are disabled:

Import from .pst files

Download to PST option when selecting Export data from GFI MailArchiver.

GFI MailArchiver supports only Microsoft Outlook® 2003/2007/2010 32bit.
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The process of adding emails from PST files to GFI
MailArchiver involves the following procedure:

1. The GFI MailArchiver Import Export Tool
extracts emails from one or more PST files.

2. The GFI MailArchiver Import Export Tool
converts the emails to MIME format.

3. The GFI MailArchiver Import Service processes
the extracted emails based on the date of each
email.

4. GFI MailArchiver stores emails in the
appropriate archive store.

NOTE
Microsoft Outlook® 2003 (32 bit) or later must
be installed on the machine running the GFI
MailArchiver Import Export Tool.

NOTE
During extraction, emails in PST files are
copied and the PST file is left in its original
state.

9.2.1 Step 1: Importing emails from a remote computer

IMPORTANT

This section only applies when extracting emails from a remote machine. If importing
emails from the same machine where GFI MailArchiver is installed, skip to Run the GFI
MailArchiver Import Export Tool in this manual.

GFI MailArchiver lets you extract email mailboxes located on remote machines. To do this:

1. From the GFI MailArchiver machine, navigate to <GFI MailArchiver installation path>\MAIS\
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2. Share Pickup folder to give full read and write permissions to the remote machine from where the
GFI MailArchiver Import Export Tool is to run. To share a folder:

In Windows® Server 2003:

a. Right-click the Pickup folder and select Sharing and Security…

b. Select Share this folder and click Permissions button to enter the Permissions dialog.

c. Click Add.

d. Enter the username of the user where the tool is going to be run and click Check Names to confirm
the user.

e. Click OK to add the user in the Permissions dialog.

f. In the Permissions dialog select the username added and select the Allow checkbox for Full Control.

g. Click OK to save and exit the Permissions dialog.

h. Click OK to save and exit the folder properties sharing dialog.

In Windows® Server 2008:

a. Right-click Pickup folder and select Share…

b. Specify the credentials under which the GFI MailArchiver Import Export Tool will run and click Add.

c. From the Permission Level drop-down list next to the added user, select Co-owner.

d. Select Share and click Done.

3. Return to where GFI MailArchiver is installed and copy the MarcImportExport folder.

4. Paste the folder on remote machine.

5. Open an instance of CMD

6. Browse to the MarcImportExport Folder on the local machine

7. Run MArcImportExport.exe.

9.2.2 Step 2: Run the GFI MailArchiver Import Export Tool to Import from PST Files

Run GFI MailArchiver Import Export Tool to extract emails from PST file.

1. Navigate to Start > Programs > GFI MailArchiver > GFI MailArchiver Import Export Tool.

2. Click Import from .pst files.
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Screenshot 93: Microsoft Outlook® personal folders (PST) files

3. Click Add PST File and select a PST file to extract. Repeat for each PST file to be added.

4. Click Next when all PST files are added.
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Screenshot 94: Import from Microsoft Exchange: Configure import options

5. From Import destination area, select one of the following options:

Import to GFI MailArchiver – import emails to GFI MailArchiver Archive Stores.

Extract emails to given path – extract emails to a location on disk in .txt format.

6. In the Cut-off time area, specify a date range. Emails sent between specified dates are extracted,
all others are ignored.

7. In the Owner area, enable Select the owner of the emails to extract and specify the user in the
Owner text box.

Example: If user@testdomain.com is specified in the Owner field, imported emails are displayed
under user@testdomain.com.

8. Click Next to start the export process.

9. When the process completes, click Finish.

NOTE

The duration of the process depends on the amount of emails to extract.
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9.3 Import emails from PST files on the network

The GFI PST Exporter wizard included with GFI MailArchiver helps in archiving Microsoft Outlook® PST
files on the network created before installing GFI MailArchiver.

GFI PST Exporter is an agent-based utility part of the
GFI MailArchiver installation. Below is how it works:

1. GFI PST Exporter installs agents on end-user
machines.

2. It extracts emails from PST files stored on the end-
user machines.

3. The GFI MailArchiver Import Service processes the
extracted emails based on the date of each email.

4. GFI MailArchiver stores emails in the appropriate
archive store.

NOTE
Microsoft Outlook® 2003 (32 bit) or later must be
installed on the machine running the GFI
MailArchiver Import Export Tool.

9.3.1 Step 1: Install GFI PST Exporter

1. Select Start > Programs > GFI MailArchiver > Import Tools > Install GFI PST Exporter.

2. Specify the path where to install GFI PST Exporter, and click Next.
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Screenshot 95: GFI PST Exporter Master Service credentials

3. After the setup extracts the files, specify the credentials under which the GFI PST Exporter Master
Service will run.

4. Click Install to finalize the installation.

9.3.2 Step 2: Configure the General Settings of GFI PST Exporter

1. Select Start > Programs > GFI MailArchiver > Import Tools > GFI PST Exporter Management
Console.

2. From the GFI PST Exporter Management Console, click General Settings node.
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Screenshot 96: GFI PST Exporter: general settings

3. In the Cut-off date (UTC time) field, specify a cut-off date and time. Only emails dated prior to this
date and time are extracted.

NOTE

If you set the date and time prior to the installation of GFI MailArchiver, the GFI PST
Exporter will extract emails that have not been processed by GFI MailArchiver, avoiding
duplicate emails in the archive store.

4. Specify the maximum email size in the Max exportable email size field. Emails larger than the size
specified are not exported.

5. Specify the pickup folder in the GFI MailArchiver pickup folder field where to pick up extracted
emails. To import the extracted emails into a GFI MailArchiver archive store, specify the pickup folder
of GFI MailArchiver Import Service. The default path of the GFI MailArchiver Import Service is: <GFI
MailArchiver Installation Path>\MAIS\Pickup
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NOTE

If running GFI PST Exporter on a remote machine, do not specify mapped drives but use
the full UNC path: \\server\share.

NOTE

The import service pickup folder must have full read/write permissions.

6. In the Directory Services section, select the Directory Service Type.

Screenshot 97: GFI PST Exporter: General Settings: verify query root

7. Click Verify to launch the Directory Services Verification dialog. Specify the query root or click
Auto Detect to auto detect the query root.

8. Key in a valid username for the query root specified and click Test Lookup to verify. Click OK to
return to the PST Exporter General Settings.

9. Specify the name of the Microsoft® Exchange Server in the Microsoft Exchange Server field.

10. In the Domain, Username and Password fields, specify the credentials of a domain controller
account. These credentials will be used by the GFI PST Exporter agent to process and extract emails
on the end-user machine.

11. Select the Validate on save checkbox to check the credentials specified when confirming the
settings.

12. Click Save to save configuration or Revert to cancel all settings.

9.3.3 Step 3: Configure the Notification Settings of GFI PST Exporter

After configuring the General Settings, GFI PST Exporter can be configured to send email notifications
to monitor the PST processing status on end-user machines.

1. Select Start > Programs > GFI MailArchiver > Import Tools > GFI PST Exporter Management
Console.

2. Select Notification Settings Node.
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Screenshot 98: GFI PST Exporter: notification settings

3. From the Mail Server Type drop down list, select SMTP.

4. Specify the Authorization Method applicable for your mail server.

5. Specify server IP address in the Mail Server Address field.

6. If the authorization method requires authentication, specify a valid username and password in the
Username and Password fields.

7. Specify an email address in the From Email Address field. This is the email address shown as the
sender of the notification. This address may not be an existing email address and can be dedicated for
the GFI PST Exporter notifications

Example:PSTexporter@mydomain.com

8. Specify the email address in the To Email Address field where to send notifications.

9. Click Send Test Email to test the connection settings and send a notification test email.

10. Click Save to save the configuration.

9.3.4 Step 4: Configure Computer Groups

After configuring the general and notification settings, GFI PST Exporter enables you to organize end-
user machines into computer groups. For each computer group apply different settings and carry out
PST exports separately.
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Computer groups can be configured by accessing the Computer Groups node from the GFI PST
Exporter Management Console.

Screenshot 99: GFI PST Exporter: computer groups

Adding new computer groups

1. Click the Create a new Computer Group button .

Screenshot 100: GFI PST Exporter: create a computer group

2. Specify the group name and click OK.
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Screenshot 101: GFI PST Exporter: computer group properties

3. From the properties dialog click General tab.

4. From the Ownership section, specify who will be the owner of extracted emails for this computer
group:

To assign a specific owner to all extracted emails, select the All PST’s belong to email option and
enter the owner email address.

To assign ownership to the Microsoft Outlook® email profile under which emails were extracted,
select Auto detect ownership option.

NOTE

Ownership of emails is important since only the specified owner will be able to browse
the archived emails.
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5. Specify when to send notifications from the Notify when: drop-down list. The settings configured
previously in the Notification settings node are used.

6. Click the Sources tab.

Screenshot 102: GFI PST Exporter: computer group locations to search

7. In the Restrict to Folders section, manage the path(s) within which PST files can be processed. The
conditions you specify apply to all folders and subfolders within the path. The path(s) you specify can
be:

Local – referring to the end-user machine where the agent is deployed

Example: “Include”, “C:\”, “Local path” - to search all files in the local hard drive

Mapped – paths that are resolved using a drive letter.

UNC – in the format \\server\share

Click Add to add the path to the list.

8. Click OK to add the new computer group.

Editing Computer Groups

To edit computer groups configuration:

1. From the GFI PST Exporter Management Console, select the computer group to edit from the
Computer Groups node.
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Screenshot 103: GFI PST Exporter: edit computer group configuration

2. Click Edit to launch the Computer Group Properties dialog.

3. Apply the required changes as explained in steps 4 to 8 in the Adding new computer groups section.

4. Click OK to save changes.

Computer Group Updates

The GFI PST Exporter Console displays the status of each computer in a group.

To configure when to update the status, select the computer group from the Computer Groups
node. In the Update every: drop-down list, select the time interval when to update the status.

Click Refresh now to manually update the status.

9.3.5 Step 5: Add end-user machines in computer groups

After configuring computer groups, specify which end-user machines belong in each group. To add
end-user machines:

1. From the GFI PST Exporter Console, click the Computer Groups node.

2. From the viewing pane, select the desired computer group.
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Screenshot 104: GFI PST Exporter: add computer

3. Click Add computer button to add a computer to the group.

4. Specify the computer name or IP address (example 192.168.4.50) to add to the group and click OK.

End-user machines

Configure end-user machines in computer groups by right clicking on the end-user machine and select
any of the following options:

Remove – delete the selected end-user machine from the computer group.

Move to Group – move the selected end-user machine to another computer group.

9.3.6 Step 6: Deploy the GFI PST Exporter agent to end-user machines

To extract PST files from end-user machines, the GFI PST Exporter agent must be deployed remotely
on the end-user machine. To deploy the agent:

1. From the GFI PST Exporter management console, select the Computer Groups node.

2. From the view pane, select the computer group.

3. Select the computer on which to deploy the agent.
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Screenshot 105: GFI PST Exporter: deploying the agent

4. Click Deploy button to launch the GFI PST Exporter – Deployment Manager wizard.
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Screenshot 106: GFI PST Exporter: deploying the agent

5. In the Ownership from field, specify the owner of extracted emails for this computer. Ownership
options include:

OPTION DESCRIPTION

Leave
unchanged –

The current owner

Group default
–

The owner specified in the computer group

Force auto-
detection –

Force the agent to detect the Microsoft Outlook® email profile

Force specific
owner –

Specify the email address of the owner that will be assigned to the extracted emails. Enter the owner
email address in the Forced owner email address field.

6. Click Next to continue.
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Screenshot 107: GFI PST Exporter: remote computer requirements

7. Take note of the pre-requisites required to be able to deploy and run GFI PST Exporter agent on
end-user machines. Click Next to start deployment on the end-user machine.

NOTE

During or after deployment, click the server to view the log of deployment details.

NOTE

A window may pop-up on the end-user machine informing the user that the agent is
being deployed. The window closes automatically once deployment is complete.

8. Click Close when deployment is complete.

9.3.7 Step 7: Process PST files on end-user machines

After deploying the GFI PST Exporter agent on end-user machines, you can remotely trigger the agent
to start processing PST files on selected machines. To start the extraction process of PST files:

1. From the GFI PST Exporter Management Console, click Computer Groups node.

2. In the view pane, select the computer(s) on which to start processing.
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3. Click Start button to start processing the PST files on the selected computers.

Screenshot 108: GFI PST Exporter: processing at remote computer

4. The number of emails examined and the number of emails extracted is shown next to each
computer.

5. To view the detailed processing status on each machine, select the computer from the navigation
pane.

9.3.8 Reports and logs

GFI PST Exporter can display reports of extracted emails. Through the Reports node, you can view
the Export Report, which displays details on processed PST files. Besides details on successful
exports, any errors or warnings encountered are also displayed. Information shown includes status,
group, and computer names, date, and time when processing attempts were made, and number of
emails exported.
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Screenshot 109: GFI PST Exporter: export report

To view report click Reports Node.

You can also print the report or export it in HTML format.

End-user machines processing details

Besides the export report, you can also view details about processed PST files for each end-user
machine.

1. From the GFI PST Exporter navigation pane select the Computer Groups node.

2. Expand the appropriate computer group to list all end-user machines

3. Select the end-user machine sub-node for which to display details.
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Screenshot 110: GFI PST Exporter: processing logs

4. To view reports for the selected machine in the viewing pane:

Click the Logs tab to view a list of export jobs. Double-click a job to view more details for that
particular job.

Click the PST tab to view a list of PST files that were processed. Information displayed includes
PST file location, process success/failure, and number of emails exported.

NOTE

To re-export emails from a PST file, select a PST file and click the re-export button
. Exercise caution when doing this, as it may result in duplicate emails being archived.

9.3.9 Adding imported emails to the GFI MailArchiver archive stores

The extracted emails are saved in the pickup folder specified in the general settings of GFI PST
Exporter. To import the exported emails into a GFI MailArchiver archive store, place the exported
emails in the GFI MailArchiver Import Service pickup folder by:
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Choosing the GFI MailArchiver Import Service pickup folder as the destination folder in the gen-
eral settings of GFI PST Exporter, or

If emails are already exported, manually move the emails to the pickup folder.

Emails in the GFI MailArchiver Import Service pickup folder are processed as follows:

Emails are placed in the queue folder so that they can be placed in the appropriate archive store.

If an email in the pickup folder has a date that does not fit the date range of any of the archive
stores configured, GFI MailArchiver will automatically create a new Archive Store.

The Import Service will retry to upload Failed emails and notifications are sent on the progress of
the failed emails.

The default paths of these folders are:

Pickup folder: <GFI MailArchiver Installation Path>\MAIS\Pickup

Queue folder: <GFI MailArchiver Installation Path>\MAIS\Queue

9.4 Export emails from GFI MailArchiver Archive Stores

The GFI MailArchiver OneClick Restore feature enables you to restore individual emails to an email
address you define. If you however want to export or restore more than one email at a time, use the
GFI MailArchiver Import Export Tool. Through this tool, you can connect to a GFI MailArchiver
installation, search for emails to export and export all of the emails in one go using the following
options:

Restore to a specific email address

Download to a folder on disk in .eml or .msg format

Download to a PST file.

The export feature in the GFI MailArchiver Import Export Tool is useful to export a set of emails that
match specific search criteria, for example, to provide emails to satisfy a litigation support request.

NOTE

The export process exports a copy of the emails and does not remove the original emails
from the Archive Stores.

9.4.1 Exporting Emails

1. Navigate to Start > Programs > GFI MailArchiver > GFI MailArchiver Import Export Tool.

2. From the Export Data from GFI MailArchiver area, click Download emails from GFI MailArchiver.
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Screenshot 111: Email Export: Connecting to GFI MailArchiver

3. In the Login Credentials area:

In the GFI MailArchiver URL field specify the URL used to connect to GFI MailArchiver.

Select Login as Current User to login using the credentials of the logged on user or select Use
Other Credentials to login using another username and password.

Click Verify Connection to confirm that a connection can be established to the GFI MailArchiver
URL using the specified credentials.

4. Click Next to continue.
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Screenshot 112: Email Export: Search options

5. Select the type of search from the following options:

OPTION DESCRIPTION

Entire mailbox Search for all emails in a particular mailbox.

Emails containing specific
words

Search for emails that include particular words in subject, body and/or attachment.

Emails with specific search
criteria

Search for emails stored in a particular Archive Store, in a particular mailbox or emails
that contain a particular tag.

6. Click Next to continue.

7. Depending on the type of search selected in the previous step, specify the search criteria as
follows:

TYPE OF
SEARCH

SEARCH CRITERIA

Entire mail-
box

Mailbox Search
All emails in mailbox – Click … button and add the mailbox to search all containing emails.

Retrieve only the first 5000 emails – Search returns only the first 5000 emails that match search
criteria.

Table 81: Email export search criteria



GFI MailArchiver 9 Import and Export Emails | 209

TYPE OF
SEARCH

SEARCH CRITERIA

Emails con-
taining spe-
cific words

Simple Search
Look for – Key in terms to search in emails’ subject and body.

Search in Attachments – check this option to include attachments when searching.

Return only the first 5000 occurrences – Search returns only the first 5000 emails that match
search criteria.

Only in mailbox(es) – Search only in particular mailboxes. Click … button to specify the mailbox to
search in.
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TYPE OF
SEARCH

SEARCH CRITERIA

Emails
with spe-
cific search
criteria

Advanced Search
Search in all Archive Stores

Restrict search on particular Archive Stores – Run search through specific Archive Stores. Click
hyperlink to select the Archive Stores to search in.

Search in mailbox(es) – Check this option to search for emails in specific mailboxes. Click … button
to select the mailboxes to search in.

Retrieve only the first 5000 occurrences – Search returns only the first 5000 emails that match
search criteria.

Query Criteria - select the search criteria and specify the condition from the drop-down list. Click
to add more criteria. Available conditions are:

Subject – Search for emails having a specific subject.

Sender - Specify the email address or Active Directory® display name of the email sender for
which to search emails.

Recipient - Specify the email address or Active Directory® display name of the email recipient for
which to search emails.

Sent Date - Search for emails sent before, after or exactly on a specific date. Key in or select a
date, and select Is before, Is after or Is exactly.

Received Date - Search for emails received before, after or exactly on a specific date. Key in or
select a date, and select Is before, Is after or Is exactly.

Size (KB) - Search for emails that are bigger, smaller or equal to a particular size. Key in a size
and select Is greater than, Is smaller than and Is exactly.

Message ID - Search using the ‘Message ID’ field contained in the email header. Key in or paste
the message ID of the email to find.

Whole Email - Search for emails that have some specific content anywhere in the email (includ-
ing the body, headers and attachments).

Body - Search for emails that have some specific content in the body.

Attachment - Search for emails that have some specific content anywhere in the attachment.

Folder - Search for emails contained in a specific mailbox folder.

Folder/Subfolders - Search for emails contained in a specific subfolder within a mailbox folder.

Personal Label - Search for emails labeled with a specific label.

Global Label - Search for emails labeled with a global label.

Classification Label - Search for emails labeled with a classification label.

SPAM Tag - Search for emails classified as SPAM.

Contains document - Search for emails with attachments of the following file types: .txt, .rtf,
.htm, .html, .xml, .zip, .pdf, .msg, .doc, .xls, .ppt, .docx, .xlsx, .pptx, .wpd, .wpf, .sxc, .sxd, .sxi,
.sxw, .sxg, .stc, .sti, .stw, .stm, .odt, .ott, .odg, .otg, .odp, .otp, .ods, .ots, .odf, .eml, .mht, .xps,
.zip.

NOTE

Click displayed next to a search condition to remove it.

8. Click Find to show all matching emails. To export the returned emails click Next.
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NOTE

After you perform a search, you might need to review particular emails from the result
set to check that they actually contain what you are looking for. Double-click on the
email to view. The GFI MailArchiver Bulk Export tool loads the email in a separate
window.

Screenshot 113: Email Export: Export options

9. Select how to export the emails:

EXPORT OPTION CONFIGURATION

Restore to the following
email address

Select this option to export emails to a mailbox. Specify the email address and select the
method how to send the emails:

Send emails as separate attachments

Send emails as original

Download to path Export emails to a location on disk. Key in the path or click Browse to select the folder
where to export the emails. Select the format how to export the emails in .eml or .msg
format.

Table 82: Email export options
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EXPORT OPTION CONFIGURATION

Download to PST Export emails to a Microsoft Outlook® PST file. Key in the path or click Browse to select the
pst file where to export the emails. To maintain the folder structure of exported emails,
check Retain folder structure.

10. Click Next to start the export process.

11. When the export process completes, click Finish.

NOTE

The duration of the export process depends on the amount of emails to export.
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10 Restoring Mailboxes

GFI MailArchiver provides you with the facility to restore emails archived within GFI MailArchiver
Archive Stores to a Mailbox in Microsoft® Exchange Server. Using the GFI MailArchiver Mailbox Restore
feature enables you to restore, for example, emails for deleted mailboxes.

10.1 Restore a mailbox

1. Launch the GFI MailArchiver Mailbox Restore utility from the GFI MailArchiver program group (GFI
MailArchiver > Mailbox Restore).

Screenshot 114: Restore mailbox utility

2. Select a mailbox to restore from the Restore from Mailbox field.

3. Select All messages to restore all messages or specify a ‘Date from’ and a ‘Date to’ to restore a
specific date range.

4. Key in the mailbox to restore emails to in the To mailbox field.

5. Click Start to start the mailbox restore process.
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NOTE

The GFI MailArchiver Mailbox Restore utility require the following rights for the user
under which this utility is running:

Access to the emails in GFI MailArchiver (Source)

Read/write access to the Microsoft® Exchange Server mailbox (destination);

Executable rights on the server where GFI MailArchiver is installed.

For further information, refer to:

http://go.gfi.com/?pageid=MAR_MailboxRestorePermissions

http://go.gfi.com/?pageid=MAR_MailboxRestorePermissions
http://go.gfi.com/?pageid=MAR_MailboxRestorePermissions
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11 Troubleshooting

Troubleshooting and supportIntroductionThis chapter explains how to resolve any issues encountered
during installation of GFI MailArchiver. The main sources of information available to solve these issues
are:This manual - most issues can be solved through the information in this section.GFI Knowledge
Base articlesWeb forumContacting GFI Technical Support

11.1 GFI SkyNet

GFI maintains a comprehensive knowledge base repository, which includes answers to the most
common problems. GFI SkyNet always has the most up-to-date listing of technical support questions
and patches. In case that the information in this guide does not solve your problems, next refer to GFI
SkyNet by visiting: http://kb.gfi.com/.

11.2 Web Forum

User to user technical support is available via the GFI web forum. Access the web forum by visiting:
http://forums.gfi.com/.

11.3 Request technical support

If none of the resources listed above enable you to solve your issues, contact the GFI Technical
Support team by filling in an online support request form or by phone.

Online: Fill out the support request form and follow the instructions on this page closely to sub-
mit your support request on: http://support.gfi.com/supportrequestform.asp

Phone: To obtain the correct technical support phone number for your region visit:
http://www.gfi.com/company/contact.htm

NOTE

Before contacting Technical Support, have your Customer ID available. Your Customer
ID is the online account number that is assigned to you when first registering your
license keys in the GFI Customer Area at: http://customers.gfi.com.

We will answer your query within 24 hours or less, depending on your time zone.

11.4 Documentation

If this manual does not satisfy your expectations, or if you think that this documentation can be
improved in any way, let us know via email on: documentation@gfi.com.

http://kb.gfi.com/
http://forums.gfi.com/
http://support.gfi.com/supportrequestform.asp
http://www.gfi.com/company/contact.htm
http://customers.gfi.com/
mailto:documentation@gfi.com
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11.5 Installation problems

ISSUE DESCRIPTION

One of the following error messages is
displayed while installing GFI MailArchiver:

Error 1720. There is a problem with this
Windows® Installer package. A script
required for this install to complete
could not be run. Contact your support
personnel or package vendor.

Setup failed to launch installation
engine: Access is denied.

Error installing Ikernel.exe, access is
denied.

1. Disable real-time scanning of anti-virus products or any other software
scanning your machine real-time.
2. Ensure that you do not have any software that automatically removes
files from the TEMP directory.
3. Log in the machine with the Domain Administrator account.
4. Download and install the latest version of Windows® Scripting Host &
Windows Installer for your Windows Operating System from:
http://www.microsoft.com/downloads/
5. Ensure that the following Windows® technologies are installed
correctly and not corrupt:

Windows® Management Instrumentation (WMI)

Windows® Installer

Microsoft .Net Framework

Microsoft Data Access Components (MDAC)

6. Ensure that the following system libraries located at
<Windows\System32> are correctly registered:

Oleaut32.dll

urlmon.dll

ole32.dll

Actxprxy.dll

Scrrun.dll

Browseui.dll

Mshtml.dll

Shdocvw.dll

Shell32.dll

To register a library with the operating system, perform the following
steps:
1. Click Start and select Run
2. Key in cmd.exe and click Enter.
3. Key in ‘regsvr32 <path & filename of dll>’ Example: ‘regsvr32
c:\windows\system32\urlmon.dll’
4. Place the installation file in a temporary directory (Example C:\temp)
on the machine where you are installing the GFI product.
5. Also, check the Distributed Component Object Model (DCOM)
permissions as explained in:
http://support.microsoft.com/default.aspx?scid=kb;en-us;295278

Table 83: Installation problems

http://www.microsoft.com/downloads/
http://support.microsoft.com/default.aspx?scid=kb;en-us;295278
http://support.microsoft.com/default.aspx?scid=kb;en-us;295278
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ISSUE DESCRIPTION

During installation, the following error is
displayed:

The wizard was interrupted before GFI
MailArchiver could be completely
installed.

Your system has not been modified. To
complete installation at another time,
please run setup again.

The wizard was interrupted before GFI
MailArchiver could be completely
installed.

Cause:
Windows Scripting Host (WSH) is outdated or corrupted.
Solution:
Install latest version of Windows® Scripting Host (WSH) and reboot the
machine. WSH can be downloaded from:
http://www.microsoft.com/en-us/download/details.aspx?id=8247

11.6 General Issues

ISSUE DESCRIPTION

GFI MailArchiver fails to authenticate users on load-
ing web interface in Windows® Server 2008.

Cause:
Problem caused by use of Forms Authentication and Http errors
module installation in IIS®7.
Solution 1:Uninstall HTTP Errors module.
Solution 2:Remove HTTP errors from GFI MailArchiver virtual
directory:
1. Unlock the Custom Errors Module from the server.

a. From IIS® Manager, select the server.
b. Double click Modules icon and select
CustomErrorModule.
c. Click Unlock from Actions pane.

2. Remove Custom Error Module from the GFI MailArchiver virtual
directory.

a. Select the GFI MailArchiver virtual directory
b. Select CustomErrorModule
c. Click Remove from Actions pane and YES to
confirm.

Blank page/HTML code/instructions to download
aspx is displayed in browser on loading GFI Mai-
lArchiver

Cause:
ASP.NET® not registered with IIS® Web Server.
Solution:
Register ASP.NET®:
1. From Command Prompt, change directory as follows:

32-bit machines: <Win-
dowsDir>\Microsoft.NET\Framework\<version number>\

For 64-bit machines change to: <Win-
dowsDir\Microsoft.NET\Framework64\<version number>\

2. Key in ‘aspnet_regiis.exe -i’ and press Enter.

Table 84: General issues

http://www.microsoft.com/en-us/download/details.aspx?id=8247
http://www.microsoft.com/en-us/download/details.aspx?id=8247
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ISSUE DESCRIPTION

GFI MailArchiver fails to authenticate when loading
the web interface: Error 401.

Cause:
This error occurs when the IIS® authentication method is not
configured correctly on the GFI MailArchiver server.
Solution:
Verify the IIS® authentication method used.
IIS® 6
1. Navigate to Start > Programs > Administrative Tools >
Internet Information Services (IIS®) Manager.
2. Expand <web server name> > Web Sites > Default Web Site,
right click MailArchiver and select Properties.
3. Select Directory Security tab and under Authentication and
access control, click Edit.
4. Check the Enable anonymous access check box.
5. In the Authenticated access area, select the authentication
method to use. Integrated Windows authentication is
recommended.
6. Click OK twice and close Internet Information Services (IIS®)
Manager.
IIS® 7
1. Navigate to Start > Programs > Administrative Tools >
Internet Information Services (IIS®) Manager.
2. Expand <web server name> > Sites > Default Web Site and
select MailArchiver.
3. In the Features view, double click Authentication.
4. Click Anonymous Authentication and from the right pane
select Enable.
5. Select the authentication method to use and from the right
pane click Enable. Windows Authentication is recommended.
6. Close Internet Information Services (IIS®) Manager.
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ISSUE DESCRIPTION

GFI MailArchiver fails to authenticate when loading
the web interface: Error 4000.

Cause:
This error occurs when another application is installed on the GFI
MailArchiver server, which may be using the same ports required
by GFI MailArchiver.
Solution:
Verify that the default ports used by GFI MailArchiver are not
used by other software:
1. In GFI MailArchiver server, launch Command Prompt.
2. In the command line, type netstat -abn
>C:\netstat.txt. A text file named netstat.txt is created in
C:\.
3. Open netstat.txt and locate the following entries under Proto
column:

TCP 0.0.0.0: 8014 - [MArc.Core2.exe]

TCP 0.0.0.0: 8017 - [MArc.Core.exe]

TCP 0.0.0.0: 8018 - [MArc.Store.exe]

TCP 0.0.0.0: 8019 - [MArc.Search.exe]

TCP 0.0.0.0: 8020 - [MArc.MAIS.exe]

If any of the ports do not correspond with the executable files,
the GFI MailArchiver executable file must be configured to use a
different port. To change a default port:
1. Navigate to Start > Run and type services.msc.
2. Stop all GFI MailArchiver services.
3. Navigate to the GFI MailArchiver installation folder and backup
the following files:

..\Core\bin\MArc.Core.Remoting.exe.config

..\Core\bin\MArc.UMPolling.ExPolling.exe.config

..\Core2\bin\Marc.Core2.exe.config

..\Core2\bin\Marc.Core2.Remoting.exe.config

..\Mais\bin\MArc.MAIS.Remoting.exe.config

..\Mais\bin\MArc.MAIS.exe.config

..\Search\bin\MArc.Search.Remoting.exe.config

..\Search\bin\MArc.Search.exe.config

..\Store\bin\MArc.Store.Remoting.exe.config

..\Store\bin\MArc.Store.exe.config

..\ASPNET\remoting.config

4. Open each .config file listed in step 3 in a text editor, search
for the port number to change and replace by a new port
number.
Example: Search for 8017 and replace by 8117.

NOTE: Ensure that the new port number is not used by any
other application.

5. When changes are made in a .config file, save the file with
encoding set to UTF-8.
6. Click Save to apply changes.
7. When all .config files are updated, restart the GFI MailArchiver
services stopped in step 2.
8. Repeat netstat test in command prompt to confirm that the
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ISSUE DESCRIPTION

GFI MailArchiver is now using the new ports.

When moving emails from the Sent Items folder of
the Microsoft® Exchange mailbox to another folder,
the move is not replicated in the folder structure of
GFI MailArchiver.

Cause:
This behavior occurs when Cached Exchange Mode is enabled in
the user’s Microsoft Outlook® account settings. For more
information about Cached Exchange Mode refer to:
http://go.gfi.com/?pageid=MAR_CachedExchangeMode
Solution:
Disable the Cached Exchange Mode from Microsoft Outlook® as
follows:
Microsoft Outlook® 2003
1. Navigate to Tools > E-mail Accounts.
2. Select View or change existing e-mail accounts and click
Next.
3. Select the Microsoft® Exchange Server mailbox account and
click Change.
4. Unselect Use Cached Exchange Mode and click Next.
5. Click OK and click Finish.
6. Restart Microsoft Outlook® to apply change.
Microsoft Outlook® 2007
1. Navigate to Tools > Account Settings.
2. In the E-mail tab, select the Microsoft® Exchange Server
mailbox account and click Change.
3. Unselect Use Cached Exchange Mode and click Next.
4. Click OK and click Finish.
5. Restart Microsoft Outlook® to apply change.

NOTE: This solution applies only to emails which are
archived after Cached Exchange Mode is disabled.

When opening emails or email attachments from the
GFI MailArchiver interface, one of the following
errors is encountered:

A Web filtering error specifying that the down-
loaded attachment is corrupted.

The downloaded attachment is opened in
Internet Explorer® instead of its default appli-
cation.

Cause:
This may occur when a web filtering tool is installed between GFI
MailArchiver server and GFI MailArchiver Outlook Connector, and
is blocking HTTP requests.
Solution:
Configure the web filtering tool to allow all HTTP traffic
generated from GFI MailArchiver server. Ensure that the GFI
MailArchiver server’s IP address, NETBIOS name or DNS name are
not blocked by the web filter.
For more information, refer to:
http://go.gfi.com/?pageid=MAR_WebFiltering

11.7 Import Export Problems

ISSUE DESCRIPTION

1. Importing/exporting displays: “'The GFI
MailArchiver Import Service is not running”

Cause:
The GFI MailArchiver Import Service is stopped.
Solution:
Ensure that the GFI MailArchiver Import Service is started:
1. Select Start > Run, key in ‘services.msc’ and click Enter.
2. Ensure that the ‘GFI MailArchiver Import Service’ is started. In case it is
not, right click it and select Start.

Table 85: Import Export problems

http://go.gfi.com/?pageid=MAR_CachedExchangeMode
http://go.gfi.com/?pageid=MAR_CachedExchangeMode
http://go.gfi.com/?pageid=MAR_WebFiltering
http://go.gfi.com/?pageid=MAR_WebFiltering
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ISSUE DESCRIPTION

2. Importing/exporting displays: “Export
processes paused since no databases are
configured for the GFI MailArchiver Import
Service”

Cause:
No databases are configured in the GFI MailArchiver Import Service
Configuration.
Solution:
Ensure that the GFI MailArchiver Archive store configured within the GFI
MailArchiver Import Service is not a Read-Only archive Store:
1. From GFI MailArchiver, select Archive Stores node.
2. Click Edit Settings Icon next to the Archive store configured in the GFI
MailArchiver Import Service.
3. Ensure that the Do not allow further archiving into this archive store
is not enabled.

3. Importing/exporting displays: “The
number of files in the process queue is
growing large. Export processes have been
paused to give some time to the GFI Mai-
lArchiver Import Service to process the
email backlog.”

Cause:
GFI MailArchiver is not able to archive emails in the databases. This
results in emails backing up in the <\GFI\MailArchiver\MAIS\Pickup> folder.
When the amount of emails in this folder reaches 300, the GFI PST Export
tool is instructed to pause.
Solution:
Check if there are more than 300 files in the
<\GFI\MailArchiver\MAIS\Pickup> folder. If there are, this might indicate
that emails are not being uploaded to Archive Store.
1. Ensure that the GFI MailArchiver directory is excluded from real-time
backup and/or virus scanning software.
2. Ensure that GFI MailArchiver has a stable connection to the database
and that it has enough resources to cope with the load.
3. For SQL Server® databases, set the auto-growth settings of both the
data and the transaction log files to a fixed value in megabytes, instead of
a percentage value. Recommended values are 10 Mb for the Transaction
Logs and 100 MB for the Data Files. Also, ensure that the Maximum file size
option for both data and transaction files is left to ‘Unrestricted file
growth’.
4. Ensure that there is enough disk space on the server where the GFI
MailArchiver Import Service is running.
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ISSUE DESCRIPTION

4. Importing/exporting displays: “A large
number of emails have a date that does not
match any of the date ranges covered by
the databases configured. Export processes
suspended indefinitely. Please check the
manual for troubleshooting”

Cause 1:
There are no databases configured in the GFI MailArchiver Import Service
Configuration that cover the date of some emails. Such emails cannot be
stored in any database, and will be stored in the
<\GFI\MailArchiver\MAIS\Unclassified> folder. When the amount of emails
in this folder reaches 500, the email extraction wizard is instructed to
pause.
Solution 1:
Navigate to the ‘Unclassified’ folder.

If any emails in the folder do not need to be archived, you can
delete these emails. GFI MailArchiver Import Service will auto-
matically resume with the processing of other emails.

If any emails in the folder need to be archived:

1. Determine the date range of the unclassified emails.

NOTE: To determine the exact date of the email,
open the .eml file in the ‘Unclassified’ folder, and see
the email header.

2. Modify the GFI MailArchiver Import Service Configuration
archive stores’ date ranges, or create a new archive store
that covers the date range.

NOTE: For instructions on how to set the dates of the
archive stores, refer to the section Configure the GFI
MailArchiver Import Service in the appropriate
scenario of Import and Export Emails chapter in this
manual.

3. Move emails located in the Unclassified folder to the
<\GFI\MailArchiver\MAIS\Queue> folder.
4. The Import Service will automatically proceed with
archiving the emails.

NOTE: For more information and instructions about
emails in the Unclassified folder, refer to the
Unclassified emails chapter in one of the appropriate
scenarios described in the Import and Export Emails
chapter in this manual.

For more information on this solution refer to:
http://go.gfi.com/?pageid=MAR_ImportExportDateRange
Cause 2:
Spam emails are often sent with corrupt mail headers, making it
impossible for the GFI MailArchiver Import Service to determine the date
received for such emails. These emails will be found in the ‘Unclassified’
folder, with an incorrect date.
Solution 2:
It is recommended to delete such emails from the ‘Unclassified’ folder.

5. When exporting PST files, the following
error is displayed: “Either there is no
default mail client or the current mail
client cannot fulfil the messaging request.
Please run Microsoft Outlook® and set it as
the default mail client”

Cause:
To export emails from a PST file using the GFI PST-Exchange Email Export
tool Microsoft Outlook® version 2003 or higher must be installed on the
same machine.
Solution:
Install Microsoft® Office version 2003 or higher.

http://go.gfi.com/?pageid=MAR_ImportExportDateRange
http://go.gfi.com/?pageid=MAR_ImportExportDateRange
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ISSUE DESCRIPTION

6. When using the GFI MailArchiver PST-
Exchange Email Export the following errors
are displayed: “Mailbox could not be
opened using current credentials.” “Access
is denied.” “Failed to enumerate folders.”
“The mailbox selected cannot be accessed.
Please check your credentials.”

Cause:
The GFI MailArchiver PST-Exchange Email Export tool uses the credentials
of the logged-on user when run on the Microsoft® Exchange Server
machine directly. When the GFI MailArchiver PST-Exchange Email Export
tool is run on a machine that is not the Microsoft Exchange server
machine, you need to specify a username and password. In both cases,
this account needs to have ‘SendAs’ and ‘ReceiveAs’ permissions on the
mailboxes from which emails are to be extracted.
Solution:
Refer to: http://go.gfi.com/?pageid=MAR_ImportExportCredentials for
detailed instructions on how to solve this issue.

11.8 Outlook® Connector Issues

ISSUE DESCRIPTION

GFI MailArchiver Outlook Connector shows a
warning sign in Microsoft Outlook® right after
installation

Cause:
This behavior is normal. Once you install the GFI MailArchiver Outlook
Connector, it would need to synchronize the emails with GFI
MailArchiver.

GFI MailArchiver Outlook Connector syn-
chronizes and keeps only the last 365 days
worth of emails.

Cause:
By default GFI MailArchiver Outlook Connector only synchronizes and
keeps the last 365 days worth of emails.
Solution:
Default behavior can be modified by changing a special key in the
GeneralSettings.xml configuration file:
1. Close Microsoft Outlook®, navigate to:

Windows® XP and earlier:

<c:\Documents and Settings\user\Local Settings\Application
Data\GFI\MailArchiver 6\>

Windows® Vista:

<c:\Users\userA\AppData\Local\GFI\MailArchiver 6\>
2. Open GeneralSettings.xml file using a text editor.
3. Locate the SynchronizeDaysSpan element and change the value
from 365 (default) to the number of days worth of emails to see in the
Outlook® Connector. Example: To view the last 5 years worth of emails
set the line as: <SynchronizeDaysSpan>1826</SynchronizeDaysSpan>
4. Save and close the GeneralSettings.xml file.
5. Delete the local cache from the same directory. This is normally a
long number with FDB extension. If you are not sure which one to
delete, open the StoreSettings.xml and locate the Store ID attributed
with the user whose cache you want to affect.
6. Open Microsoft Outlook® and synchronize GFI MailArchiver Outlook
Connector with GFI MailArchiver to enable changes.
Delete this text and replace it with your own content.

GFI MailArchiver search page does not appear
in the Search folder in Microsoft Outlook® 2007

Cause:
In Microsoft Outlook® 2007, the home page setting is disabled for non-
default stores. The GFI MailArchiver Mailbox is a non-default store, and
is therefore affected by this policy.
Solution:
Refer to the Microsoft KBase below for more details on how to solve
this issue:
http://support.microsoft.com/kb/923933

Table 86: Outlook® connector issues

http://go.gfi.com/?pageid=MAR_ImportExportCredentials
http://go.gfi.com/?pageid=MAR_ImportExportCredentials
http://support.microsoft.com/kb/923933
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ISSUE DESCRIPTION

One of the following issues is encountered: »
Cannot enable Offline Access from the set-
tings dialog » Cannot set the number of days
for Offline Access greater than a particular
number

Possible cause
The offline access settings are automatically configured by the system
administrator or the feature is disabled by the system administrator.
Possible solution
Consult these issues with your system administrator.

GFI MailArchiver Outlook Connector is not syn-
chronizing with GFI MailArchiver.

Cause 1:
No connection between the client machine and the GFI MailArchiver
server.
Solution 1:
Check with your system administrator to confirm the URL of GFI
MailArchiver. This can be modified from the GFI MailArchiver Outlook
Connector settings dialog.
Cause 2:
GFI MailArchiver Outlook Connector is disabled
Solution 2:
Enable GFI MailArchiver Outlook Connector from Start > Programs >
GFI MailArchiver Outlook Connector > Enable Outlook Connector
and restart Microsoft Outlook®.

Synchronization errors: HTTP Errors Possible cause:
HTTP errors are due to network configuration issues.
Possible solution:
For more information refer to:

http://support.microsoft.com/kb/324069

http://msdn.microsoft.com/en-us/library/ms524996.aspx

http://support.microsoft.com/kb/907273

Synchronization errors: HTTP Error 500 Possible cause:
The GFI MailArchiver server is busy or inaccessible.
Possible solution:
Resynchronize the GFI MailArchiver Outlook Connector within a few
minutes.

Synchronization errors: GFI MailArchiver con-
nection timeout

Possible cause:
The GFI MailArchiver server is busy and failed to send the required
data in a specified time interval.
Possible solution:
To increase the timeout value:
1. Navigate to:

Windows® XP and earlier:

<c:\Documents and Settings\user\Local Settings\Application
Data\GFI\MailArchiver6\>

Windows® Vista:

<c:\Users\userA\AppData\Local\GFI\MailArchiver6\>
2. Open GeneralSettings.xml using a text editor.
3. Locate the TryConnectionTimeout element and increase the default
value of 120000.
4. Save and close GeneralSettings.xml.

http://support.microsoft.com/kb/324069
http://msdn.microsoft.com/en-us/library/ms524996.aspx
http://msdn.microsoft.com/en-us/library/ms524996.aspx
http://support.microsoft.com/kb/907273
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12 Glossary

A

Access privileges
Permissions granted to users or group of users to perform various operations on diverse
emails.

Active Directory
A technology that provides a variety of network services, including LDAP-like directory serv-
ices.

AD
See Active Directory

Archive Store management
A GFI MailArchiver technology that enables you to queue and schedule the archive stores to
use according to different time periods.

Archive Stores
A collection of email sources, email metadata and search indexes within GFI MailArchiver

C

Categorization policies
A categorization system within GFI MailArchiver that enables the categorization of email
according to its label.

Conversation thread
A list of emails forming a conversation between two or more users.

D

Database Activity Auditing
A system that uses the tracing capabilities of Microsoft SQL server to record all activity within
an archive database.

Database schema
The structure of a database that defines the tables, the fields in such tables and the rela-
tionship between fields and tables.

E

Exchange OLE DB provider
A method used to access the local Microsoft Exchange Server store by using OLE DB and Micro-
soft ADO.
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Exchange System manager
A specialized MMC console that enables you to manage your Exchange organization.

ExOLEDB
See Exchange OLE DB provider

F

Firebird database
An open source relational database system.

G

GFI MailArchiver Import Service
A GFI MailArchiver tool that imports email data from file to the GFI MailArchiver.

GFI MailArchiver Outlook Connector
A GFI MailArchiver tool that enables you to synchronize Microsoft Outlook folders with the
email data archived by GFI MailArchiver.

GFI MailInsights
A reporting facility within GFI MailArchiver that leverages archived emails to deliver infor-
mation related to email usage and trends.

GPO
See Group Policy Objects

Group Managers
A user group within GFI MailArchiver that members can browse and search through all users
forming part of their Active Directory group.

Group Policy Objects
An Active Directory centralized management and configuration system that controls what
users can and cannot do on a computer network.

H

Headers
Information that precedes the email text (body). This includes the sender, recipient, subject,
sending and receiving time stamps, etc.

I

IMAP
See Internet Message Access Protocol
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Internet Message Access Protocol
One of the two most commonly used Internet standard protocols for e-mail retrieval, the
other being POP3.

J

Journaling
A Microsoft Exchange Server feature which stores email copies in a central mailbox for various
purposes, incl. mail archiving.

M

Mailbox
A directory or folder used for receipt, filing, and storing messages of emails.

Mailbox folder structure retrieval
A GFI MailArchiver feature that enables you to synchronize the mailbox folder structure in
Microsoft Exchange with GFI MailArchiver

MAIS
See GFI MailArchiver Import Service

MAPI
See Message Application Programming Interface

Message Application Programming Interface
A messaging architecture and a Component Object Model based API for Microsoft Windows.

Metadata
Data that provides information about email archived within GFI MailArchiver.

Microsoft SQL Server
A Microsoft relational database management system.

MIME
See Multipurpose Internet Mail Extensions

Mixed authentication mode
An SQL server authentication method that enables both Windows and SQL Server authen-
tication.

Multipurpose Internet Mail Extensions
A standard that extends the format of e-mail to support text other than ASCII, non-text
attachments, message bodies with multiple parts and header information in non-ASCII char-
acter sets.
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O

OneClick Restore
A user-friendly method of restoring archived emails to the user s inbox and either restores
emails as it was at the time of deletion or sends it to user as an email attachment.

Outlook Web Access
Microsoft Exchange Server s webmail service. Used to access email, contacts, tasks, etc.
using a web interface when Microsoft Office Outlook is unavailable.

OWA
See Outlook Web Access

P

POP3
See Post Office Protocol ver.3

Post Office Protocol 3
A protocol used by local email clients to retrieve emails from mailboxes over a TCP/IP con-
nection.

PST exporter
An agent-based tool that once deployed on the target computers, extracts emails from PST
files for processing by the GFI MailArchiver Import Service.

PST file
A file used to store local copies of email, calendar events, contacts and other items within
Microsoft Office Outlook.

Public folders
A common folder shared between Microsoft Exchange a user, which enables information shar-
ing.

R

Retention Policies
A system that enables you to control for how long to keep specific emails in your archive
stores.

S

Search index
A system that collects parses and stores data to enable fast and accurate information
retrieval.
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U

User interaction auditing
A system that enables you to record all users activity while they are using the GFI Mai-
lArchiver web interface.
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13 Appendix 1 - Journal Mailbox Manual Operations

13.1 Create a Journal Mailbox in Microsoft® Exchange Server 2000/2003

13.1.1 Step 1: Create a New Journaling Mailbox.

1. Select Start > Programs > Microsoft Exchange > Active Directory Users and Computers.

Screenshot 115: Add new user in Microsoft® Exchange Server 2003

2. Expand the domain to archive emails from, right-click Users node and select New > User.
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Screenshot 116: New Object - User dialog

3. Key in a relevant ‘User logon name’ (For example journal), fill in other new user details, and click
Next.

Screenshot 117: Add a password

4. Key in a password, unselect user must change password at next logon option and enable user
cannot change password and password never expires options. Click Next to continue setup.
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NOTE

Ensure that the password keyed in meets the password complexity requirements setup
for your Active Directory® users.

5. Click Next and review the new user details. Click Finish to create new user.

13.1.2 Step 2: Configure Email Archival to Journaling Mailbox

1. Select Start > Programs > Microsoft Exchange > System Manager.

Screenshot 118: Mailbox store node properties

2. Expand Servers > <Your Server name> > Storage group, right click Mailbox Store node and select
Properties.
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Screenshot 119: Enabling journaling on a Microsoft® Exchange Server mailbox store

3. From the General tab, select Archive all messages sent or received by mailboxes on this store
check box and click Browse button.

4. Select the journaling mailbox name you created in step one, for example ‘journal’, and click OK.

5. Close the Mailbox Store Properties dialog and the Exchange System Manager Management
console.

13.1.3 Step 3: Enable BCC Information Journaling

IMPORTANT

It is highly recommended that you DO NOT enable this option but enable envelope
journaling instead. Envelope journaling journals all the header information, not just the
BCC data. For more information on envelope journaling refer to Step 4: Enable Envelope
Journaling

On Microsoft® Exchange Server 2000 and Microsoft® Exchange Server 2003 systems, BCC information
is not by default included in the journaled message. To enable BCC information journaling:

For Microsoft® Exchange Server 2000 only

1. Install hot fix available from:

http://support.microsoft.com/?kbid=810999

For both Microsoft® Exchange Server 2000 and Microsoft® Exchange Server 2003.

1. From command prompt, type regedit.exe

http://support.microsoft.com/?kbid=810999
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2. Add the following registry key:

HKEY_LOCAL_
MACHINE\System\CurrentControlSet\Services\MSExchangeTransport\Parameters

3. Add the following registry key and values:

HKEY_LOCAL_
MACHINE\System\CurrentControlSet\Services\MSExchangeTransport\Parameters\

Key name: JournalBCC

Data type: Dword

Data value: 1

4. Close Registry editor and from command prompt type services.msc. Restart Simple Mail
Transport Protocol and the Information Store services.

13.1.4 Step 4: Enable Envelope Journaling

Envelope Journaling enables the archival of email header information and can be switched on using:

Microsoft® Exchange Server Email Journaling Advanced Configuration (exejcfg.exe), or

ADSI Editor Management console.

Using the exejcfg.exe tool

1. Download the exejcfg.exe tool from:

http://www.microsoft.com/downloads/details.aspx?familyid=E7F73F10-7933-40F3-B07E-
EBF38DF3400D&displaylang=en

2. From the command prompt, navigate to the folder in which you copied the exejcfg.exe tool.

3. Type exejcfg -e and press Enter.

NOTE

exejcfg -d disables Envelope Journaling for that organization.

Using the ADSI Editor

1. Locate the adsiedit.msc tool from the Windows® 2000 Server resource kit or the Windows®

2003 Server support tools.

2. From command prompt, navigate to the folder where adsiedit.msc is stored, type
adsiedit.msc and then press Enter.

http://www.microsoft.com/downloads/details.aspx?familyid=E7F73F10-7933-40F3-B07E-EBF38DF3400D&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=E7F73F10-7933-40F3-B07E-EBF38DF3400D&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=E7F73F10-7933-40F3-B07E-EBF38DF3400D&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=E7F73F10-7933-40F3-B07E-EBF38DF3400D&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=E7F73F10-7933-40F3-B07E-EBF38DF3400D&amp;displaylang=en
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Screenshot 120: ADSI Edit

3. Expand ADSI Edit > Configuration > <CN=Configuration> > <CN=Services> > <CN=Microsoft
Exchange> node.

4. Right-click CN<your organization name> node and click Properties.
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Screenshot 121: Heuristics attribute

5. Select heuristics attribute from the Attributes list and click Edit.

Screenshot 122: Editing the heuristics attribute value

6. Key in ‘512’ and click OK.

7. Click OK to save and close the ADSIEdit console.

NOTE

A value of 512 enables Envelope Journaling, and a value of 0 disables Envelope
Journaling.

13.2 Disabling Journaling in Microsoft® Exchange Server 2000/2003

1. Select Start > Programs > Microsoft Exchange > System Manager.
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Screenshot 123: Mailbox store node properties

2. Expand Servers > <Your Server name> > Storage group, right click Mailbox Store node and select
Properties.
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Screenshot 124: Enabling journaling on a Microsoft Exchange mailbox store

3. From the General tab, unselect the Archive all messages sent or received by mailboxes on this
store check box. Click OK to save settings.

13.3 Creating a Journaling Mailbox in Microsoft® Exchange Server 2007

Microsoft® Exchange Server 2007 supports two types of journaling:

Standard journaling: Configure a Mailbox store that enables the recording of email in an organ-
ization. GFI MailArchiver can use Microsoft® Exchange Server journaling to centralize all the
emails in a single mailbox for archival. This type of journaling is also called per-mailbox database
journaling.

Premium journaling: Only available with Microsoft® Exchange Enterprise client access license. It
enables an administrator to setup custom journaling rules such as:

Archive only incoming emails

Archive only outgoing emails

Archive emails for a particular group.

GFI MailArchiver utilizes this type of journaling by detecting and displaying these rules in the Data
Sources Configuration Wizard.

Which journaling method shall I use?

Choose standard journaling to archive all emails (inbound and outbound) for all users in your
organization.
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Choose premium journaling if you want more control over the emails to archive (For example, only
for specific users or for inbound or outbound only).

NOTE

Premium journaling requires a Microsoft® Exchange Enterprise client access license.

13.3.1 Set up standard journaling

Step 1: Create a new journaling mailbox

1. Select Start > All Programs > Microsoft Exchange Server 2007 > Microsoft Exchange Management
Console.

2. Expand Recipient Configuration node and click on Mailbox node.

3. Select New Mailbox… from the Actions pane.

4. Select User Mailbox option and click Next.

5. Select New user option and click Next.

Screenshot 125: New user mailbox details

6. Key in the ‘User information’ details for the new user to which the new journaling mailbox will be
assigned and click Next.

7. Ensure that the mailbox settings are correct and click Next.
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8. Review the new mailbox summary for the new mailbox to create and click New.

Step 2: Configure standard journaling

1. Select Start > All Programs > Microsoft Exchange Server 2007 > Microsoft Exchange Management
Console.

Screenshot 126: Configuring a Mailbox Database

2. Expand Microsoft Exchange > Server Configuration > Mailbox node and click Properties from the
Actions pane.
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Screenshot 127: Mailbox Database properties

3. Select Journal Recipient option, click Browse, and select mailbox previously configured from the
Active Directory®.

4. Click OK to finalize setup.

13.3.2 Set up premium journaling

1. Select Start > All Programs > Microsoft Exchange Server 2007 > Microsoft Exchange Management
Console.



GFI MailArchiver 13 Appendix 1 - JournalMailboxManualOperations | 242

Screenshot 128: Configuring Journaling rules

2. Expand Organization Configuration > Hub Transport node and select Journaling tab.

3. From the Actions tab and click on New Journaling Rule.
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Screenshot 129: Creating a new Journaling rule

4. Key in a name for the new rule and click Browse. Select the Journal e-mail address, preferably a
mailbox within the existing Microsoft® Exchange organization, from Active Directory®.

5. <Optional> Configure:

Scope - Select whether to journal all email (Global), internal or external email.

Journal e-mail for recipient - Select specific recipient(s) for which this journaling rule applies.

6. Ensure that the Enable Rule option is enabled and click New.

NOTE

In Microsoft® Exchange Server 2007, envelope journaling is automatically enabled by
default.

13.4 Disabling standard journaling in Microsoft® Exchange Server 2007

1. Select Start > All Programs > Microsoft Exchange Server 2007 > Microsoft Exchange Management
Console.
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Screenshot 130: Configuring a Mailbox Database

2. Expand Microsoft Exchange > Server Configuration > Mailbox node and click Properties from the
Actions pane.
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Screenshot 131: Mailbox Database properties

2. Unselect Journal Recipient option.

3. Click OK to finalize setup.

13.4.1 Disable standard journaling from the Microsoft Exchange Management Shell

In the Microsoft® Exchange Server Management Shell, use the following syntax to disable a journaling
rule:

Set-MailboxDatabase <Mailbox Database> -JournalRecipient $Null

13.4.2 Disable premium journaling

1. Select Start > All Programs > Microsoft® Exchange Server 2007 > Microsoft Exchange
Management Console.
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Screenshot 132: Configuring Journaling rules

2. Expand Organization Configuration > Hub Transport node and select Journaling tab.

3. Right click the journal rule to remove, and click Remove.

4. Click Yes to confirm that you want to remove the journal rule.

13.4.3 Disable premium journaling from the Microsoft® Exchange Server Management Shell

In the Microsoft® Exchange Server Management Shell, use the following syntax to disable a journaling
rule:

Remove-JournalRule <journal rule name>

13.5 Create a Journal Mailbox in Microsoft® Exchange Server 2010

Microsoft® Exchange Server 2010 supports two types of journaling:

Standard journaling: Configure a Mailbox store that enables the recording of email in an organ-
ization. GFI MailArchiver can use Microsoft® Exchange Server journaling to centralize all the
emails in a single mailbox for archival. This type of journaling is also called per-mailbox database
journaling.
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Premium journaling: Only available with Microsoft® Exchange Enterprise client access license. It
enables an administrator to setup custom journaling rules such as:

Archive only incoming emails

Archive only outgoing emails

Archive emails for a particular group.

GFI MailArchiver utilizes this type of journaling by detecting and displaying these rules in the Data
Sources Configuration Wizard.

Which journaling method shall I use?

Choose standard journaling to archive all emails (inbound and outbound) for all users in your
organization.

Choose premium journaling if you want more control over the emails to archive (For example, only
for specific users or for inbound or outbound only).

NOTE

Premium journaling requires a Microsoft® Exchange Enterprise client access license.

13.5.1 Set up standard journaling

Step 1: Create a new journaling mailbox

1. Launch Microsoft Exchange Management Console.

2. Expand Recipient Configuration node and click on Mailbox node.

3. Select New Mailbox… from the Actions pane.

4. Select User Mailbox option and click Next.

5. Select New user option and click Next.
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Screenshot 133: New user mailbox details

6. Key in the ‘User information’ details for the new user to which the new journaling mailbox will be
assigned and click Next.

7. Enter an ‘Alias’ for the journaling mailbox and click Next.

8. Click Next and review the new mailbox summary for the new mailbox to create and click New.

Step 2: Configure standard journaling

1. Launch Microsoft Exchange Management Console.
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Screenshot 134: Configuring a Mailbox Database

2. Expand Microsoft Exchange > Organization Configuration > Mailbox node. Right-click the Mailbox
database and select Properties.
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Screenshot 135: Mailbox Database properties

3. From the mailbox database properties dialog, select the Maintenance tab and select the Journal
Recipient checkbox. Click Browse, and select the journaling mailbox previously configured.

4. Click OK to finalize setup.

13.5.2 Set up premium journaling

1. Launch Microsoft Exchange Management Console.

2. Expand Organization Configuration > Hub Transport node and select Journaling tab.

3. From the Actions tab, click New Journal Rule.
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Screenshot 136: Creating a new Journaling rule

4. Key in a name for the new rule

5. Click Browse to select the journaling mailbox where to send journal reports.

6. <Optional> Configure:

Scope - Select whether to journal all email (Global), internal or external email.

Journal messages for recipient - Select specific recipient(s) for this journaling rule.

7. Ensure that the Enable Rule option is enabled and click New.

NOTE

In Microsoft® Exchange Server 2010, envelope journaling is automatically enabled by
default.

13.6 Disabling standard journaling in Microsoft® Exchange Server 2010

1. Launch the Microsoft Exchange Management Console.
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Screenshot 137: Configuring a Mailbox Database

2. Expand Microsoft Exchange > Organization Configuration > Mailbox > Database Management tab
and select Properties from the Actions pane.
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Screenshot 138: Mailbox Database properties

2. Unselect Journal Recipient option.

3. Click OK to finalize setup.

13.6.1 Disable standard journaling from the Microsoft Exchange Management Shell

In the Microsoft Exchange Management Shell, use the following syntax to disable standard
journaling:

Set-MailboxDatabase <Mailbox Database> -JournalRecipient $Null

13.6.2 Disable premium journaling

1. Launch the Microsoft Exchange Management Console.

2. Expand Organization Configuration > Hub Transport node and select Journal Rules tab.

3. Right click the journal rule to remove, and click Remove.

4. Click Yes to confirm that you want to remove the journal rule.

Disable premium journaling from the Microsoft Exchange Management Shell

In the Microsoft Exchange Management Shell, use the following syntax to disable a journaling rule:
Remove-JournalRule <journal rule name>
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14 Appendix 2 - Role Based Installations

Role-based Deployment allows for scalability of GFI MailArchiver in large IT infrastructures dealing
with heavy email traffic. This is achieved through the deployment of multiple GFI MailArchiver
instances on separate servers. Each instance is configured to fulfill diverse roles, to balance workload
and collectively help for the smooth running of the email archiving process.

The following roles can currently be assigned to GFI MailArchiver instances:

Central Configuration Service

Data Collection

Storage

Search and Indexing

User Interface and Administration

Data Import Service
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14.1 How Role-based Deployment Works

Screenshot 139: How Role-based Deployment works

The GFI MailArchiver role-based deployment process in a distributed environment involves the
following steps:

1. Establish the number of GFI MailArchiver instances required and the role to assign to each
instance.

2. Install GFI MailArchiver on each server that will be participating in the deployment. This is a
normal installation as described in the previous sections in this manual.

3. Execute the Deployment Manager Wizard on each GFI MailArchiver instance.

4. Store each server’s deployment configuration file for future reference. This file may be required
when updating to newer GFI MailArchiver builds or when the administrator needs to reconfigure the
deployment roles.
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5. Configure GFI MailArchiver from the server with the User Interface and Administration role.

NOTE

GFI MailArchiver instances communicate with each other over the network using the
.NET® Remoting protocol.

NOTE

A GFI MailArchiver instance can be assigned more than one role; the following roles can
be assigned to more than one GFI MailArchiver instance:

Data Collection

User Interface and Administration

Data Import Service

Though there may be a number of GFI MailArchiver instances distributed over the network, this fact is
transparent to the administrator when it comes to configuring GFI MailArchiver, since configuration is
centralized. Once the deployment process is complete, the administrator does not have to configure
individual servers but can carry out all configuration through the GFI MailArchiver management
console. In a distributed deployment, the GFI MailArchiver management console is accessible from the
server(s) assigned the User Interface and Administration role.

14.2 System Requirements

For the GFI MailArchiver Role-based deployment, you need:

Hardware and software specifications as described in the ‘Installing GFI MailArchiver’ chapter.

NOTE

For a Role-based deployment only SQL Server® based Archive Stores are supported.

NOTE

If you are using a SQL Server® and NTFS file system archive store, make sure that the
archived email binary source path is specified in UNC format.

GFI MailArchiver services running under Active Directory® credentials allowing communication
over the network.

14.3 Installing GFI MailArchiver in a Role-based Environment

You assign roles to GFI MailArchiver instances by using the Deployment Manager Wizard, which
simplifies and streamlines the process.
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14.3.1 Installing GFI MailArchiver

Install GFI MailArchiver on each instance where a role will be deployed. For more information, refer
to Installing GFI MailArchiver (page 29).

14.3.2 Executing the Deployment Manager Wizard on Each Instance

Execute the Deployment Manager Wizard on each GFI MailArchiver instance, according to the role(s) it
will be assigned, in the following order:

1. Central Configuration Service

2. Storage

3. Search and Indexing

4. Data Collection (more than one allowed)

5. User Interface and Administration (more than one allowed)

6. Data Import Service (more than one allowed)

7. User Mailbox Synchronization

8. IMAP Server

NOTE

Execute the wizard for the GFI MailArchiver instance that will be assigned the Central
Configuration Service role, then execute it for the GFI MailArchiver instance with the
Storage role, and so on.

14.3.3 Launching the Deployment Manager Wizard

To launch the Deployment Manager Wizard:

1. From Command Prompt, navigate to:

<Program Files Directory>\GFI\MailArchiver\DM\

2. Key in deploymentmanager.exe and press Enter.

Using the Deployment Manager Wizard

1. After launching the Deployment Manager Wizard you are presented with the welcome dialog. Click
Next to continue.
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Screenshot 140: Selecting roles

2. Specify which role(s) will be assigned to the GFI MailArchiver instance on this server and click Next.

NOTE

Move the mouse pointer over any role listed in the dialog to view the relevant
description for that role.

3. Based on the roles selected in the previous stage, you will be asked to configure some parameters.
For information on how to configure roles refer to the next sections. Click Next to continue.
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Screenshot 141: Specify Active Directory® credentials

4. Specify the Active Directory® credentials under which to run GFI MailArchiver services and click
Next.

NOTE

GFI MailArchiver services must run under an Active Directory® user account.

NOTE

Specify an account that has read/write access privileges on the Microsoft® Exchange
Server configuration.
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Screenshot 142: Apply all configuration settings specified

5. Click Next to initiate the process and apply all specified parameters.

NOTE

During this process all GFI MailArchiver services need to be stopped and re-started. This
occurs automatically and may take minutes to complete.

6. Click Finish to finalize your settings and close the Deployment Manager Wizard.
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Assigning the Central Configuration Service Role

Screenshot 143: Assigning the Central Configuration Service role

To assign the ‘Central Configuration Service Role’ select the appropriate option from the list of roles
in the ‘Server Role Selection’ dialog.

The server assigned this role maintains the central configuration database of the GFI MailArchiver
deployment and hosts miscellaneous services like email restore and licensing. You can only assign the
‘Central Configuration Service Role’ to one server in the deployment.
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Assigning the Data Collection Role

Screenshot 144: Assigning the Data Collection role

To assign the ‘Data Collection Role’ select the appropriate option from the list of roles in the ‘Server
Role Selection’ dialog.

The server assigned this role collects emails, to be archived, from Microsoft® Exchange Server
locations.

To achieve maximum performance, assign the ‘Data Collection Role’ to a GFI MailArchiver instance
residing directly on the Microsoft® Exchange Server.

You can assign this role to multiple servers in the deployment. However, ensure that the ‘server
tagging’ option is enabled when assigning the ‘User Interface and Administration Role’.
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Assigning the Storage Role

Screenshot 145: Assigning the Storage role

To assign the ‘Storage Role’ select the appropriate option from the list of roles in the ‘Server Role
Selection’ dialog. The server assigned this role provides email storage and retrieval services.

You can only assign the ‘Storage Role’ to one server in the deployment.
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Assigning the Search and Indexing Role

Screenshot 146: Assigning the Search and Indexing role

To assign the ‘Search and Indexing Role’ select the appropriate option from the list of roles in the
‘Server Role Selection’ dialog.

The server assigned this role provides email search and indexing services. GFI MailArchiver creates
search indexes for each archive store you configure. Each search index automatically indexes new
email content archived in the corresponding archive store, to keep the search index updated and
enable users to perform precise and fast searches.

You can only assign the ‘Search and Indexing Role’ to one server in the deployment.
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Screenshot 147: Specify the word breaker for the Search and Indexing role

You will be prompted to specify the word breaker to use. Word breakers for each language enable the
resulting terms to be more accurate for that language. If no word breaker is available for a particular
language, the neutral word breaker is used. With the neutral word breaker, words are broken at
neutral characters such as spaces and punctuation marks.

Select the indexing option available if you also want to index email message attachments.
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Assigning the User Interface and Administration Role

Screenshot 148: Assigning the User Interface and Administration role

To assign the ‘User Interface and Administration Role’ select the appropriate option from the list of
roles in the ‘Server Role Selection’ dialog.

The server assigned this role enables users to browse/search their archives and administrators to
configure GFI MailArchiver through the management console.

You can assign the ‘User Interface and Administration Role’ to multiple servers in the deployment.



GFI MailArchiver 14 Appendix 2 - Role Based Installations | 267

Screenshot 149: Specify User Interface and Administration role settings

You will be prompted to specify the authentication method to use (Windows® or Forms) to log in to
the GFI MailArchiver management console.

If more than one server is assigned the Data Collection role, select the Enable server tagging in the
Data Sources configuration option. Server tagging allows multiple GFI MailArchiver instances running
the Data Collection role to process different mailboxes without interfering with each other.
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Assigning the Data Import Service Role

Screenshot 150: Assigning the Data Import Service role

To assign the ‘Data Import Service Role’ select the appropriate option from the list of roles in the
‘Server Role Selection’ dialog.

The server assigned this role uploads imported emails to the GFI MailArchiver Archive Stores.

You can assign the ‘Data Import Service Role’ to multiple servers in the deployment.
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14.3.4 Assigning the User Mailbox Synchronization Role

Screenshot 151: Assigning the Data Import Service role

To assign the ‘User Mailbox synchronization Role’ select the appropriate option from the list of roles
in the ‘Server Role Selection’ dialog.

The User Mailbox Synchronization role is used to synchronize emails in a user mailbox between GFI
MailArchiver and Microsoft® Exchange Server. You can configure only one server to run the User
Mailbox Synchronization Role in the deployment.
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14.3.5 Assigning the IMAP Server Role

Screenshot 152: Assigning the IMAP Server role

To assign the ‘IMAP Server Role’ select the appropriate option from the list of roles in the ‘Server
Role Selection’ dialog.

The IMAP Server role enables IMAP email clients to connect to GFI MailArchiver and download
archived emails to their devices. You can configure only one instance of this role in the deployment.
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14.3.6 Assigning Multiple Roles to a Server

Screenshot 153: Assigning multiple roles

A GFI MailArchiver instance may be assigned more than one role. To assign the required roles, select
the appropriate options from the list of roles in the ‘Server Role Selection’ dialog.
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Identifying the Central Configuration Service Role Server

Screenshot 154: Identifying the Central Configuration Service Role server

If you are assigning a role other than the ‘Central Configuration Service Role’ to a GFI MailArchiver
instance, you are prompted to identify the server that has been assigned that role.

Click Test connection to verify that the ‘Central Configuration Service Role’ server you specified is
accessible.
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Identifying the Data Collection Role Server

Screenshot 155: Identifying the Data Collection Role server

If you are assigning the ‘User Interface and Administration Role’ to a GFI MailArchiver instance, but
not the ‘Data Collection Role’ to the same instance, you are prompted to identify the server with the
‘Data Collection Role’.

Click Test connection to verify that the ‘Data Collection Role’ server you specified is accessible.
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14.3.7 Identifying the Storage Role Server

Screenshot 156: Identifying the Storage Role server

If you are assigning a role other than the ‘Storage Role’ to a GFI MailArchiver instance, you are
prompted to identify the server that has been assigned that role.

Click Test connection to verify that the ‘Storage Role’ server you specified is accessible.
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14.3.8 Identifying the Search and Indexing Role Server

Screenshot 157: Identifying the Search and Indexing Role server

If you are assigning a role other than the ‘Search and Indexing Role’ to a GFI MailArchiver instance,
you are prompted to identify the server which has been assigned that role.

Click Test connection to verify that the ‘Search and Indexing Role’ server you specified is accessible.
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14.3.9 Recommended Deployment Scenario

Figure 4 - Deployment scenario

This is the recommended scenario for a GFI MailArchiver distributed deployment. In this scenario, an
organization will be deploying three GFI MailArchiver instances. Each instance is installed on a
separate server, with each server fulfilling roles as shown in the following table:

SERVER ID ROLE

Data Collection

User Mailbox Synchronization

User Interface and Administration

Central Configuration Service

Storage

Search and Indexing

Data Import Service

Table 87: Deployment scenario
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NOTE

To achieve maximum performance, assign the ‘Data Collection Role’ and the User
Mailbox synchronization roles to a GFI MailArchiver instance residing directly on the
Microsoft® Exchange Server with the journaling mailbox.

These are the steps to follow for this deployment:

1. Install GFI MailArchiver on each server.

2. Execute the Deployment Manager Wizard on each of the three servers to assign roles to the GFI
MailArchiver instances. The roles should be assigned in the order as listed in the ‘Executing the
Deployment Manager Wizard on each instance’ section of this chapter. Run the Deployment Manager
Wizard in the order as shown in the following table:

SERVER ID ORDER DEPLOYMENT MANAGER WIZARD

Run Wizard to assign the following roles:
Central Configuration Service

Storage

Search and Indexing

Data Import Service

Run Wizard to assign the Data Collection role and User Mailbox synchronization roles.

Run Wizard to assign the User Interface and Administration role

Table 88: Deployment order

3. Configure GFI MailArchiver through the management console, accessed from Server ID 2, which is
the server with the User Interface and Administration role.

Alternative Scenario

Another recommended scenario is to deploy servers with the following GFI MailArchiver roles:

Server 1:

Central Configuration Service

Storage

Server 2:

Search and Indexing

Server 3:

Data Collection

User Mailbox synchronization
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NOTE

To achieve maximum performance, assign the Data Collection role to a GFI MailArchiver
instance residing directly on the Microsoft® Exchange Server with the journaling
mailbox.

NOTE

You can have multiple servers assigned with the Data Collection role.

Server 4:

User Interface and Administration

Server 5 (Temporary server):

Data Import Service

NOTE

This temporary server can be used when past emails (before GFI MailArchiver was
installed) from PST files will be imported into the Archive Stores. Importing past emails
is normally a one-time process, thus the temporary nature of this server.
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